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About This Guide and Your Product

This manual contains reference information and instructions for configuring and operating the Scalar
Distributed Library Controller (Scalar DLC) software. This guide is intended for customers and
administrators who use the Scalar DLC software.

Explanation of Symbols and Notes

The following symbols appear throughout this document to highlight important information.

INDICATES A POTENTIALLY HAZARDOUS SITUATION WHICH, IF NOT
A WARNING  AVOIDED, COULD RESULT IN DEATH OR BODILY INJURY.

_ Indicates a situation that may cause possible damage to equipment, loss of
41y CAUTION  (ata, or interference with other equipment.

@ Note Indicates important information that helps you make better use of your system.

Other Documents You Might Need

The following documents are also available for this product. These documents can be found on the product

CD or at www.adic.com/manuals:

»  Scalar DLC Installation Guide
» Scalar DLC Release Notes (6-00335-xx)

*  DAS Administration Guide (6-00345-xx)
»  DAS/ACI Interfacing Guide (6-00346-xx)

* Scalar 10K SCSI Reference Guide
e Scalar 1000 SCSI Reference Guide
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»  SCSI Primary Commands 2 (SPC-2)
* SCSI Primary Commands 3 (SPC-3)
*  ROBAR Interfacing Guide

»  Scalar 10K Operator Guide

»  Scalar 1000 Operator Guide

*  RMU Reference Guide

Getting More Information or Help

More information about this product is available on the Customer Service Center website at
www.adic.com/csc. The Customer Service Center contains a collection of information, including answers to
frequently asked questions (FAQs). You can also access software, firmware, and drivers through this site.

For further assistance, or if training is desired, contact ADIC:

ADIC Technical assistance center (ATAC) in the USA: 800-827-3822

ADIC Technical assistance center (ATAC) in Europe and Japan: 00-800-9999-3822

For additional contact information: www.adic.com/contact
To open a Service Request: www.adic.com/techsup
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Description

This chapter provides an overview of the Scalar DLC software that supports the Scalar 1000 and Scalar
10K (single- and dual-aisle) tape libraries.

The sections contained are:

» System Description on page 3 provides the description of Scalar DLC system.

+  Graphical User Interface on page 8 briefly describes the main administration tool of the Scalar DLC
software.

+ Command Line Interface on page 8 provides an information about command line interface.

+ Service and Maintenance Alerts on page 8 describes the alert features of the Scalar DLC.

System Description

The Scalar DLC software runs as a service under Windows 2000/2003. It serves as a centralized library
management tool that simplifies and automates the tracking and management of all system resources for
optimal performance and maximum availability. The Scalar DLC software provides network and System
Administrators with a Java-based interface that allows library monitoring from anywhere on the Web.

T4 Note If a firewall is being used, outside access by Web browsers might be denied.

The Scalar DLC also allows administrators to select parameters that define which library events provide
notifications to customers and ADIC Technical Assistance Center (ATAC) via email and, sometimes, the
Simple Network Management Protocol (SNMP) alerts.

The main working tool of the Scalar DLC software is the Management GUI. Refer to Graphical User
Interface on page 8. This tool executes all the actions of management and configuration.

The Scalar DLC provides the connectivity between the library and the customer (client). The connection
type depends on client configuration. See Figure 1 on page 4.
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Figure 1 Client Connection
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The Scalar tape libraries are connected to the Scalar DLC software host via the SCSI bus or the Fibre
Channel cable. See Figure 2.

Figure 2 Physical Libraries connected to the Scalar DLC

\ Scalar OLC host

Scalar 1000 Scalar 10K Scalar 10K DA

For each tape library found during Scan SCSI Bus operation, the Scalar DLC software creates an object
called physical library. This object represents all aspects of the real tape device.

Logical Library Concepts

In order for clients to have a flexible way to share common resources (physical library), the Scalar DLC uses
virtual objects called logical libraries to represent the real device for the client. The Management GUI is used
to create and configure these logical libraries. The connection between the logical library and the device is
implemented by means of the partitioning features that are unique to the Scalar DLC software. The
partitioning operation creates a number of element ranges called partitions that are used by the physical
library. These ranges are then assigned to the logical libraries (see Figure 3 on page 5) so that the client
who uses a certain logical library can access the correct part of the physical library. This feature is very
useful when clients use a single physical library while the client has access to only a certain resource. The
logical library represents these resources, and the assigned partitions provide a connection between the
logical library and its physical equivalent.
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This logical library concept is based on a partition containing the continuous range of elements of a single
type (for example, storage) and media domain (for example, DLT). The partitions cannot overlap; however,
a single partition can be assigned to two or more logical libraries. In that case, two logical libraries will have
a shared area, and the clients of the first library can access this area as well as the clients of the second
library.

_ Sharing the single partition between two or more logical libraries may cause
41y CAUTION  3ccess problems, so this feature must be used with extreme caution.

\.g Note The partition cannot contain both storage tower and storage shelf elements, even if they
consist of the identical storage slots (for example, Generic DLT). This means for the
single-media library with a storage tower (for example, Scalar 10K), no less than two
storage partitions should be created in order to cover its storage area completely; the
first partition will cover the tower, and the second will cover the linear storage (storage
shelves).

Figure 3 Partitions and Logical Libraries
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Two or more clients either of the same type (for example, DAS-based) or of different types (for example,
DAS-based and ROBAR-based) may use a single logical library. This means that they have rights to use
common resources that are part of this library (cartridges, drives, and so forth). See Figure 4.

Figure 4 Clients and Logical Libraries
Scalar DLC host
Library1
Clienitt
Client2
Library2
Clisrt

PC System Requirements

The minimum PC system hardware requirements are based on Microsoft PC 2000 System Design Guide
Specifications. The following list summarizes the Scalar DLC system requirements:

Required:
« 800 MHZ or faster Inter Pentium ™ or equivalent CPU (minimum 4 free PCI slots in chassis)
+ 256K L2 Cache
+ 256 MB RAM
*  Dual matched Hard Drives (10GB or more)
« CDRW
3.5" Diskette Drive
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* 15" or greater SVGA Display
*  NT/2000 compliant SCSI adapter
+ Standard keyboard and mouse
*  Windows 2000 SP4 or Windows 2003 pre-installed
Optional:
+ SCSil target HBA LSI 20860, LSI 8751D, and/or LSI 8951U
+  Fibre Channel target HBA QLogic 2200F-33 and/or QLogic 23xxF

Refer to Table 1 for a description of SCSI and Fibre Channel adapters that can be used in the system.

Table 1 SCSI and Fibre Channel Adapters

Adapter Type Connection (external) Max cable length, m
LSI 20860 SCSI 50-pin high density SE 5
LSI18751D SCsSi 68-pin high density HVD 25
LSI 8951U SCSI 68-pin very high density LVD/SE 12(LVD), 5(SE)
QLA 2200 Fibre Channel SC duplex multi-mode -

QLA 23xx @ Fibre Channel Small form factor multi-mode optic LC -
Local P scsl - -

a. ‘xx’ means 00, 10, 40, and 42. No other models are currently supported.
b. The driver is designed by ADIC to execute the SCSI backup applications right on the Scalar DLC server PC. No SCSI/FC
hardware is required.

Redundant Solution Requirements

The Scalar DLC Redundant (failover) solution is provided using the Microsoft Cluster service. The user has
a shared disk with the Scalar DLC database and two hosts with the installed components of Scalar DLC

software; for redundancy reasons, one host is online and the other is offline. If an error occurs and the online
host goes offline, the other host turns online immediately, so the customer even does not notice a problem
with the host. The customer engineer can repair the problem host without stopping the Scalar DLC software.

The Scalar DLC Redundant solution is based on Microsoft Cluster service. The special requirements are:

+ Two PCs, each meeting the standards described in PC System Requirements on page 5.

e Microsoft Windows 2000 Advanced Server or Windows 2003 Server installed on each PC.
*  Microsoft Cluster Service installed on each PC.

* For each PC, there should be a minimum of two disk controllers. The two disk controllers do not
need to be the same type. For example, using on-board IDE and SCSI is acceptable.

* Atleast one external (shared) RAID disk. The disk partition should have NTFS formatting.

* RAID adapter (on each PC) to access a shared disk.

_ The Scalar DLC failover solution in a redundant configuration requires the
41y CAUTION  windows 2000 Advanced Server or Windows 2003 Server operating system.
By default, this system is configured without password protection for network
access. So ADIC strongly urges companies using this product to use all
customary procedures to protect Scalar DLC servers from external threats.
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For the details about Scalar DLC Redundant solution, refer to the Scalar DLC Installation Guide.

Tape Library Requirements

The library firmware and hardware requirements are described in this topic.

Operating mode
For the Scalar 1000 library, the following operating modes are supported:
* Native
+  EXABYTE compatibility
» Storage Technology compatibility
*  EMASS compatibility
For the Scalar 10K library only native mode is supported.
For the Scalar 10K DA (dual-aisle) library:
*  Both medium changers (aisles) must run in native mode.
*  Both medium changers (aisles) must operate in non-compressed mode.

» At the time of the first configuration, both medium changers (aisles) must be in the online state.
Ready state is not required.

_ The Scalar DLC software may not work properly if the tape library operates in
41y CAUTION  the unsupported mode.

Additionally, for the libraries with towers (Scalar 10K and Scalar 10K DA):

» At the time of the first configuration all towers (if any) must be in the library (online) state.

Firmware Version

Make certain the firmware version of each tape library meets the Scalar DLC requirements (Table 2).

Table 2 Required Firmware Version
Tape Library Required Firmware Comment
Scalar 1000 641A or later If the current version is 2.3 or earlier, contact
ATAC. A customer engineer will upgrade the
library with the appropriate firmware version.
Scalar 10K 300A or later
Scalar 10K DA 300A or later (for both robots)

Remote Browser Requirements

The Scalar DLC Management GUI takes advantage of very advanced Java2 features that are not supported
by all browsers. The browser updates can be initiated from the Scalar DLC software splash page by
selecting the Tools and Utilities tab. Refer to Figure 7 on page 13 and Browser Pre-Installation on page 11.
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Graphical User Interface

The Scalar DLC software GUI (also called Management GUI) is based on Web browser technology that
guarantees a consistent user interface across all UNIX and Windows platforms. The GUI is available to
users, system administrators, and customer engineers. The Management GUI consists of the following

components:

*  Main Menu bar
+ GUITabs
* Library tab
»  Configuration tab
* Eventstab
+ Service tab
+  GUILog

Each component is covered in detail in the following chapters.

Command Line Interface

The command line interface is supported by the DAS version 3.12 SP2 application. The DAS interface
supports numerous third party software applications.

Additional information about DAS is contained on this CD-ROM in the DAS Administration Guide document.

Service and Maintenance Alerts

The Scalar DLC software monitors all system resources and automatically notifies the ADIC Technical
Assistance Center (ATAC) whenever a service call is required. The information supplied to ATAC includes:

»  Error detection
« Eventlogging and tracing
*  Error recovery
Notification is generated by means of applications in the following list:
*  GUI Messenger
+ Email Home
« Call Home
+  SNMP

Each component is covered in detail in the following chapters.
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Configuration

This chapter provides information about logical configuration of the Scalar DLC system for the customer.

% Note Local administrator rights are required to install the Scalar DLC software and all required
components.

The sections are:

» Autostart Installation on page 9 describes the installation order.

+ Scalar DLC Management GUI on page 9 contains information on launching the Management GUI.

» Configuration on page 16 describes the configuration order.

Autostart Installation

To launch the autostart program, load the CD-ROM in the CD-ROM drive. If the autostart program does not
launch, use the Run option from the Start button on the task bar to execute the autorun.exe program.

For a description of the installation process, refer to Scalar DLC Installation Guide.

'Qg Note The Adobe Acrobat Reader version 4.0 or later is required to view the documentation in
PDF format. Download the most recent version of the software from the Adobe Web site
at http://www.adobe.com.

Scalar DLC Management GUI

The Scalar DLC Management GUI is started by either the browser-launched applet or the supervisory
desktop application. Before using any of them, determine that the Scalar DLC service is running.

@ Note Before starting the Management GUI, verify that the display resolution setting is 800 x
600 pixels or higher and the display color setting is more than 256 colors

To check the service state (refer to Table 3 on page 10), examine either the Control Panel > Services or
the task bar.
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Table 3 Scalar DLC Service State

Task Icon Description

The Scalar DLC supervisor service is stopped (Offline for the Scalar DLC Cluster
m solution). Double click the icon to display Figure 5.

The Scalar DLC supervisor service is started (Online for the Scalar DLC Cluster
ﬁﬁ solution). Double click the icon to display Figure 5.

for the Scalar DLC failover solution).

ﬁﬁ The Scalar DLC supervisor service is either starting or stopping (turning online/offline

Figure 5 About Scalar DLC
About ScalarDLC_State x|

ScalarDLC_State Version 1.0
Copyright [C] 2002 ADIC

Scalar DLC version information:

Build 2.6.0003

Kermel v. 2.6.0003
Jewellni v, 2,63
Object Server v, 263
GUI v 263

All right d
rights reserve

The About dialog shows the version of installed Scalar DLC software and its internal components. All Scalar
DLC hot fixes and service packs (if any) are enlisted here, too.

Resizing Windows and Panes

Some Management GUI panes contains data that cannot fit into the standard screen string (for example,

long names of SCSI Adapter objects, or partitions), or a long list of properties that would be useful to see

all in one screen without scrolling. Especially for such cases both the browser-based and application-based
Management GUI allow you to modify the size of the main Scalar DLC window screen as well as to resize
some internal Scalar DLC panes.

T4 Note Do not reduce the Scalar DLC screen below its original size.
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Browser Pre-Installation

Both Netscape Navigator ™ and Internet Explorer ™ browsers must be updated by installing the Java Plug-
in, as described in Java Plug-In on page 14, to take full advantage of the Scalar DLC Management GUI. For
a remote browser, the update is required before the browser can launch the Scalar DLC software. For a
local browser, the update could be executed manually; but it is best practice to install the browser(s) before
launching the Scalar DLC software installation. The update steps should be executed by either a system
administrator or an expert PC user.

@ Note The Internet Explorer browser is a required component for the Scalar DLC software
installation. If Internet Explorer is not present, the Scalar DLC CD autorun program
installs Internet Explorer as a part of the Scalar DLC Installation process. No pre-
installation is required for a complete installation.

Start the update procedure by entering the Host name location of the Scalar DLC software server on the
browser address line (for example, http://computer). This establishes a connection with the Scalar DLC
software home page. Refer to Table 4 and Figure 6 on page 12.

_ If the Scalar DLC software is installed with SSL support (refer to the Scalar
A1 CAUTION  pj ¢ Installation Guide), always use https:// instead of http://.

Table 4 Scalar DLC Home Page Name

Name /ID Value (example only) Explanation

DNS host computer The host network name used in DNS.

name

Cluster name | sdlccluster The cluster virtual name (redundant solution only),
refer to the Scalar DLC Installation Guide.

DNS address | 192.168.1.14 The host network IP address, refer to the Scalar DLC
Installation Guide.

Cluster DNS | 192.168.1.10 The virtual cluster IP address (redundant solution

address only), refer to the Scalar DLC Installation Guide .
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Figure 6  ADIC Scalar DLC Home Page
#} 5calar DLC Autorun - Microsoft Internet Explorer

J File Edit Wiew Favorites Tools Help

ﬂl‘a
] e

Launch Java Interface

After pressing this button pleage wait for
the Java GUI to appeat. Depending on the
network connection this can take up to 2 \ |
mitnates... | 1

Tools and Utilities

€5 1.800.336.1233 r

The only required component for the browser update is a Java Plug-in. Click the Launch Java Interface
button when it appears. Refer to Java Plug-In on page 14 for the description of update process.

Selecting the Tools and Utilities tab displays the Tools and Utilities pane (see Figure 7 on page 13).
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Figure 7 Tools and Utilities Page
/) scalar DLC Autorun - Microsoft Internet Explorer e 101 =l

J File  Edit  Wiew Faworites Tools  Help ﬁ
=

Installing the Management
GUI on a Remote System
How to install i ;
Install the Java Application . : Faifion
* Install '

Install the PkZip2.5
= [nstall

Downloading Browsers

Download MS Internet Explorer 5.5 - SR il
+ Download ' '

Download Netscape Navigator 4.74

« Download

5 1.800.336.1233 #

The latest required versions of both Netscape Navigator ™ and Internet Explorer ™ browsers can be
downloaded from this page.

Do not download the browser unless your browser version (always shown under Help >
T4 Note . .
About) is lower than required.

The Scalar DLC Management GUI that is designed to launch the Scalar DLC software application from a
remote host can be downloaded also. The installation steps of the Scalar DLC Management GUI are
described on this page as well.

Remote Management GUI

The Java-based GUI software is used as a Scalar DLC management tool. It is always installed on the Scalar
DLC server, however the same software can be downloaded from server and launched from a remote host
as well.

From the Tools and Utilities page (see Figure 7) click on “Install Java Application" and download the zip
archive containing all files for the remote Management GUI. The “How to install“ link contains the complete
instruction on how to install the package and launch the application.

Also download and install the Java Plug-In, as described in Java Plug-In on page 14.
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Java Plug-in

When running versions of Netscape Navigator prior to version 4.7, the Scalar DLC Management GUI
requires the Java 2 plug-in 1.4.2_09 release. Installing the plug-in enables direct Java2 applets to run while
using Sun’s JRE (Java Remote Environment). Therefore, the j2re-1_4 2 09-windows-i586-p.exe file must
be executed so that files are added to a specific directory.

Begin the procedure by selecting the hyperlink associated with the Java Plug-in. Save the file to a temporary

directory and then launch it.

The same update procedure should be executed when the Management GUI is used with the remote Scalar

DLC host.

@ Note The Java plug-in patch is also required for both the Microsoft Internet Explorer and
Netscape Navigator browsers when the user desires to use the applet-based GUI (refer
to Launch the Management GUI from a Browser on page 14) rather than application-

based (Launch the Management GUI as an Application on page 15).

However, the MS IE browser installs the Java plug-in patch automatically when the
browser-based Management GUI is launched for the first time.

The Netscape Navigator browser needs to be updated manually.

Launch the Management GUI from a Browser

Enter the Hostname location of the Scalar DLC server on the browser. This procedure establishes a
connection with the Scalar DLC home page. See Figure 6 on page 12.

B Disk write operations (upload) are not allowed from the browser-launched Scalar DLC
L Note . -
Management GUI due to security restrictions.

When the Scalar DLC home page appears, press the Launch Java Interface button. The Scalar DLC
Logon dialog window appears (see Figure 8).

Figure 8 Scalar DLC GUI Logon Dialog

Scalar DLC Logon

Llser name
| |

Fassward

| Ok || Cancel |

The default login settings are shown in Table 5.

Table 5 Management GUI Default Users

Default user name

Default password

Access level

admin

password

Admin (administrator)

atac

guardian

CE (customer engineer)
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_ Because of security reasons it is strongly recommended to change the default
41y CAUTION  admin and CE passwords after the configuration is complete.

For the details on user access level and settings refer to Users Tab on page 128.

Firewall and Proxy Issues

If the Scalar DLC Management GUI starts but can not connect to the Scalar DLC server, a firewall or proxy
server could be present between the browser and the Scalar DLC server. The remote methods invocation
transport layer normally attempts to open a direct socket connection to the host on the Internet. However,
many intranets have firewalls or proxies that do not allow this procedure.

The Management GUI cannot communicate with the Scalar DLC software server through a firewall if port
1099 is not open. Connections also are easier to make if the browser is not configured to use a proxy. If
necessary, contact the System Administrator to resolve any connectivity issues.

Launch the Management GUI as an Application

From the Windows desktop, launch the Scalar DLC Manager shortcut (Start > Programs > ADIC
Distributed Library Controller > Scalar DLC Manager, or double-click on the Scalar DLC Manager
desktop icon) to enable the host connection window (see Figure 9).

The operation can be executed either from local host where the Scalar DLC software is installed or from a
remote host after installing the Management GUI, as described in Remote Management GUI on page 13.

Figure 9 Host Connection Window

E Enter hostnarne:
| |

| 0]78 || Cancel ‘

Enter the Scalar DLC hostname in the dialog window. Then the Scalar DLC log on dialog appears. See
Figure 8 on page 14.

B Disk write operations (upload, download) are allowed from the application-based Scalar
£ Note
DLC Management GUI.
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Configuration

When a user is logged into the Management GUI and no previously configured physical library has been
found, a configuration selection pane opens automatically (see Figure 10); if the configuration has been

performed, this pane will not appear. Choose the configuration method.

Figure 10  Configuration Window

[¥ | Automatic configuration (Default)

This mode canfigures the Scalar DLC system with default settings.
Mo additional knowledge is required. Recommended for normal users.

[ Manual configuration (Wizard)

Inthis made a wizard will guide yau through the Scalar DLC system
canfiguration. This requires hasic knowledge ofthe system structure.
Recommended far experienced users anly.

[ Advanced configuration (Expert)
This mode allows you to configure the Scalar DLC according to persanal

preferences. This reguires extensive knowledge ofthe Scalar DLC
systemn structure. Recammended for advanced users anly.

" Ok

Either accept the default configuration or select the desired configuration method.

+ Automatic Configuration on page 17 is recommended for the first-time users that have no
experience in configuring the Scalar DLC system.

*  Wizard-based Manual Configuration on page 18 is recommended for the users with basic
knowledge about the configuration of the Scalar DLC.

« Advanced Configuration on page 18 is designed for the advanced users that have enough
experience to perform all configuration manually.

« After the basic configuration is finished, an Additional Configuration on page 23 could be performed.

Some client interfaces have certain limitations concerning the names of used objects, for example, some
DAS-based applications do not recognize the mailbox name for Insert command other than Ixx (xx means
any two alphanumeric characters). To avoid such issues, be sure that the objects created and configured
by means of the Scalar DLC Management GUI are named as shown in the Table 6.

T4 Note

Some customer (client) applications do understand the capitalization difference (A and
a), the others do not. ADIC recommends using the common alpha-model (either capitals
or small letters in all object names).

ADIC also strongly does not recommend using spaces (“ “), underscores (“_"), hyphens
(“-") and other symboils in the object names. Even when the Scalar DLC Management
GUI permits this, the client application may not recognize the appropriate object.

Table 6 Object name limitations
Object GUI Manager DAS / ACI ROBAR ScCsi
Host 40 an?, a first 40 an, a first An None
Logical library 30 an, a first None (absent) None None
(absent)
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Table 6 Object name limitations (Continued)
Object GUI Manager DAS / ACI ROBAR ScCsi
Partition 30 an, a first None (absent) None None
(absent)
Client 80 an, a first 80 an, a first 80 an, a first | None
Scratch pool 30 an, afirst 16 an, a first None None
(absent)
Clean pool 30 an, a first 16 an, a first Paa None
Data cartridge, volser | 30 an 16 an (6 6 an None
recommended)
Cleaning cartridge, 30 an 16 an (CL +4 an CL+4an None
volser recommended)
Mailbox area, eject 30 an, a first 3 an, Enn Enn None
operations recommended
Mailbox area, insert 30 an, a first 3 an, Inn Inn None
operations recommended
Drive 40 an, a first 30 an® (9 an, a first Dnn None
recommended)

a. alphanumeric; “a” means “alpha” (A-Z), “n” means “numeric” (0-9).
b. Only for DAS ACI ver. 3.12 and higher.

Automatic Configuration

ADIC recommends the automatic configuration for typical or first time users. Using the automatic
configuration, create a default Scalar DLC configuration for each detected physical library.

The automatic configuration creates the configuration by executing the following procedures:

Step 1 Scans the SCSI bus for physical libraries.

Step 2 Creates partitions for all the physical library elements.

Step 3 Creates a logical library.

Step 4 Assigns all created partitions to the logical library making it a representation of the whole
physical library.

Step 5 For the logical library, creates two identical mailboxes (101 and E01) that include all the mailbox
slots.

Step 6 Creates a client and assigns it to the logical library.

By default, if the DAS Client support is installed, the created client is the DAS Client; if
not, no client can be created because the SCSI and ROBAR interfaces need certain pre-
configuration.

T4 Note
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Manual Configuration

For advanced users, the wizard-based configuration automatically scans for libraries and creates physical
library objects by executing the following step-by-step procedures:

Step 1 Scans the SCSI bus for physical libraries.

Step 2 Creates partitions for all the physical library elements.
Step 3 Creates a logical library. The library name can be specified. Also refer to Table 6 on page 16.
Step 4 Assigns the partitions to the logical library. It is possible to select a method of assignment:

single-media library, single-robot library, and the complete library selection are available for the
first-time manual configuration.

Step 5 Creates two identical mailboxes covering all the mailbox slots. The mailbox names can be
specified. Also refer to Table 6 on page 16.

Step 6 Creates a client and assigns it to the logical library. The client name can be specified. Also refer
to Table 6 on page 16.

‘Qi Note By default, if the DAS Client support is installed, the created client is the DAS Client; if
not, no client can be created because the SCSI and ROBAR interfaces need certain pre-
configuration.

Refer also to Create Configuration on page 32 for the detailed description of steps.

Advanced Configuration

ADIC recommends this mode for expert or administrator users. In this mode, only the icon associated with
the Scalar DLC software system appears.

To enable all the Management GUI functions, create a working configuration by performing the procedures
in the following sections:

Rescan SCSI Bus

Create the device objects associated with a physical library by using the Rescan SCSI Bus button on the
Configuration > Physical > Controller pane. Refer to Physical Tab on page 112.

Create Partitions

Create the partition objects representing desired parts of the Physical Library. That can be done on
Configuration > Physical > Library pane (Add new Partition button). Refer to Create Partition on page
127.

Qi Note There should be at least three partitions created for each physical library: storage, I/E,
and drive. Refer to Partition on page 119 for the details.

The partition properties can be modified later, even after the partition is assigned to a logical library, via the
Configuration > Physical > Partition pane. Refer to Partition on page 119.
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Create a Logical Library

Create alogical library. That can be done on the Configuration > Logical pane (Add new Library button).
Refer to Create Library on page 107.

Immediately after creation, the logical library is shown as Invalid. That is correct: Invalid state indicates that
the library does not contain a proper set of partitions.

Assign Partitions to a Library

Assign the previously created partitions to the new logical library. That can be done through the
Configuration > Logical > Library pane (Assign new Partition button) or Assign Partitions wizard in Main
Menu > Wizards section. Refer to Assign Partition on page 108 or Assign Partitions on page 38.

‘Qﬁ Note There should be at least three partitions assigned to each logical library: storage, I/E,
and drive. The partition can be shared between two or more logical libraries. Refer to
Partition on page 93 for details.

The partitions can also be assigned or unassigned at a later time.

Create Mailbox

Create one or more mailboxes for a logical library. They will represent its insert/eject areas. This can be
done through the Configuration > Logical > Library pane (Add new Mailbox button). Refer to Create
Mailbox on page 110.

@ Note Although Management GUI does not have name restrictions for the mailbox name, some
backup applications do have them. Refer to Table 6 on page 16.

The mailbox name and assigned range of insert/eject slots also can be changed later through the
Configuration > Logical > Mailbox pane (Add/Remove new Slots button). Refer to Assign Slots to
Mailbox on page 100.

Create Client

Create the client object(s) that will represent the customer(s) that will work with the library. Depending on
the interface used, the clients are DAS Clients, SCSI Clients, or ROBAR Clients. Some clients may share
a single logical library.

_ Setting up the SCSiI client to share the logical library with any DAS- or ROBAR-
41y CAUTION  pased client may cause problems in the work of the client application. Both
DAS and ROBAR interfaces do have the same concept of the cartridge home
position (refer to Home Position on page 79) but the SCSI does not because it
uses only ‘move’ commands.

DAS

The DAS Client can be created via the Configuration > Clients > DAS pane (Add new Client button).
Refer to Create DAS Client on page 144.

SCSI

The SCSI Client can be created via the Configuration > Clients > SCSI pane (Add new Client button).
Refer to Create SCSI Client on page 155.
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Note that the Target and LUN objects must be created before via the Configuration > SCSI Target > Port
pane (Add new Target button), and Configuration > SCSI Target > Port > Target pane (Add new LUN
button). Refer to Create Target on page 169 and Create LUN on page 170.

@ Note It is strongly recommended to create Targets and LUNs as a continuous range of
elements starting from 0 (TargetO, Target1, Target2, etc.; LUN 0, LUN1, etc.).

ROBAR

The ROBAR Client can be created via the Configuration > Clients > ROBAR pane (Add new Client
button). Refer to Create ROBAR Client on page 160.

Note that the ROBAR Port must be configured before the clients can send commands (refer to ROBAR on
page 156).

Initialize the Logical Library

The library must be initialized for its internal elements and cartridges to be created. It can be done by using
the Inventory button. The same command can be done via the client interface.

Once the initialization process is completed, the library functions are available.

Assign Drives to Cartridges

After the cartridges are created, they may be assigned to the appropriate drives for use by the Generic
mount operation. This will use the assigned drive as the first position in the list of possible mount
destinations. A cartridge can be assigned to one and only one drive, but the drive can be assigned to
multiple cartridges.

The assignment executes (and can be changed later) through the Configuration > Logical > Cartridge
pane (Cartridge properties > Assigned Drive >> Save changes). Refer to Cartridge on page 94.

@ Note This optional feature is not required for SCSI or ROBAR clients, but some DAS clients
do use it.

Inserting New Media

After adding new cartridges to the library through the mailbox always execute Import (insert) operation
(either via client interface or in Management GUI) before starting actually using the new media. The
cartridge that was not inserted can not receive the valid home position (refer to Home Position on page 79),
and thus a lot of basic functions will be not available.

Qé Note The Home Position feature is not used by SCSI clients, but for DAS and ROBAR the
home position (home slot, home address) is a part of their concepse.

Assigning a home position via import/insert operation is sometimes the only way to put the cartridge in the
correct logical library.

Example: two libraries (Library1 and Library2) with two different clients (Client1 and Client2) have non-
shared storage areas and a shared I/E area. The cartridge that should be accessed by Client2 is put to the
shared mailbox. Client2 (or Admin from GUI in the Library2) must execute the import/insert operation so the
cartridge will go to the storage area of Library2. But if the Client1 launches the import operation first, the
cartridge will go to the Library1 and become not accessible for the Client2.
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Create Scratch Pool

Create the required scratch cartridge pools for a logical library. The scratch pools should contain the data
cartridges ready for writing. That can be done through the Configuration > Logical > Library pane (Add
new Scratch Pool button). Refer to Create Pool on page 109.

\E’g Note Although Management GUI does not have name restrictions for the pool name, some
backup applications do have them. Refer to Table 6 on page 16.

In the same dialog it is possible to add data cartridges to the new pool (Assign/Unassign button). Refer to
Assign Media to Pool on page 98.

_ Sharing a single data cartridge between two or more scratch pools is not
415 CAUTION  ajjowed.

The pool name and assigned cartridge range can be changed later through the Configuration > Logical >
Pool pane. Refer to Pool on page 97. Some DAS and ROBAR clients may also assign cartridges to the
existing pool as well as remove them.

@ Note Itis possible to create pools before Inventory, but the cartridges will appear in the library
only after it is initialized.

Mark Cleaning Cartridges

After the Inventory is performed, the logical library recognizes all cartridges that it contains. However, the
library cannot say which cartridge is of data type (readable and writable data carrier), and which is of
cleaning type (the tool used for drive cleaning). By default, all cartridges are recognized as data, so it is up
to Admin to mark the correct cartridges as cleaning.

This can be done through the Configuration > Logical > Cartridge pane (Cartridge properties > Type
(data/clean) >> Save changes). Refer to Cartridge on page 94.

If the cartridge is marked as cleaning by mistake, and in fact it is data, change its type back the same way.

‘Qﬁ Note The type of cartridges that are already assigned to the scratch or clean pool cannot be
changed.

Create Clean Pool

Create the required clean pools for a logical library. The clean pools should contain the cleaning cartridges
ready to perform drive cleaning operations. That can be done through the Configuration > Logical >
Library pane (Add new Clean Pool button). Refer to Create Pool on page 109.

@ Note Although Management GUI does not have name restrictions for the pool name, some
backup applications do have them. Refer to Table 6 on page 16.

In the same dialog it is possible to add cleaning cartridges to the new pool (Assign/Unassign button). Refer
to Assign Media to Pool on page 98.
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_ Sharing a single clean cartridge between two or more cleaning pools is
A1 CAUTION  3jlowed. Watch however the state of that cartridge with extreme caution.

The pool name and assigned cartridge range can be changed later through the Configuration > Logical >
Pool pane. Refer to Pool on page 97. Some DAS and ROBAR clients may also assign cartridges to the
existing pool as well as remove them.

\.g Note The cartridges appear in the library during Inventory, but only Admin can mark the
cartridge as cleaning, as described in Mark Cleaning Cartridges on page 21. Also the
‘insert cleaning cartridges to pool’ operation can be executed via DAS by DAS Client.

Configure Clean Manager

After the cleaning pools are created and configured, they can be assigned to the appropriate drives for the
drive cleaning operation. Cleaning can be executed either automatically or by client request. This can be
done via the Configuration > Logical > Drive pane (Drive properties > Cleaning). Refer to Drive on page
104. Specify the correct cleaning time according to the drive type and model. Specify also the cleaning rate
(the number of mounts between cleanings).

Configure Aliasing

Some DAS Clients use old vertions of backup application that cannon correctly recognize the newest
models of media and drives, but must work with such models nevertheless. To fix this issue, Scalar DLC
provides an Aliasing feature.

Using Configuration > Clients > DAS > DAS Client pane > Aliasing (refer to Aliasing on page 143) for
either drive or media (or both) select the alias that the backup application ’'understands’ instead of its default
type that the application cannot recognize. Then press Save button to update the client properties. The
Scalar DLC restart is not required, the client application restart is not required, too.

@ Note This feature is optional and used only by some DAS clients.

Reserve Drives and Cartridges

Some DAS clients may reserve the drives and the cartridges which means no one but the client will access
the appropriate resource.

_ The drives and cartridges reserved/allocated by Client1 cannot be accessed
41y CAUTION by other clients. The allocation must be removed before the other client can
access the reserved resource.

Removing the allocation made by another client is also possible from the
client side by the special command (allocd, allocv) if the client has Supervisor
privileges.

Enter the appropriate values through the Configuration > Clients > DAS > DAS Client pane (Reserved
Drives > (Select Drive) >> Reserve; Reserved Volsers >> Add Volserrange, Remove Volserrange). Refer
to Drives on page 138 and Reserve or Define Volsers on page 142. Also the customer may perform a
reserve operation by using the special commands (allocd, allocv) from the client side.
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@ Note This feature is optional and used only by some DAS clients.

@ Note Using the Management GUI Admin can execute any operation whether the used
medium and/or drive is reserved or not.

Also Admin can remove the allocation, either through Configuration > Clients > DAS
> DAS Client pane (Reserved Drives >> Specify >> Save changes; Reserved Volsers
>> Add Volserrange, Remove Volserrange), or through Configuration > Logical >
Drive (Drive properties > Owner >> None >> Save changes) and Configuration >
Logical > Cartridge (Cartridge properties > Owner >> None >> Save changes).

Define Drives and Cartridges

Some DAS clients may define the drives they will use and the cartridges they may access.

_ The drives and cartridges defined by Client1 are in common use, but the
41y CAUTION  cjient1 itself can access only the defined drives and media. ‘None defined’
means the Client1 can use all drives and all media in the library it is assigned
to.

Define the appropriate values through the Configuration > Clients > DAS > DAS Client pane (Defined
Drives >> Specify >> Save changes; Defined Volsers >> Add Volserrange, Remove Volserrange). Refer to
Define Drives on page 140 and Reserve or Define Volsers on page 142. Also the customer may perform a
temporary define operation by using the special command (scop2) from the client side.

Q@ Note This feature is optional and used only by some DAS clients.

Configure Additional Libraries

Follow the sequence of the previous procedures to configure additional logical libraries.

‘fg Note A re-initialization of the library is necessary if the library properties are changed.

Additional Configuration

The following actions can be performed to make the Scalar DLC more user-friendly.

Create User

By default, the Scalar DLC contains two pre-defined users to work with Management GUI: default
administrator (admin) and default customer engineer (atac). More users can be created.

Step 1 Log on the Management GUI as administrator.
Step 2 Using Users Tab (Configuration > Users tab >> Add new User) create the new user selecting

the user access level and user rights, and specifying login, password, and email settings. Refer
to Create User on page 132 and Table 21 on page 129.
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Update ATAC Settings

All problem reports (tickets) created by the customer will be sent by default to ATAC on
“‘watchman@adic.com®. This can be changed if required. Do the following:

Step 1

Step 2

Step 3

Log on the Management GUI as administrator. Check the Scalar DLC email notification settings
on Main Menu > Extended Service > Registration Information pane. Refer to Registration
Information on page 55. The “Email Notification® field must be checked, and the “SMTP server”
and “port” parameters must contain valid information. Contact the local network administrator
for details.

Open Configuration > Users Tab and select the default CE “atac” (refer to User on page 131).
Change the email settings from “watchman@adic.com* to the required value.

Restart the Scalar DLC service for the changes take effect.

Configure Email Notifications

To notify the customer via email that the given operation has been performed:

Step 1

Step 2

Log on the Management GUI as administrator. Create the working configuration. Refer to
Automatic Configuration on page 17 or Advanced Configuration on page 18.

Using the Rule Wizard (Main Menu > Wizards > Create Rule) create the rule that will react
when a certain event occurs in the system and will send a notification about this event to a
certain email address. Refer to Create Rule on page 45.

‘Qﬁ Note The Scalar DLC database contains the email addresses of all users (refer to User on

Step 3

Step 4

Step 5

page 131) and the email addresses that were entered manually during rule creation (see
Figure 37 on page 53 and Figure 38 on page 53). If the required email address is present
in this list, it can be selected during the rule creation process; if not, it can be entered
manually and will be thereby added to the database.

After creating the rule, go to Events > Rules Tab and ensure that the rule is correct and active.
Refer to Rules Tab on page 179.

Check the Scalar DLC email notification settings on Main Menu > Extended Service >
Registration Information pane. Refer to Registration Information on page 55. The “Email
Notification” field must be checked, and the “SMTP server” and “port” parameters must contain
valid information. Contact the local network administrator for the details.

Restart the Scalar DLC service for the changes to take effect.

The received email shall look as follows:

24

Packet Type: <Automatically Open Ticket>

Packet Revision Level: <2.6 build 3>

Current Time: <Friday, Nov 19, 2005 04:07:08 PM>

Scalar DLC s/n: <DLC12345>

Packet Number: <{AFC3A8D1-EE87-4C45-913B-A949907E1D63}.92.3>
Site ID: {}

Source: <Automated: DLC12345>

Total call Time: <N/A>

# of times packet was sent: <0>
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Site ID: {}

Caller Name: <Automated: DLC12345>

Caller Phone: <none>

Modem Phone: {}

Call-In Enabled: {yes}

Company Name: {Scalar DLC Installation}

Call Type: {not available}

Call Subtype: {not available}

Device: {not available}

System Serial Number: {ADIC Scalar 1000 #111111111}
Item Serial Number: {not available}

Service Action Code: 80

Service Action Code Modifier: <12345678>

Service Action Code Description: <Failures detected in the X-axis Servo
system.>

Priority: <not available>

Description: <General hardware problem>
Configuration Table: <not available>

Physical Library Name <ADIC Scalar 1000 #11111>

@ Note Some fields may be empty, or contain <none> or <not available> which is correct
especially in case of the automatically created/opened tickets with the appropriate email
notification.

Installing New Slots

When the new slot (for example, drive) is installed in the physical library, perform the following actions so
that the Scalar DLC logical libraries have the correct reflection of the current hardware.

Step 1 Install the slot(s), make all proper connections according to the library Operator Guide.

Step 2 Execute Teach command from the robot Operator Panel. After the command is finished (that
may take some time) the slot will appear in appropriate range of the physical library.

Step 3 For each newly installed slot, verify the partition settings.

a. Ifthe new slot has appeared in the unpartitioned space, then everything is correct and it can be
used as any other slot after adding to the appropriate partition.

b. If the new slot has appeared in the partitioned space and its type and media domain match the
existing partition properties, it is accessible for every client that can access the appropriate
partition.

c. If the new slot has appeared in the partitioned space and its type and media domain do not
match the existing partition properties (for example, SDLT 220 Drive appeared in the middle of
IBM LTO Drive partition), the newly installed slot becomes incompatible, and the Management
GUI shows it (see Table 16 on page 67 and Table 15 on page 66).

Admin must manually correct the situation by changing the range of the existing partition until
it will not cover the new (not compatible) slot. Then another partition must be manually created
and assigned to the appropriate logical libraries. Perform a complete inventory after all
assignments are done.
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Operating the Tape Library Doors

It is possible to stand up right before the tape library device and manipulate its doors when the Scalar DLC
is in work. Moreover, it is required sometimes.

The Scalar DLC will reflect as much as it could, but some operations (especially executed by the clients who
use backup applications and do not monitor the resource before launching the command) are to be failed
when the doors are opened.

Front Door

When the front door is in open state, the Scalar DLC resources can be described as follows:

Element State, single-aisle library State, dual-aisle library
Robot Offline Offline
Physical library Offline Online @
Partition, drive, storage, mailbox Offline Online / offline °
Logical library Offline Online / offline ©

a. That is, online if the second front door is closed and the second robot is online.
b. Depends on the state of the robot where the partition is physically located on, whether it is offline or online.
c. Depends on the partitions the library contain, whether all of them are offline or some are online.

When the front door of Robot1 on the dual-aisle system is opened, the Robot2 may still perform operations
that do not use resources managed by Robot1 (for example, mount from <Robot2 storage> to <Robot2
drive> shall pass). If the customer-requested resource is in Robot1 control, the Scalar DLC marks the
resource as ‘not accessible’ and the operation shall fail.

BE VERY CAREFUL WHEN OPENING THE FRONT DOOR. THE AISLE
ﬂ WARNING  MECHANICS WILL GO OFFLINE WHEN THE DOOR IS OPENED BUT IT TAKES
TIME.

After the front door is closed the robot must be manually turned online from the operator panel. Then the
robot starts the complete inventory operation to check whether the new elements are installed, and if so,
map them correctly.

I/E Station Door

When the door of insert/eject station is opened the Scalar DLC marks the elements of this station as ‘not
accessible’. Any operation that involves the non-accessible resource (for example, move to the non-
accessible mailbox slot) will fail. The other operations (for example, dismount, clean, move to the mailbox
slot of the other insert/eject station) shall pass.

Closing the insert/eject door starts the partinventory (partial inventory) of the appropriate insert/eject
station to check whether the new cartridges were put in the library or the cartrigdes ejected to the mailbox
were removed.
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Managing the Database

The separate Database Tool (refer to Database Tool on page 206) is used for every operation that is
allowed with the Scalar DLC database. The tool is launched from Start > Programs > ADIC Distributed
Library Controller > Scalar DLC DB Tool (or right-click on Scalar DLC tray icon and then Tools > Scalar
DLC DB Tool).

Set Up Database Backup Mode

Step 1 Launch DB tool, log in and open Extended mode tab (refer to Extended Mode on page 209).

Step 2 Check Full recovery mode box if the database is to be backed-up with full information. Uncheck
the box if only the database itself is to be backed-up.

Step 3 Press Apply button to apply settings, them Exit to close DB tool.

Schedule Database Backup

Step 1 Launch DB tool, log in and open Backup tab (refer to Database Backup on page 207).

Step 2 Set up the Backup destination in automatic backup. Check the Time-generated file names box
if the backup files are to be named according the backup date.

Step 3 Set up the Backup schedule and then check Enable schedule box.

Step 4 Press Apply button to apply settings, them Exit to close DB tool.

Schedule Transaction Logs Backup

Step 1 Launch DB tool, log in and open Extended mode tab (refer to Extended Mode on page 209).
Step 2 Set up the Destination in automatic transaction logs backup.

Step 3 Set up the Schedule and then check Enable schedule box.

Step 4 Press Apply button to apply settings, them Exit to close DB tool.

Backup Database Manually

Step 1 Launch DB tool, log in and open Backup tab (refer to Database Backup on page 207).

Step 2 Set up the Backup destination in Manual backup.

Step 3 Press Execute button to backup the database to a file, them Exit to close DB tool.

Schedule Database Compact

Step 1 Launch DB tool, log in and open Compact tab (refer to Database Compact on page 212).

Step 2 Set up the Compact schedule and then check Enable schedule box.

Step 3 Press Apply button to apply settings, them Exit to close DB tool.
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Compact Database Manually

Step 1 Launch DB tool, log in and open Compact tab (refer to Database Compact on page 212).

Step 2 Press Execute button to compact the database, them Exit to close DB tool.

Restore Database from Backup

Step 1 Launch DB tool, log in and open Restore tab (refer to Database Restore on page 214).

Step 2 Stop the Scalar DLC software (bring offline for a failover solution).

Step 3 Select Database to restore from a regular backup, then select a backup from a database
backup list.

Step 4 To restore the database with transaction logs, check also Restore with logs box and select the

transaction log.
Step 5 Press Restore button to restore the database, them Exit to close DB tool.

Step 6 Start/bring online Scalar DLC again.

Restore Database from File

Step 1 Launch DB tool, log in and open Restore tab (refer to Database Restore on page 214).
Step 2 Stop the Scalar DLC software (bring offline for a failover solution).
Step 3 Select From device to restore from a file, then select a device name (file) to restore the

database from.

Step 4 Change the names for a database file and transaction log file if the default values are not good
enough.
Step 5 Press Restore button to restore the database, them Exit to close DB tool.

Step 6 Start/bring online Scalar DLC again.

Archive Database
Step 1 Launch DB tool, log in and open Save tab (refer to Database Save on page 216).
Step 2 Set up the Destination.

Step 3 Press Save button to save the database archive to a file, them Exit to close DB tool.
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Management GUI

This chapter describes the structure of Scalar DLC Management GUI and provides a brief description of its
functionality.

The Management GUI screen is divided into three areas (see Figure 11 on page 30).

»  The upper portion of the screen contains the Main Menu bar. Refer to Main Menu Bar on page 30.

» The center portion of the screen contains the library related menus, configuration and service tabs,
and more. Refer to GUI Tabs on page 61.

*  The lower portion of the screen holds the GUI Log. Refer to GUI Log on page 69.
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Figure 11 Management GUI
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Main Menu Bar

The Main Menu Bar contains five sections. See Figure 12 on page 30. The sections are:

Screen Refresh Icon. Forces the Management GUI screen to refresh. Refer to Screen Refresh Icon
on page 31.

Connection. Contains the user connection options. Refer to Connection on page 31.

Wizards. Contains the wizard-based engines for configuring logical libraries, assigning partitions,
creating tickets, and creating rules. Refer to Wizards on page 32.

Extended Service. Contains some service panes like registration information, online log viewer etc.
Refer to Extended Service on page 54.

Help. Contains Management GUI help panes. Refer to Help on page 60.

Figure 12 Main Menu Bar
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Screen Refresh Icon

The broad black bar containing the red ADIC logo is a screen refresh icon. It also contains the user-to-host
connection status (as at the example picture, User admin connected to computer, where admin is the user
name and computer is either the Scalar DLC host name or the Scalar DLC cluster name). This button
forces the Management GUI screen to refresh.

Icon Description

Refresh the Management GUI screen.

The black bar itself acts as the refresh button, too.

‘Qi Note Depending on the PC performance and the current Scalar DLC configuration, the refresh
may take up to several minutes.

Qi Note Some update (for example, library statistic) is not performed by the global refresh but
requires special refresh operarion initiated by an appropriate button.

Connection

This section contains the basic Log off and Exit operations.

Options Name Description

Connection | Log Off Log off the Management GUI. A new log on dialog appears.

Log O Exit Close and exit the current applet or application and log off the user.
Exit
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Wizards

The Wizards section contains the wizard-based engines used to create some Scalar DLC internal elements.
It contains the following options:

Options Wizard Description Access

Wil | Create Creates the logical library according to the Admin only
Configuration  user-specified values (library name, assigned
client, etc.). Refer to Create Configuration on

Create Configuration

Assign Paditions

Create Ticket page 32.
Create Rule Assign Either assigns a number of partitions to the Admin only
Partitions logical library, or removes a number of

partitions from the logical library (without
deleting these partitions physically). Refer to
Assign Partitions on page 38.

Create Ticket Creates the report issue (ticket) which will be  All users
immediately sent to the ADIC Technical
Support Center (ATAC). Refer to Create
Ticket on page 40.

Create Rule Creates the rule that will notify the specified Admin only
user or person that a certain event has been
occurred. Refer to Create Rule on page 45.

All wizards contain the same operational buttons (Table 7).

Table 7 Wizard Buttons

Name Icon | Operation Description
First « Click Return to the first dialog (disabled at the first wizard dialog).
Previous “ Click Return to the previous dialog (disabled at the first wizard
dialog).
Next ' Click Go to the next wizard dialog.
Create/Finish vy Click Create (only at the last dialog).
Cancel/Exit x Click Cancel creation or exit wizard after successful creation.

Create Configuration

The Configuration wizard: creates a logical library that covers all the parts of the selected physical library;
creates two identical mailboxes (I01 and E01) that cover the entire insert/eject area; and assigns a client to
the created library. The wizard automatically creates the required partitions in the ranges of a physical
library and assigns them to the logical library.
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Selecting the Create Configuration option activates the Configuration wizard. The first dialog is Physical
Library selection. See figure below.

Figure 13  Select Physical Library

ADIC Scalar 10K #11111

Select Physical Library:

| 4 | P et H X Cancel ‘
Name Operation Description
Select Physical Select Select the physical library from the combo box. The created
Library library will be based on the selected device.

The next dialog is Logical Library Selection. See figure below.

Figure 14 Select Logical Library

Mame of new Logical Library:

Libraryd

| M First H 4 Previous H P et H X Cancel ‘

Accept the default name or enter the desired name. ADIC recommends accepting the default name while
being sure not to duplicate the name of existing libraries.

Name Operation Description

Name of new Logical Library  Enter Enter the new logical library name.
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The next dialog is Configuration Method selection. See figure below.

Figure 15 Select Configuration Method
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Operation Description

Select by Media Create the single-media library.

Type The Next button will show the Figure 16 on page 35
with the media selection dialog.

analogously Create the copy of already created library.
to existing Enabled only when there is at least one logical library
library already.

from unused
elements

from
elements by
R1

from
elements by
R2

from
elements by
R1 & R2

The Next button will show the Figure 17 on page 35
with the prototype selection dialog.

Create the library from the elements that are currently
not assigned to any other logical library.

Enabled only when there is at least one not assigned
element in a physical library.

Create the library from the elements available for the
Robot1.

Create the library from the elements available for the
Robot2.
Enabled only for the dual-aisle physical library.

Create the library from the elements available for both
Robot1 and Robot2
Enabled only for the dual-aisle physical library.
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Figure 16  Select Media
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Name Operation Description

Detect media type Select Select the media type for the single-media library. Refer to
Media Types on page 246.

Figure 17  Select Library Prototype
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Name Operation Description
Select logical library Select Select the existing logical library which will be the prototype for

the new library.
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The next dialog is Mailbox selection.

Figure 18 Select Mailbox
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Accept the default names or enter the desired names. ADIC recommends accepting the default names.

Name Operation Description
Name of new Maibox  Enter Enter the name of the new mailbox (EOQ1 for export).
Name of new Maibox Enter Enter the name of the new mailbox (101 for import).

The next dialog is Client selection. See figure below.

Figure 19 Select Client
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Name Operation Description

Select the Select DAS Client creates the DAS client with all parameters by default.
type of new Always available if the DAS Client support is installed.
Client

SCSI Client creates the SCSI Client assigned to the first free LUN of
the first existing Target. Available only after the SCSI is configured (at
least one target is created and at least one LUN is free). Refer to
Create Target on page 169 and Create LUN on page 170.

ROBAR Client selects the ROBAR Client. Available only after the
ROBAR interface is configured (non-zero port is specified). Refer to
ROBAR on page 156.

Name of new Enter Enter the name of the new client.
Client

Accept the default name or enter the desired name. ADIC recommends accepting the default name while
being sure not to duplicate an existing client name.

The next dialog is Configuration Summary. See figure below.

Figure 20 Configuration Summary
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Name Operation Description
Summary Supplied Be sure that the data entered from the previous dialogs is correct.
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The final configuration dialog then appears.

Figure 21  Configuration Complete
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Name Operation Description

Operation list  Supplied The list of operations executed by configuration wizard.

Assign Partitions

The Partition Assignment wizard assigns the partition(s) to the logical library or executes the backward
operation. The logical library and the partitions to assign must be created before launching the wizard.

Selecting the Assign Partitions option activates the Partition Assignment wizard.

There are two types of Partition Assignment wizard first screens. Figure below appears when the selected
logical library contains at least one partition.

Figure 22 Partitions Contained
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Figure below appears when the selected logical library contains no partitions.

Figure 23 Partitions Not Contained
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Name Operation Description
Select Logical Library  Select The logical library to assign/unassign partition(s).
Select Physical Supplied The physical library whose partition(s) are already assigned to
Library the selected logical library.
Select The physical library whose partition(s) should be assigned to

the selected logical library.

The next wizard screen shows the assign/unassign dialog.

Figure 24 Partition List
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Name Operation Description
Library name  Supplied The logical library to assign/unassign partition(s).
Partition(s) Check The checked partitions are, or should be, assigned to the logical

library. The not checked partitions currently are not assigned to the
library or should be unassigned from it. The changes are marked with
asterisks.
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Name Operation Description

Partition Supplied Name Partition name.
properties - :
Class Partition class (Storage, I/E, Drive). See Table 13 on
page 65.
Type Partition media type. Refer to Storage Types on page
247, Mailbox Types on page 248, or Drive Types on
page 249.
Start Starting address in the range of the partition elements.
End Ending address in the range of the partition elements.

Figure 25 Partitions Summary
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Name Operation Description
Summary Supplied Shows the summary for the assign/unassign partition(s)

Create Ticket

Ticket is a brief report of the problem encountered by the user that should be solved by ADIC Technical
Assistance Center (ATAC). After the ticket that describes the problem is created, the email notification is
sent to ATAC. The ATAC solution will allow the CE (customer engineer) to begin working toward a solution
of the problem. Information supplied to the ticket becomes a part of the ATAC Calls pane. Refer to ATAC

Calls Tab on page 189.

Selecting the Create Ticket option activates the Ticket wizard.

40 Management GUI



Figure 26 Ticket Registration
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Name Operation Description
Enter your name Enter The issue originator name.
Enter your phone Enter The issue originator contact phone number.
number
System Serial Supplied The system serial number (taken directly from the Scalar DLC
Number Database).

The Ticket Priority and Description dialog is the next step in the wizard process. A priority is selected, and

a description of the problem is entered.

Figure 27 Ticket Priority and Description
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Name Operation Description

Select a Select Critical means the problem must be solved immediately. Highest
priority for priority.
the ticket

Urgent means that solving the problem is very important but not critical.
High priority.

Major means that the problem should be solved. Medium priority.
Minor means that the problem should be solved. Low priority.
Enhancement means that the problem should be solved. Lowest priority

Enter a brief  Enter
description of A description of the problem.
the problem

The Ticket Category dialog is used to select a category for the problem. The frequency of the problem is
established.

Figure 28 Ticket Category

& Create Ticket
—
9%
1
A A
782%
L _ﬁﬁ ; Select a category that describes the problem: ‘ Do not know - |
A
o B
oo e
] ot !
e
-
|
. Sy i Did the prablem occur once ar repeatedly? ‘ Do not know - |
—=
4 First 4 Previous P rext X Cancel
Name Operation Description
Select a Select Do not know means the problem category is unknown.
problem )
category that Operator means the problem source is an operator error.
desg:lnbes the Hardware means the problem source is a hardware error.
problem

Firmware means the problem source is a software error.
Service call means the user has asked for service help.

Configuration means the problem source is a wrong system
configuration.

Statistical means the problem source is statistical data.
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Name Operation Description
Did the Select Do not know means the problem frequency is unknown.
roblem
gccuronce or Temporary means the problem occurred once and was not reproduced.
repeatedly”? Permanent means the problem appeared several times.

The Ticket Device, Library, and Client dialog selects the problematic device, details the location of the
logical library that contains the device, and identifies the associated client.

Figure 29 Ticket Device, Library, and Client
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Name Operation

Select the device where the Select
problem is

Select the logical library Select
where the device is located

Is the problem related to a Select
specific client
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Description

Select the device from the combo box if the problem is
somewhere in the device.

Select the logical library from the combo box if the
problem is with the logical library.

Select the client from the combo box if the problem
related with a client.
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The Ticket Service Code dialog establishes the service code associated with the problem.

Figure 30 Ticket Service Code
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Name Operation Description
Select the Select Do not know means the code is unknown.
Service Code ] o ]
for the Unscheduled Repair means an unexpected repair is required.
problem

44

Scheduled Repair means a pre-arranged time has been allocated for
the repair.

Information Call means information is sent to ATAC.

Customer Resp. means the problem is caused or belongs to the
customer.

Preventive Maint. means routine preventive maintenance is scheduled.

Installation means the ticket is generated to notify ATAC about the
installation of the system.

De-Installation means the ticket is generated to notify ATAC about a
system de-installation.

EC/Field Bill means a service call is the result of an EC/Field build
installation.

Feature Code Change means a new feature or function is added to the
system.
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The Ticket Summary dialog contains selected information from the previous dialogs. The wizard assembles
the data and requires a verification.

Figure 31 Ticket Summary
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Name Operation Description
Summary Supplied Be sure that the data entered from the previous dialogs is correct.

The Create button is disabled while the ticket is in the creation process. During this
period, the data is being integrated into the ATAC Calls pane.

T4 Note

Create Rule

The Scalar DLC software contains rules for monitoring system events either by sending notification via email
or directly to the Management GUI. In addition, system rules are generated by the Scalar DLC software
itself. The user can define rules that will operate in a similar manner. See Table 8 for the detailed description
of the events and matching rules configuration.

In the table that follows, (Any) means selection “Any,” (None) means selection “None”,
(#) means exact selection (for example, Library1, or Client2).

T4 Note

For the details on Error code, if any, refer to Error Codes on page 251.

Table 8 Event Specification
- Error | Physical Logical .
Event Event Group Specific Event code Library Library Client

Start Statistical SDLC supervisor has 0 None None None
supervisor been started
Stop Statistical SDLC supervisor has 0 None None None
supervisor been stopped
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Table 8 Event Specification (Continued)
g Error Physical Logical .

Event Event Group Specific Event code Library Library Client
License Statistical Licenseisto expireina | O None None None
expiration few days
warning
Physical Statistical New physical libraryis | O None None None
library is created
created
Physical Statistical Physical library has 0 None None None
library is been deleted
deleted
Physical Statistical The library state has 0 Any None Any
library state changed
changed #
Logical Statistical The library state has 0 None # None
library state changed
changed
Library Tape | Statistical Message about Drive 0 Any None Any
Alert Tape Alert Flag 4
Drive Tape Statistical Message about Drive 0 # None Any
Alert Tape Alert Flag
Front door Statistical Library door closed. 0 # None Any
closed Context defined below.
Inventory Statistical Library elements have | O None # None
(GUI) been inventoried
Inventory Statistical Library elements have | O # None Any
(auto) been inventoried
Inventory Statistical Library elements have | 0 # # Any
(common) been inventoried
Move Statistical A cartridge has been 0 None # #
cartridge successfully moved
(common)
Move Statistical A cartridge has been 0 None # Any
cartridge successfully moved
(client) #
Move Statistical A cartridge has been 0 None # Any
cartridge successfully moved
(GUI)
Physical Statistical Library elements 0 # # Any
elementstate changed its state
changed
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Table 8 Event Specification (Continued)
g Error Physical Logical .

Event Event Group Specific Event code Library Library Client
Logical Statistical Library elements 0 None # None
element state changed its state
changed
New Statistical New firmware has 0 # None Any
firmware been loaded to
loaded physical library
New Statistical New firmware has 0 None # Any
firmware been loaded to
loaded physical library
Drive Statistical Message from Clean 0 None # #
cleaning Manager about drive

cleaning
Clean pool Statistical A clean’s pool 0 None # None
requires condition has become
service critical
Element(s) Statistical Logical library element | O None # #
allocated by has changed its
client allocation state
Cluster node | Statistical Cluster node has been | 0 None None Any
changed changed
Hardware Hardware An erroneous situation | 217 Any Any Any
error: has been encountered
generic, and #
so forth
Hardware Hardware An erroneous situation | 216 Any Any Any
error: has been encountered
accessor #
cannot pick a
cartridge
Hardware Hardware An erroneous situation | 215 Any Any Any
error: has been encountered
accessor #
cannot put a
cartridge
Hardware Hardware An erroneous situation | 223 Any Any Any
error: has been encountered
destination #
full
Hardware Hardware An erroneous situation | 222 Any Any Any
error: source has been encountered
empty #
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Table 8 Event Specification (Continued)
oe Error Physical Logical .
Event Event Group Specific Event code Library Library Client
Hardware Hardware An erroneous situation | 360 Any Any Any
error: has been encountered
accessor #
cannot move
Hardware Hardware An erroneous situation | 220 Any Any Any
error: has been encountered
common #
General General An erroneous situation | 217 Any Any Any
failure: has been encountered
common # #
Not ready: General An erroneous situation | 205 Any Any Any
common has been encountered "
Not ready: General An erroneous situation | 248 Any Any Any
device is has been encountered
becoming #
ready
lllegal General An erroneous situation | 223 Any Any Any
request: has been encountered
destination # #
full
lllegal General An erroneous situation | 222 Any Any Any
request: has been encountered
source empty # #
lllegal General An erroneous situation | 358 Any Any Any
request: has been encountered
destination is # #
accessor
lllegal General An erroneous situation | 363 Any Any Any
request: has been encountered
invalid CDB # #
field
lllegal General An erroneous situation | 368 Any Any Any
request: I/E has been encountered
station door # #
open
Abort: General An erroneous situation | 376 Any Any Any
command has been encountered
aborted #
General General An erroneous situation | 247 Any Any Any
failure has been encountered "

(Scalar 1000)
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Table 8 Event Specification (Continued)
g Error Physical Logical .
Event Event Group Specific Event code Library Library Client

General General An erroneous situation | 212 Any Any Any
failure has been encountered
(Scalar 1000) # #
General General An erroneous situation | 354 Any Any Any
failure has been encountered
(Scalar 1000) # #
General General An erroneous situation | 221 Any Any Any
failure has been encountered
(Scalar 1000) # #
General General An erroneous situation | 355 Any Any Any
failure has been encountered
(Scalar 1000) # #
General General An erroneous situation | 226 Any Any Any
failure has been encountered
(Scalar 1000) # #
Internal error | Internal An erroneous situation | 0 Any Any Any

has been encountered
License Configuration | License has been 0 None None #
expired expired
Configuration | Configuration | Configuration changed | 0 None None #
changed
Manually Ticket Open ticket (manually) | O None None Any
created ticket
Automatic Ticket Open ticket (auto) 0 None None Any
created ticket
Ticket in Ticket Continue ticket 0 None None Any
work
Close ticket Ticket Close ticket 0 None None Any

4 Note

An incorrect rule cannot be created. Only the selections matching the selected event
group, event, and so forth, are enabled in the Rule wizard.
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Selecting the Create Rule option opens the Rule Name dialog. Specify the rule name here.

Figure 32 Rule Name

£ create new Rule x|
ALLEEEHERLR
-jHEE EERRNY
5 S:EZEEE

Enter the name for the new rule;Rulel

44 l .{ Pre ; | P nlext | | & Cancel
Entry Operation Description
Enter the name for Enter The rule name. ADIC recommends using names describing
the new rule the meaning of the rule.

The Rule Event dialog continues the wizard process. The event group and specific event are specified here.

Figure 33 Rule Event

& Create new Rule |

ll EEEERE Ll‘ Select the appropriate event graup from the list. 'S0y’ implies any event group is acceptable.
JENEEERRRR _ —
S Event group: ‘Statlstmal v|
EEEER Eg
_I =| =5 =
Ifdesired, select a more specific event in the event group.
Motificatian 0fevents:| Zluster node has been changed - |
| 4 First | | 4 Previous | | P hlext | | & Cancel
Entry Operation Description
Event group Select Event group selection. See Table 8 on page 45.
Notification of events  Select Event selection. See Table 8 on page 45
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The Rule Event dialog continues the wizard process The device, library, and client must be specified here.

Figure 34 Rule Event Location
£ create new Rule x|

FEEEEERENREWN : D : :
- . = y To receive notification of events for a specific ahject,
a ‘l E E E‘. EEE‘. select the appropriate information below.
= - 3 Send notification if event is related to the following device:
|
Send notification if event is related to the following library:
2|
Send notification if event is related to the following client:

To be notified abhout a specific error situation for an event, |0

enter the error code here.

| 4 First | | 4 Previous | | P hlext | | & Cancel |
Entry Operation Description
Device Select Device (Physical library) selection. See Table 8 on page 45.
Library Select Logical library selection. See Table 8 on page 45.
Client Select Client selection. See Table 8 on page 45.
Specificerror  Enter An error code listing. Refer to Error Codes on page 251 and Table 8 on
situation page 45.

The Rule Notification Sent dialog continues the wizard process. The way to send notification is specified
here.

Figure 35 Rule Notification Sent Dialog
&Ereate new Rule |
;_I FENEEEERENR Hiw should the notification he delivered?

fl E E E EEE" : o via EMAIL

—— o ————

After this notification is acknowledged, do you want a ticket to be generated?

] Na ¥l ¥es

| 4 First | | 4 Previous | | P hlext | | X Cancel

@ Note Although there exist some predefined rules that send notification via SNMP, the user-
created rules other than predefined cannot deliver SNMP notification because of
interface properties.
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Entry Operation Description
Deliver notification by Select EMAIL sends notification via email.

GUI sends a notification to the Management GUI.

Generate ticket by Check Enable/disable a service ticket generation request
acknowledge (enable only when GUI selected).
Next Click If EMAIL is selected, the Rule Email Destination dialog

appears. See Figure 37 on page 53.

If GUI is selected, the Rule Notification Receiver
dialog appears. See Figure 36.

The Notification Receiver dialog pane identifies the user who receives the notification.

Figure 36 Rule Notification Receiver
&Ereate new Rule |
EEELEEBRERNN
JEEEEERURNY

FEEEERRRN

Choose the userwho should receive the notification.

| 4 First | | 4 Previous | | P nlext | | X Cancel
Entry Operation Description
Notification receiver Select A selection from the user list.
Next Click Go to the next wizard dialog (Summary).
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The Rule Email Destination dialog identifies the user who receives the notification via email.

Figure 37 Rule Email Destination
£ Create new Rule x|

FEEEEENERELR Chaoose an email destination or create a new ane:;

FEEEEEERRN .

FEEEEERRY )
- L Delete ||

v Add

Choose an email template:

| 4 First | | 4 Previous | | P nlest | | & Cancel
Entry Operation Description

Choose/ Select A selection from the current list of email destinations. The default
create entries in the list that cannot be removed are atac (default CE) and the
destination “contact person,” as shown in Figure 40 on page 55.
Delete Click Delete the entry from the list.
Add Click Add an entry to the list. See Figure 38.
Choose Select Choose a selection from the combo box. Only valid template (matched
template the rule) could be selected.
Next Click Go to the next wizard dialog (Summary).

The Rule Email dialog identifies the user who should receive the notification.

Figure 38 Rule Email
£ create new Rule x|
FEEEEEREREELN

P FEEEEELERLLC |

!JJEEFEEE
T | | Frarm: | |
HaostTo: | | HnstFrnm:| |
Port: |25 |

| W Create | | & Cancel
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Entry Operation Description

Name Enter Email sender name.

To Enter Email recipient address.

From Enter Email sender address.

Host To Enter Recipient email server.

Host From Enter Sender email server.

Port Enter Sender email port (the default is shown).

The last Rule wizard dialog displays the Rule Summary.

Figure 39 Rule Summary

£ create new Rule : x|
l'- ELEEEE ‘-"‘ The summary pade below shows informatian
PEREEERRERRY which will be used in the new rule.
FEEEE 3 To change this information, return to previous page. Click 'Create' to accept.
Event code:Cluster node has heen changed
PEC:0
Device:Mone
Library:Hane
ClientAny
ia GLI
Weknowledge with ticket:Mo
LIseradmin
| 4 First | | 4 Previous | | v Create | | & Cancel
Entry Operation Description
Summary Supplied Be sure that the data entered from the previous dialogs is correct.

Extended Service

This section contains the extended service operations.

Operations Name Description
Extended Service | Registration Scalar DLC registration information. Refer to
EES— . Information Registration Information on page 55.
egistration Information
Connectto RMU Connect to RMU RMU connection window. Refer to Connect to RMU on
Wigw Log page 56.
View Log Online log viewer window. Refer to View Log on page
57.
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Registration Information

Selecting the Registration Information opens the Registration Information pane. It shows the customer’s
personal information that was entered during installation of the Scalar DLC software.

Figure 40 Registration Information
i Registration information il
_Customer information:

Company name: | |

Campany address:| |

Contact name: | |

Cantact email: | | [ Email Motification

SMTF serer: | |F'Dr11| |
Contact telephane: | |Fax | |
[¥] Service contract site |0 |

Scalar DLC information:

Serial number:
Location:

Dial in nurnber:
ATAC contact: ) Europe ) Marth America

Reset pdate Clase

Review the registration information and change it if necessary.

Name Operation Description
Company name Enter The company name.
Company address Enter The company mailing address.
Contact name Enter The contact person name.
Contact email Enter The contact email address.
Email Notification Check Check this box to receive notifications via email.
SMTP Server Enter The SMTP server name.
Port Enter The SMTP server port number.
Contact telephone Enter The contact phone number.
Fax Enter The contact fax number.
Service contract Check Marks the service contract feature as “signed.”
Site ID Enter The site ID (for the signed service contract).
SDLC serial number  Supplied The Scalar DLC serial number.
SDLC location Enter The Scalar DLC location.
SDLC dial-in number  Enter The Scalar DLC dial-in number.
ATAC contact Select The Scalar DLC ATAC contact region (North America or
Europe).
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Name Operation Description

Reset Click Clear all the fields and restore the registration information from
the Scalar DLC database

Update Click Update the Scalar DLC database with the registration
information entered in this pane.

Cancel Click Close the pane without saving changes.

_ If the Email Notification field is not checked, the Scalar DLC will never send
41y CAUTION notifications via email.

Connect to RMU

Selecting the Connect to RMU opens the Remote Management Unit (RMU) connection pane (Figure 41). It
allows to connect to the remote management unit.

Figure 41 Connect to RMU
g’%EnIEI hostname of RMU E2

T4 Note The down arrow will open a list of previously connected RMUs.

The factory installed RMU in each system uses a standard Web browser for remote library access. The
supported browsers are:

*  Microsoft Internet Explorer version 4.0 and above
* Netscape Navigator version 4.01 and above.

You can do the following by means of the RMU:

+ Update RMU firmware

* Access the library status

« Make configuration changes

* Access the library Operator Panel

« Update the library controller firmware

* Retrieve library command and error logs

* Use the ADIC website to access Scalar documentation

The RMU supports Simple Network Management Protocol (SNMP) version 2.0 and acts as an SNMP
server. The RMU acquires Tape Alert 3.0 compatibility information from the library over the serial interface
port and sends that information to a SNMP server. The RMU also detects a power loss and generates a
SNMP trap for notification.

56 Management GUI



View Log

Figure 42 View Log: standard mode

Scalar DLC log viewer - Microzoft Internet Explorer mE E
Fil=  Edit “iew Favoriter Toolz Help |-
g =
& .= . AN e BN E RS A
Back Frard Stop  Refresh  Home Search Favortes  History Print Edit

Address I@ Type=LiCld=tiClient=kisClazs=onkfClass=kiz0bject=on&f0bject=4i:D escr=onifD escr=kizslnf=onkis\win=onkisE m=on&izCE r=on j @GD |J Links *

tax records |25

Scalar DLC log file I 200109061 =] Record Filter | 4l messages =l

Submit filter | Advanced mode [T Reverse sort order [T Downlosd  Help HOME / END / HEXT / prev
Time Command Type ID Client Class Object Des
€905.09.2001 11:10:41.186 Unknown nfa Systern Logger Logger Suc
€9 05.09.2001 11:10:41.236 Unknown nfa Systemn Tracer Tracer Sl
€906.09.2001 11:10:45.572 Unknown nfa Systern DeviceMlanager Devicelanager S
€905.09.2001 11:10:48.176 Unknown nfa Systern DevicelMlanager Devicelanager Cre.
€905.09.2001 11:10:50.369 Unknown nfa Systern DeviceMlanager Devicelanager Cre.
€9 05.09.2001 11:10:50.479 Unknown nfa Systern DevicelMlanager Devicelanager Upe
€905.09.2001 11:10:50.612 Unknown nfa Systern DeviceMlanager Devicelanager Lipa
€9 05.09.2001 11:10:50.652 Unknown nfa Systern DevicelMlanager Devicelanager S
€9 06.09.2001 11:10:50.672 Unknown nfa Systermn NSEMailConnection NMSEMailCannection Suc
€9 05.09.2001 11:10:50.790 Unknown nfa Systerm NSSnmpConnection MSSnmpConnection S
€906.09.2001 11:10:51.120 Unknown nfa Systemn MsgTranslatar MNSMessageTranslator Suc
€905.09.2001 11:10:51.310 Unknown nfa Systern DevicelMlanager Devicelanager Sude
€9 05.09.2001 11:11:00.203 Unknown nfa Systern DasClient Contral Path e
€9 05.09.2001 11:11:00.704 Unknown nfa Systermn DasClient Contral Path e
€9 06.09.2001 11:11:00.974 Unknown nfa System ScsiCon DevADICScalar_10005555555555 Suc
€905.09.2001 11:11:01.024 Unknown nfa Systemn Scalarl 0K DevADICScalar 101111111111 Suc
€905.09.2001 11:11:01.074 Unknown nfa Systemn DasRpc DASRpc Das
€9 05.09.2001 11:11:03.948 Unknown nfa System Amls LibADICScalar_10005555555555 SuC -
i | i
] Done I_I_Ei! Local intranet

Selecting the View Log opens the online log viewer window. Refer also to the Log Viewer Utility on page
221.

Name Operation Description

Scalar DLC log file Select The log file to view can be selected (current session by

default).
Record Filter Select The filter of records can be specified.
Max records Enter The maximum number of records to show can be specified.
Advanced mode Check Pressing the Submit filter button shows the View Log

advanced mode window. See Figure 43 on page 58.

Reversed sort order Check Not supported in current version.

Download Click Downloads the current log file.
Help Click Open Log help screen.

Home Click Go to the first record page.
End Click Go to the last record page.
Next Click Go to the next record page.
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Name Operation Description
Prev Click Go to the previous record page.
Submit filter Click Refresh the current screen to apply changes.
Record messages Double-click  Open the log message detail window. See Figure 44 on page

59.

Double-clicking on the record message opens the log message detail window. See Figure 44 on page 59.

Figure 43 View Log: advanced mode
Scalar DLC log viewer - Microsoft Internet Explorer

File  Edit “iew

HE E

Favortes Tools  Help

G < R A T - B B B R
Back Fammard Stop  Refresh  Home Search Fawortez  Histow Frint Edit

| 6o || Links >

-

Address IE http: £ fcomputer: 30304 zerdet dogriewen?logfile=2001 0306-1 &viewpaint=A E mimzgno=25%advanced=on

Scalar DLC log file I 2001090E-1 'I Record Filter IA” messages H Max records IF

* Time: ¥ Command type: ¥ Command id: W Client:

froml tol I I I

¥ Class: | ¥ Object: | v Descriptinn:l [T Data

I & information messages I (1) warnings & erors M @ critical erors
Submnit filter | Advanced mode W Reverse sort order T Download  Help HOME / END / NEXT / prev

Time Command Type ID Client Class Object Des
€P06.09.2001 11:10:41.186 Unkrown nfa Systermn Logger Logger Suc
€P06.09.2001 11:10:41 236 Unknown nfa Systemn Tracer Tracer Suc
€P06.09.2001 11:10:45 572 Unkrown nfa Systermn DeviceManager DeviceManager S,
€P06.09.2001 11:10:48 176 Unkrnown nfa Systermn DeviceManager DeviceManager Crer
€P06.09.2001 11:10:50.362 Unkrown nfa Systermn DeviceManager DeviceManager Cre.
€P06.09.2001 11:10:50.479 Unkrnown nfa Systermn DeviceManager DeviceManager Lpa
€P06.09.2001 11:10:50.619 Unkrnown nfa Systermn DeviceManager DeviceManager Upa
€P06.09.2001 11:10:50 652 Unkrnown nfa Systermn DeviceManager DeviceManager Sue
€P06.09.2001 11:10:50. 679 Unkrown nfa Systern NSEMailConnection NSEMailConnection Sue
€9 06.09.2001 11:10:50.790 Unkrnown nfa System NSSnmpConnection NSSnmpConnection Sue
€P06.09.2001 11:10:51.120 Unkrown nfa System MsgTranslator NSMessageTranslator Sue
€P06.09.2001 11:10:51.310 Unkrnown nfa Systermn DeviceManager DeviceManager Sude
[ | b |
j Dane I_I_Eﬂ Local intraret
Name Operation Description
Time Check/Enter  Specify the time range of the record to show using the From and To
fields. Empty fields specify all records.

Command Check/Enter  Specify the command type of the record to show.

Type

Command Id Check/Enter  Specify the command ID of the record to show.

Client Check/Enter  Specify the client of the record to show.

Class Check/Enter  Specify the class of the record to show.

Object Click/Enter Specify the object of the record to show.
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Name Operation Description
Description Check/Enter  Specify the description of the record to show.
Data Check Specify the record data to show.

Information Check Show information messages.
Warnings Check Show warning messages.
Errors Check Show error messages.
Critical errors  Check Show critical error messages.

Double-click on the record message to open the log message details window.

Figure 44 Log Message Details

; Scalar DLC log message detail - Microsoft Internet Explorer

J Fil=  Edit “iew Favoriter Toolz Help

=5 | Q G 3 =
Blask Fammard Stop  Refresh  Home Search Fawortez  Histow Frint Edit
| Addiess [#7 hitp: ¢ rcomputer 8080/ servist Aogdstsivloghle—2001 D306-1 foffsst-512 ~| PG |J Links >
. =
Log 20010906-1
Date 05.09.2001
Time 11:10:48.176
Severity ) infarmation
Command ID nia
Command Type Unknown
Client Systemn
Class DeviceManager
Object Devicelanager
Description
Create new device node, type O, vendor 1D |, product ID |, firmware revision level <=, serial number <1111111111 =,
adapter number 0xFFFFFFFF, path ID 0xFFFFFFFF, target ID 0xFFFFFFFF, LUN OxFFFFFFFF
Data
[~
|@ Dane I_I_E‘ﬂ Local intranet S
Name Description
Log Log file the record message is taken from.
Date The record date.
Time The record time.
Severity The record severity.
Command Id The record command id.

Command type

The record command type.
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Name Description

Client The record client.

Class The record class.

Object The record object.
Description The record description
Data The record additional data.

Help

This section contains the information that can be helpful for the customer.

Options Name Description

m Help Content Contains browser-based HTML help files that cover
installation, operation, and service. This information
appears in a separate window. The contents, index,
search engine, and bookmarks are accessed from this
window.

Help Contents
License Agreement
About Scalar DLC

License Agreement A copy of the Scalar DLC software license agreement
can be viewed from this pane.

About The Scalar DLC software and component code
versions can be viewed from this pane. All Scalar DLC
hot fixes and service packs (if any) are enlisted here,
too. See Figure 45.

Figure 45 Scalar DLC Software Version Code
4 Ahout Scalar DLC x|

Scalar DLC 2.6

Distributed Library Cantroller

Copyright (c) 2003 ADIC

Warsion information:

Euild 2.6.0003
Kernel w.2./.0003
Jevveldni w263
Ohject Server v.2. 63
GLI w263
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GUI Tabs

This topic describes the main area of the Scalar DLC Management GUI screen, the GUI Tabs. All extended

configuration and management is executed from this area.

The detailed structure is described in Tabs Structure on page 68.

Figure 46 GUI Tabs: Working Areas
GUI Tahs: primary level

Object tree

Expandfé____.p £5 En

collapse
button

While using the GUI Tabs, clicking the expand/collapse button on the left of the branch in the Select

GUI Tabs: Secondary level

Property icons

rLihraw r Cunﬂgyall/nn |/ Events |/ Servi

(Logical rPhﬁsical rUsers |/ Clien}{ rSCSITarget |

Select component

o] computar =
@ [ Library? {online)

& i Cartridges
@ 2 DR_Sony 50

‘2 IE_Genetic &
@ A 5T _Generic 8
& & Poolt

a1 P2_IE1E
caP2_IE1TY
a1 P2 _IE18
c31P2_IE19 =
o1 P2_IEZ0
a1 P2 _IEZ21
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o1 P2 _IEZ23
c1 P 1ETA

| L]

[4]

Properties panei(s)

Prnpepfeﬁ/

f Walue |

#Mame
& 1
@ Mumber of NE slots

EO1

12

RS

IESInts

Mame

Element type

c3PZ_IE1G
c3PZ_IE1T
c31PZ_IE1S
c3PZ_IE19
3 PZ_IEZ0
3 P2_IE21
31 P2_IEZ2
3 PZ_IEZ3
3 PZ_IEZ4

[ T o N | ol T

Generic 8mm IVE
Generic 8mm IVE
Generic 8mm IVE
Generic 8mm IVE
Generic 8mm IVE
Generic 8mm IVE
Generic 8mm IVE
Generic 8mm IVE

Generic 8mm IVE
amorie Deeen WD

Pattition |
|E_Generic 8mm__ 2

|E_Generic 8mm__ 2
|E_Generic 8mm__
|[E_Generic 8mim
|[E_Generic 8mim
|[E_Generic 8mim
|[E_Generic 8mim
|[E_Generic 8mim

|[E_Generic 8mim

1]
ead

Object icons (objects)

Object properties

Operational buttons

Components area of the pane expands or collapses that branch of the tree. Selecting the actual branch
displays the associated properties.

4 Note

Expanding the tree does not select branches from the tree.

The top of the tree always indicates the Scalar DLC controller. As each branch of the tree is expanded and
selected, the properties for that branch of the tree appear. An explanation of the tree objects is described
in Table 9 on page 62.

£ Note

Some elements are present on all the panes of the Scalar DLC Management GUI, while

other are not.
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Table 9 Tree Objects

Object

Icon

Color

Description

Controller

« Black

The name (Hostname) of the Scalar DLC server controller.
All the example screens of this manual use either computer,
or sdlccluster (failover solution).

Logical
library

(o

* Green

+ Dark
yellow

The name of the logical library object that represents the
actual library to the client.

The color of the library indicates the state of the library.

The state of the library also is indicated in parenthesis next to
the name of the library. Table 10 on page 63 explains the
definition of the states.

Physical
library

* Green

* Dark
yellow

* Red

The name of the physical tape library device.

The color of the library indicates the state of the library.

The state of the library also is indicated in parenthesis next to
the name of the library. Table 11 on page 64 explains the
definition of the states.

Robot

* Black
+ Gray

The robotic accessor inside the physical device. Most devices
contain only one robot (single aisle libraries), however some
devices contain two robots (dual aisle libraries).

The color of the robot indicates the state of the robot. See
Table 12 on page 64.

Partition

Cll

» Black
+ Gray

A segment of Physical library. It contains the continuous range
of slots of single type and single media domain.

Also the storage partition always contains either linear shelve
slots or tower slots, but not both of them even when they have
the same media domain and type.

The created partition should be assigned to a Logical library.
The Logical library should contain at least one storage
partition, one mailbox partition, and one drive partition of the
same media domain for the complete configuration.

In dual aisle libraries, the partition also must be in the range of
one robot only. If the robot is offline, its partitions are offline,
too.

The color of the partition indicates the state of the partition.
See Table 13 on page 65.

Scratch pool

* Black

The name of the scratch cartridge pool. Contains the data
cartridges available for writing.

The pool content may be either the continuous range or a
discrete set.

Only the cartridges of a single media type can be assigned to
the pool.

Clean pool

« Black

The name of the clean cartridge pool. Contains the cleaning
cartridges.

The pool content may be either the continuous range or a
discrete set.

Only the cartridges of a single media type can be assigned to
the pool.

Cartridges

* Black

This list indicates cartridges currently contained in the library.
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Table 9 Tree Objects (Continued)

Object Icon Color Description

Offline =2 |+ Black This list indicates cartridges that were removed from the

cartridges -+ physical library and their image is remained for archive
purposes.

Data « Dark green | For a dark green cartridge text, the list indicates the data

cartridge cartridges. See Table 19 on page 78 for the details.

Cleaning + Dark For a dark yellow cartridge text, the list indicates the cleaning

cartridge yellow cartridges. See Table 19 on page 78 for the details.

Storage slots g + Black This list indicates the storage area in the physical library.

Storage slot = | Blue For a blue storage slot name, a cartridge is present in the slot.

+ Gray See Table 14 on page 65.
S Black For a black storage slot name, the slot is empty. See Table 14
« Gray on page 65.

Mailbox Enq » Black The name of the insert/eject area of the logical library.
Contains a set of insert/eject slots that are also called
mailboxes or mailbox slots.

The mailbox content may be either a continuous slot range or
a discrete set.

Mailboxes Ea » Black This list indicates the whole mailbox (insert/eject) area in the
physical library.

Mailbox slot e | ° Blue For a blue mailbox slot name, a cartridge is present in the slot.

+ Gray See Table 15 on page 66.
— Black For a black mailbox slot name, the slot is empty. See Table 15
« Gray on page 66.

Drives E * Black This area contains the drive slots for executing the read/write
operations

Drive slot = * Blue For a blue drive slot name, a cartridge is present in the slot.

« Gray See Table 16 on page 67.
= + Black For a black drive slot name, the slot is empty. See Table 16 on
+ Gray page 67.

The following tables describe the states and properties of the objects mentioned above.

Table 10  Logical Library States

State Icon Color Description
Online o Green The library is online and accepts all commands
Online, alarm @ gﬂ Green The library is online and accepts all commands.
An error has been encountered.
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Table 10 Logical Library States
State Icon Color Description

Diagnostic (Service) I:Ea Dark yellow Either the library diagnostic or the firmware update is
being executed.

Disabled I:Ea Dark yellow The library is logically switched off (Home operation
executed).

Invalid DE Red The library configuration is invalid (one or more
required partition(s) missing).

Not ready Dﬂ Red The library is not available (either the connection is
lost or the admin has manually changed the library
state).

a. Alarm flag indicates that an error has occurred but it does not specify the error. To find out what has happened, use the
Log Viewer, as described in Log Viewer Utility on page 221.

Table 11 Physical Library States
State Icon Color Description

Online o Green The library is online and accepts all commands

Online, alarm @ gﬂ Green The library is online and accepts all commands.
An error has been encountered.

Diagnostic I:Ea Dark yellow The library diagnostic is being executed.

Service I:E_a Dark yellow The library is in service mode (firmware update
process is being executed).

Not ready Dﬂ Red The library is not ready (service needed).

Offline Dﬂ Red The library is offline (connection lost).

a. Alarm flag indicates that an error has occurred but it does not specify the error. To find out what has happened, use the

Log Viewer, as described in Lo

Viewer Utility on page 221.

Table 12  Robot States
State Icon Color Description
Normal (Online) Black The robot is online and functioning. All elements and
- .
slots of the robot are accessible.
Offline = Gray The robot is offline. All elements and slots of the robot
are temporary not accessible.
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Table 13  Partition Class and State
Class and State Icon Color Description

Storage, online |:|‘ Black Contains the continuous range of storage slots that
are either the linear storages or the tower storages.
The robot is online.

Storage, offline :I_l_l-l Gray Contains the continuous range of storage slots that
are either the linear storages or the tower storages.
The robot is offline.

Import/Export, online L1 Black Contains the continuous range of mailbox slots.The
robot is online.

Import/Export, offline L1 Gray Contains the continuous range of mailbox slots.The
robot is offline.

Drive, online E‘ Black Contains the continuous range of drives. The robot is
online.

Drive, offline El_l_-l Gray Contains the continuous range of drives. The robot is
offline.

Table 14  Storage Slots
State Icon Color Description

Occupied, online = Blue The slot contains a cartridge. The robot is online.

Occupied, offline = Gray The slot contains a cartridge. The robot is offline.

Occupied, online, @ Blue The slot contains a cartridge. The robot is online.

alarm @ An error is encountered (for example, the robot did not
get a cartridge).

Occupied, offline, @ Gray The slot contains a cartridge. The robot is offline.

alarm An error is encountered (for example, the robot did not
get a cartridge).

Empty, online — Black The slot is empty and free. The robot is online.

Empty, offline —= Gray The slot is empty and free. The robot is offline.

Empty, online, alarm @ Black The slot is empty and free. The robot is online.
An error is encountered (for example, the robot did not
put a cartridge).

Empty, offline, alarm @ Gray The slot is empty and free. The robot is offline.
An error is encountered (for example, the robot did not
put a cartridge).

Home position, online £ Black The slot is empty but it remains a home position of a

cartridge that is currently in a drive or mailbox slot. The
robot is online.
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Table 14  Storage Slots (Continued)

State Icon Color Description
Home position, offline ~ Gray The slot is empty but it remains a home position of a
cartridge that is currently in a drive or mailbox slot. The
robot is offline.
Not available = Gray The slot is currently unavailable (for example, tower

door is opened).

a. Alarm flag indicates that an error has occurred but it does not specify the error. To find out what has happened, use the
Log Viewer, as described in Log Viewer Utility on page 221.

Table 15 Mailbox Slots

State Icon Color Description

Occupied, online e Blue The slot contains a cartridge. The robot is online.

Occupied, offline o Gray The slot contains a cartridge. The robot is offline.

Occupied, online, . Blue The slot contains a cartridge. The robot is online.

alarm @ An error is encountered (for example, the robot did not
get a cartridge).

Occupied, offline, . Gray The slot contains a cartridge. The robot is offline.

alarm An error is encountered (for example, the robot did not
get a cartridge).

Empty, online S Black The slot is empty and free. The robot is online.

Empty, offline - Gray The slot is empty and free. The robot is offline.

Empty, online, alarm @'__l Black The slot is empty and free. The robot is online. An
error is encountered (for example, the robot did not put
a cartridge).

Empty, offline, alarm . Gray The slot is empty and free. The robot is offline. An
error is encountered (for example, the robot did not put
a cartridge).

Home position, online £ Black The slot is empty but it remains a home position of a
cartridge that is currently in a drive slot. The robot is
online.

Home position, offline £a Gray The slot is empty but it remains a home position of a
cartridge that is currently in a drive slot. The robot is
offline.

Not compatible - Gray The slot is not compatible with the library.

Missing c Gray The slot is physically missing.

a. Alarm flag indicates that an error has occurred but it does not specify the error. To find out what has happened, use the
Log Viewer, as described in Log Viewer Utility on page 221.
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Table 16 Drive Slots

State Icon Color Description
Occupied, online = Blue The slot contains a cartridge. The robot is online
Occupied, offline - Gray The slot contains a cartridge. The robot is offline
Occupied, online, ﬂj Blue The slot contains a cartridge. The robot is online.
alarm @ An error is encountered (for example, the robot did not
dismount a cartridge).
Occupied, offline, 'E.j Gray The slot contains a cartridge. The robot is offline.
alarm An error is encountered (for example, the robot did not
dismount a cartridge).
Empty, online = Black The slot is empty and free. The robot is online.
Empty, offline = Gray The slot is empty and free. The robot is offline.
Empty, online, alarm % Black The slot is empty and free. The robot is online.
An error is encountered (for example, the robot did not
load a cartridge).
Empty, offline, alarm % Gray The slot is empty and free. The robot is offline.
An error is encountered (for example, the robot did not
load a cartridge).
Not available = Gray The slot is unavailable.
Not installed Gray The slot is not installed.

a. Alarm flag indicates that an error has occurred but it does not specify the error. To find out what has happened, use the
Log Viewer, as described in Log Viewer Utility on page 221.

The panes of element properties contain the property icons (Table 17).

Table 17 Element Properties: Icons

Property Icon Operation Description
Read-only = Supplied The property or field is read-only and cannot be edited.
Editable o Enter The property can be edited, checked, or selected. The icon is
typically used for text fields, check boxes, and combo boxes.
Select
Check
Disabled W Supplied The property cannot be edited until another field is selected or
checked. Then becomes editable.
Forbidden Supplied The user is not authorized to change the property.
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Some Management GUI panes and pop-up windows also contain the typical operational buttons listed in
Table 18 (either all these buttons or several buttons or only one of them).

Table 18  Operational Buttons
Button Icon Operation Description
OK/Create Click » Create object (creation panes).

» Execute operation.

Cancel/Terminate

Click » Cancel operation.
» Close pop-up pane without creating an object.
» Close pop-up pane without executing an operation.

Save/Update

Click » Save the element properties after edit.

Help

Click » Open online help for the current pane.

ead | %y b RN

Tabs Structure

The internal structure of the Scalar DLC Management GUI tabs is summarized in the following list.

« Library Tab. Main operating area. Refer to Library Tab on page 71.

+ Configuration Tab. Managing and reviewing the library, SCSI Target, client, and user configuration.
Refer to Configuration Tab on page 87.

Logical Tab. Managing library logical configuration, cartridges, pools, mailbox areas, drives.
Refer to Logical Tab on page 88.

Physical Tab. Managing the physical library and the library partitions. Refer to Physical Tab on
page 112.

Users Tab. Managing user parameters. Refer to Users Tab on page 128.
Clients Tab. Managing clients. Refer to Clients Tab on page 134.
SCSI Target Tab. Managing SCSI Targets and LUNs. Refer to SCSI Target Tab on page 162.

* Events Tab. Managing the command queue and the created rules, monitoring the system events
and acknowledging the notifications. Refer to Events Tab on page 173.

Queue Tab. Managing command queue. Refer to Queue Tab on page 174.

Monitoring Tab. Monitoring the current login session events. Refer to Monitoring Tab on page
176.

Acknowledge Tab. Acknowledging the notifications. Refer to Acknowledge Tab on page 178.

History Tab. Monitoring the events during all sessions. Refer to History Tab on page 179.
Rules Tab. Managing the rules. Refer to Rules Tab on page 179.

» Service Tab. Executing library diagnostics, view hardware logs, managing service request (tickets),
command panel, and cluster. Refer to Service Tab on page 183.
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Logs Tab. Monitoring the library command log and error log. Refer to Logs Tab on page 183.
Diagnostic Tab. Executing the library diagnostics. Refer to Diagnostic Tab on page 187.

ATAC Calls Tab. Managing the service requests (tickets). Refer to ATAC Calls Tab on page
189.
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*  Operator Panel Tab. Executing operator panel commands from a remote console. Refer to
Operator Panel Tab on page 195.

» Cluster Tab. Viewing and changing the cluster settings. Refer to Cluster Tab on page 198.
*  SNMP Tab. Managing the SNMP settings. Refer to SNMP Tab on page 199.

The details for each tab are described in the appropriate sections.

GUI Log

The GUI Log is located at the bottom portion of the screen. It shows the list of messages that reflects the
operations executed in the Management GUI during the current session. Use the scroll bar if the list is large
or the message is long.

@ Note The GUI Log does not reflect the operations executed from a client side.

Figure 47 GUI Log
E 1341 mount carridge 000002 finished

13:41 eject cartridge Q00027 finished
1342 eject cartridge 000054 finished

|1|§:

Icon Description

[ ] Indicates that the current message contains an information message.
5 Indicates that the current message contains a warning message.

) Indicates that the current message contains an error message.
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Library Tab

The Library Tab is the main operational area. All media move commands and most logical library monitoring
is executed from this tab.

@ Note The Library Tab is accessible for all users. Some move commands require addinional
rights.

As the Library Tab is opened, in the Select Components area of the pane the Controller appears.
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Figure 48 Library Controller
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Icon Operation

Supplied
Supplied
Supplied
Supplied
Supplied
Supplied
Supplied

Click

ol BB BB B B B

Description

The CPU identifier.

The CPU vendor identifier.

The CPU speed.

The total physical memory size.
The free physical memory size.
The total virtual memory size.

The free virtual memory size.

Open online help for the current pane.
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Library

The Library Properties pane (right) contains two tab panes: Properties, with the library properties (refer to
Library Properties on page 73), and the Diagnostics, with the diagnostic information for the selected library
(refer to Library Diagnostics on page 74).

Library Properties

Figure 49 Library Properties
4. Scalar DLC _l_l- m| ﬂ
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Clientl
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12:31 admin connected to computer |~
12:31 Please wait Scanning . 3
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Field/Button Icon Operation Description

Name = Supplied Logical library name.

ID = Supplied Logical library identification number.

Number of cartridges & Supplied Number of available cartridges.

Number of drives & Supplied Number of available drives.

Number of slots & Supplied Number of available storage slots.

Number of I/E slots & Supplied Number of available mailbox slots.

State & Supplied Logical library state. See Table 10 on page 63.

Clients Supplied The clients attached to the logical library.
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Field/Button Icon Operation Description

Inventory @ Click Initialize all the library elements and assign home
positions if necessary. See Figure 3 on page 5.
Help =2 Click Open online help for the current pane.
+

a. The physical library is covered with a set of partitions. These partitions are assigned to some logical libraries. A single
partition can be assigned to two or more logical libraries. It is in the concepts of the Scalar DLC. Such apparitions are
called “shared”, and the inventory operation affects all partitions assigned to the logical library.

@ Note If a new library has been created, an inventory must be executed to avoid problems with
the cartridge home positions.

Library Diagnostics

Figure 50 Library Diagnostics
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Connection  Wizards Exiended Service  Help

fLihraw r Configuratian |/ Ewvents |/ Semice |

Select component Frocedure | Inprogress | Passages | Errors [

@ computer B Status verification Inventory 14 1}
@ [o Likrary1 {onling
& i Cartridues
o i Poalt
@ £3 EN
@ £3 101
@ = Drives
@- [ LikraryZ2 {onling
@- [ Likrary3 {onling

|08 | [J |30 | 05

[

[T» [ Properties l Diagnostics

12:31 admin cannected to computer —
12:31 Please wait. Scanning ...

12:31 Scanning finished successfully
12:31 Mo new library found

470 Lo iio Lo 1 4 bt fowe Liln il A

eod

1

The Diagnostics pane is designed for testing purposes.

Field/Button Icon Operation Description
Procedure Supplied The global test procedure.
In progress Supplied The test step currently in progress.
Passages Supplied Number of passages.
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Field/Button Icon Operation Description

Errors Supplied Number of errors, if any.

Random E Click Launch Random move test. Refer to Random Move Test on

move test page 75.

Mount test % Click Launch Random mount test. Refer to Random Mount Test on
H page 76.

Element B- Click Launch Inventory test.

status This test initializes element status command for the logical

verification library and verifies whether the starting picture of the library

test corresponds the picture received (total number of elements,

empty elements, occupied slots, etc.). Any single operation is
inventory command.

Element % Click Launch Move Gripper test.

position test This test initializes move gripper command, it randomly moves
the robot gripper to any slot assigned to the logical library and
checks the element position. No media is moved within this

test.

Terminate x Click Stop current test. The temporary warning pane appears, see
Figure 51.

Help ] Click Open online help for the current pane.

#

_ Running Library diagnostic tests must not be executed when any of the clients
A1\ CAUTION  yse the library because this testing will interfere the client work.

_ All Library diagnostic tests are cyclic, when started, they are executed
/1% CAUTION endlessly until the Admin stops diagnostics by the Cancel button (see Figure
51).

Figure 51  Stop Current Test

g Warning

Flease, wait ...

Random Move Test

Figure 52 Random Move: Select Media Type
i List of Media types x|
Select Media tvpe Sto=St
DLT
DLT NixT
DLT I |E-=IE
SOLT
SOLTI

St-=1E

Cancel
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This test moves the cartridges of the selected media type either from Storage to Storage, or from Storage
to I/E (and vice versa), or from I/E to I/E. Any single operation is move command (refer to Move Cartridge
to Element on page 80), the cartridge and target slot are selected at random by media type.

Random Mount Test

Figure 53 Random Mount: Select Media Type
4. List of Media types ﬂ
Select Media tvpe Start
DLT N
DLT T
OLT IV
SOLT
SOLTH

Cancel

This test mounts the cartridges of the selected media type and dismounts them from drives. Any single
operation is mount or dismount command, the cartridge and target drive are selected at random by media

type.

Cartridges

In the Select Components area of the pane, selectable Cartridges are displayed. Clicking the expand/
collapse button causes an element expansion.

Figure 54 Cartridges
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Field/Button Icon Operation Description

Volser Select The volume serial number, a cartridge name. Each cartridge
has one volser.
The optical disks are represented with two cartridges because
each optical disk has two volsers.

Media Type Select Cartridge media type. Refer to Media Types on page 246.
State Select A cartridge state, empty means stored. Refer to Cartridge
State on page 78.
Import c.1 Click Transfer the cartridge from a mailbox slot to a storage area.
bE The target slot is a cartridge home position.
The button is enabled for a cartridge stored in a mailbox.
Export iz Click Transfer the cartridge to a mailbox. If more than one mailbox
LA exists, an additional export selection appears. See Figure 55.

Select an appropriate mailbox from the combo box.

This operation saves the cartridge home position.

The button is enabled for a cartridge not in a mailbox, when a
mailbox exist.

Mount t  Click Insert a cartridge into the first available tape drive of the
=F appropriate media type (Generic Mount).
The button is enabled for a stored cartridge.
Dismount % Click Move a cartridge from a tape drive to the cartridge home
H position.

This button is enabled for a mounted cartridge.

Move 2 Click Open a pop-up Move window. Refer to Move Cartridge to
Element on page 80.
The move operation transfers a cartridge from its current
position to a selected destination slot.

Help =2 Click Open online help for the current pane.

+
By default, the cartridges are sorted by media type, in ascending order. Click on the appropriate column title
to change the sorting order.

To select cartridge for the operation, click on it. <ctr1>+Click allows multiple cartridge selection, for the
multiple Export/Import operations. Multiple Mount/Dismount/Move operations are not allowed in the
Scalar DLC Management GUI.

Figure 55 Multiple Mailbox Selection

& select MailBox E X
] Select MailBaox for exportto
~ e |
| 0]78 || Cancel ‘

After a cartridge has been moved to the mailbox slot through the Export command and become ejected, it
cannot be manipulated again until Inventory has been completed. After an inventory is completed, the
cartridges are recognized as stored.
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The Management GUI also allows drag and drop cartridge operations. Refer to Drag and Drop Operations
on page 81.

Cartridge State

The cartridges contained in the library have a different state. The state indicates a cartridge availability to
accept commands, and so forth.

Table 19  Cartridge States

Cartridge Command e
Icon Description
state status

Stored Active The cartridge is stored in mailbox or in storage slot. A cartridge

(shown as in a storage slot is active for Move, Mount and Export

empty) operations, a cartridge in a mailbox slot is active for Move,

Mount and Import operations.

Mounted Active The cartridge is moved to the drive slot and is ready for the
read/write operations. The cartridge is active for Move, Export
and Dismount operations.

Reverse Not active ~a The optical disk is moved to the drive, and its other side is

mounted ready for the read/write operations. The cartridge is not active
until the Dismount is done.

g

Ejected Not active + The cartridge is exported into a mailbox slot, and a home
position has been saved. The cartridge is not active for any
operations until the Inventory is finished.

al

Unloaded Not active . The cartridge is exported into a mailbox slot, and a home
position is lost. The cartridge is not active for any operations
until the Inventory is finished.

al

In problem Not active [ The cartridge is moved to a problem box. The cartridge is not

box active for any operation and remains not active after the
Inventory. Operator can only physically remove this cartridge

| from the library (a home position will be lost then).

Offline Not active 1 The cartridge is removed from the library. The cartridge was
not found after the Inventory has been executed.

Fi

Being Not active The cartridge is moving into a mailbox slot. No commands are

ejected accepted. Temporary state.

Being Not active The cartridge is moving from the mailbox slot. No commands

inserted are accepted. Temporary state.
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Table 19  Cartridge States (Continued)

Cartridge Command

state status Icon Description
Being Not active The cartridge is moving to a drive slot. No commands are
mounted accepted. Temporary state.
Being Not active The optical disk is moving to a drive slot. After the operation is
reverse executed, the cartridge will be reverse mounted. No
mounted commands are accepted. Temporary state.

E & @

The cartridge is moving to another slot (low-level command is
being executed). No commands are accepted. Temporary

Being moved | Not active

state.
Being Not active The cartridge is moving from the drive slot. No commands are
dismounted accepted. Temporary state.
Being Not active The optical disk is moving from a drive slot. The cartridge was
reverse reverse mounted. No commands are accepted. Temporary
dismounted state.

The optical disk in drive slot is being flipped. If the cartridge
state was mounted, after the operation is executed it will be
reverse mounted, and vice versa. No commands are

Being flipped | Not active

E & @

accepted. Temporary state.
Being in Not active The cartridge is moving to a problem box. No commands are
problem box accepted. Temporary state.

If the cartridge is not found in the library after the Inventory has been executed, its state changes to offline.
After that, the cartridge is removed from the Cartridge list of Logical library (both Library tab and
Configuration > Logical tab, Cartridges) and goes to archive list, or the list of the offline cartridges. It is
shown under the Physical tab of the Configuration area and contains the information about cartridges that
were removed from the physical library. Refer to Offline Cartridge on page 121.

Home Position

The cartridge home position concept is a basis of cartridge move operations in the Scalar DLC Management
software. Every cartridge impoting in the library immediately gets a home position in the first free storage
slot of appropriate type (for example, Generic DLT slot for DLT IV or SDLT cartridges; refer to Storage Types
on page 247 for the details). Each cartridge has one and only home position. The slot can be a home
position for one and only one cartridge (the only exception is optical disk — the two sides of an optical disk
are represented with two volsers and one home position is assigned to both sides).
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_ Always import cartridges when they are first appeared in the mailbox area.
41y CAUTION  oOtherwise there could be issues with a cartridge home position being the
mailbox slot.

After the home position is assigned to the cartridge, it becomes available for move operations. The Import
operation inserts the cartridge from a mailbox to the home position; the Dismount operation moves the
cartridge from a drive to the home position. If the Mount operation has been executed and the cartridge is
moved to a drive, the home position is saved and cannot be occupied by another cartridge. If the Export
operation has been executed, the cartridge is ejected from the library and becomes unavailable. However,
it saves the home position and if the Inventory operation finds the ejected cartridge, it becomes available
again. Refer to Table 19 on page 78.

The cartridge relinquishes the home position only after the eject complete operation is executed from a
client side. The cartridge state is unloaded then. Refer to Table 19 on page 78.

The home position cannot be changed after it is assigned. Every operation returning the cartridge to a library
storage area puts it into the home position. The only exception is the Move operation (it can be executed
from a client side as well); if the move destination is a storage slot, it will become a new home position of a
cartridge. The old home position is lost in that event.

_ The DAS and ROBAR clients mostly use the analog of Mount, Dismount,
41 CAUTION  import, and Export commands, although they can execute Move command,
too. The SCSI clients use Move command only and therefore do not have the
home position-related features.

Move Cartridge to Element

The Move operation transfers a cartridge from its current position to a selected destination. If the move
destination is a storage slot, it will become a new home position of a cartridge. The old home position is lost
then. Refer to Home Position on page 79 for details.

After the Move button is pressed, a Move Cartridge to Destination pop-up window appears.

'\i_;.i Note This operation is allowed only for the users with Expert move rights.

Figure 56 Move Cartridge to Destination

x|

Select move destination for cafridge 000007
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03 P2 _IE1009 (E501021001)
o3 P2_IE1010 (ES01020102)
o3 P2 _IE1011 (E801020202)
o3 P3_IE1018 (ES01020902)

4]

e

Select the destination area on the left. The list of slots for this area will be shown on the right (both partition-
name and LSCI coordinates are indicated).

80 Library Tab



@ Note Only available slots are shown that means they are to be compatible, empty, and not
marked as a home position for another cartridge. The destination and target slot can be
the same element.

For the 3590 cartridge the target can be only 3590-compatible slot; refer to Storage
Types on page 247, Mailbox Types on page 248, and Drive Types on page 249).

Select the slot and press OK to complete the move operation. Press Cancel to exit without executing a
move.

Drag and Drop Operations

Drag and Drop operation mostly serves the same function as the Import, Export, Mount, and Dismount
buttons. However there are some extestions (described below).

Drag source Source Status Drop target Operation

Cartridge Mounted Library Dismount

Cartridge Stored Drives Generic Mount

Cartridge Stored Drive Mount to the specified drive

Cartridge Mounted or stored in  Mailbox Export to the specified Mailbox

Storage slot

Cartridge Stored in I/E slot Mailbox Move to the specified Mailbox, the cartridge
remains stored

Drive slot Occupied Mailbox Export the cartridge to the specified Mailbox

Drive slot Occupied Cartridges Dismount drive

Drive slot Occupied Library Dismount drive

Drive slot Occupied No target Dismount drive

Mailbox - Library Import the entire contents of the Mailbox
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Pool

In the Select Components area of the pane, selectable Pools appear. Clicking the expand/collapse button
causes an element expansion.

Figure 57 Pool
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11:58 Irventary far likrary Librar2 completed. hd
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The pool contains a set of cartridges, so the pool properties and operational buttons are the same as those
of a cartridge.

Field/Button Icon Operation Description

Volser Select The volume serial number, a cartridge name. Each cartridge
has one volser.
The optical disks are represented with two cartridges because
each optical disk has two volsers.

Media Type Select Cartridge media type. Refer to Media Types on page 246.
State Select A cartridge state, empty means stfored. Refer to Cartridge
State on page 78.
Import .1 Click Transfer the cartridge from a mailbox slot to a storage area.
bE The target slot is a cartridge home position.

The button is enabled for a cartridge stored in a mailbox.
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Field/Button Icon Operation Description

Export g1z Click Transfer the cartridge to a mailbox. If more than one mailbox
LA exists, an additional export selection appears. See Figure 55.

Select an appropriate mailbox from the combo box.

This operation saves the cartridge home position.

The button is enabled for a cartridge not in a mailbox, when a
mailbox exist.

Mount t3  Click Insert a cartridge into the first available tape drive of the
=F appropriate media type (Generic Mount).
The button is enabled for a stored cartridge.
Dismount % Click Move a cartridge from a tape drive to the cartridge home
H position.

This button is enabled for a mounted cartridge.

Move 2 Click Open a pop-up Move window. Refer to Move Cartridge to
Element on page 80.
The move operation transfers a cartridge from its current
position to a selected destination slot.

Help =2 Click Open online help for the current pane.

+
By default, the cartridges are sorted by media type, in ascending order. Click on the appropriate column title
to change the sorting order.

To select a cartridge for the operation, click on it. <Ctr1>+Click allows multiple cartridge selection, for the
multiple Export/Import operations. Multiple Mount/Dismount/Move operations are not allowed in the
Scalar DLC Management GUI.
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Mailbox

In the Select Components area of the pane, selectable Mailboxes appear. Clicking the expand/collapse

button causes an element expansion.

Figure 58 Mailbox
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14:37 mowe cafridge 000007
14:37 move carridge 000007 finished
14:38 mount cartridge 000011
14:38 mount cartridge 000011 finished

[ »

Field/Button Icon Operation

Volser Select

Media Type Select

State Select

Import .1 Click
Lz

Export g1 Click
C 1

Mount tH3  Click
=

Dismount Click
L
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Description

The volume serial number, a cartridge name. Each cartridge
has one volser. The optical disks are represented with two
cartridges because each optical disk has two volsers.

Cartridge media type. Refer to Media Types on page 246.

A cartridge state, empty means stfored. Refer to Cartridge
State on page 78 for the details.

Transfer the cartridge from mailbox slot to a storage area. The
target slot is a cartridge home position.
The button is enabled for a cartridge stored in a mailbox.

Disabled for a mailbox.
Insert a cartridge into the first available tape drive of the

appropriate media type (Generic Mount).
The button is enabled for a stored cartridge.

Disabled for a mailbox.
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Field/Button Icon Operation Description

Move 2 Click Open a pop-up Move window. Refer to Move Cartridge to
Element on page 80.
The move operation transfers a cartridge from its current
position to a selected destination slot.

Help =2 Click Open online help for the current pane.

+
By default, the cartridges are sorted by media type, in ascending order. Click on the appropriate column title
to change the sorting order.

To select cartridge for the operation, click on it. <Ctr1>+Click allows multiple cartridge selection, for the
multiple Import operations. Multiple Mount/Move operations are not allowed in the Scalar DLC
Management GUI.

Drives

In the Select Components area of the pane, selectable Drives are displayed. Clicking the expand/collapse
button results in an element expansion.

Figure 59 Drives
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14:37 move carridge 000007
14:37 mowe cafridge 000007 finished
14:38 mount cartridge 000011
14:38 mount cartridge 000011 finished -
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Field/Button Icon

Name

Element Type

Current volser

Import C 1
L
Export &
C 1
Mount 3
=
Dismount
=

Move g

Help e

#

Operation

Select

Select

Select

Click

Click

Click

Click

Click

Click

Description

The drive name. An icon also indicates the drive state. See
Table 16 on page 67.

A drive type. Refer to Drive Types on page 249.

If the drive is occupied, a contained cartridge is shown. For the
optical disk two cartridges are shown, active side first.

Disabled for a drive.

Transfer the cartridge to a mailbox. If more than one mailbox
exists, an additional export selection appears. See Figure 55
on page 77. The user selects the appropriate mailbox from the
combo box. This operation saves the cartridge home position.
The button is enabled when a mailbox exists.

Disabled for a drive.

Move a cartridge from a tape drive to the cartridge home
position.
This button is enabled for a mounted cartridge.

Open a pop-up Move window. Refer to Move Cartridge to
Element on page 80.

The move operation transfers a cartridge from its current
position to a selected destination slot.

Open online help for the current pane.

By default, the drives are sorted by element type, in ascending order. Clicking on the appropriate column
title will change the sorting order.

To select drive for the operation, click on it. <ctr1>+Click allows multiple drive selection, for the multiple
Export operations. Multiple Dismount/Move operations are not allowed in the Scalar DLC Management

GUI.
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Configuration Tab

The Configuration Tab is designed to view and update the configuration of the various Scalar DLC system
components. The Configuration Tab contains an additional level with the following tabs:

Logical Tab. Managing library logical configuration, cartridges, pools, mailbox areas, drives. Refer
to Logical Tab on page 88.

Physical Tab. Managing the physical library and the library partitions. Refer to Physical Tab on page
112.

Users Tab. Managing user parameters. Refer to Users Tab on page 128.
Clients Tab. Managing clients. Refer to Clients Tab on page 134.
SCSI Target Tab. Managing SCSI Targets and LUNs. Refer to SCSI Target Tab on page 162.

@ Note The Configuration Tab is accessible for all users. Create, update, and remove functions

are available only for the users with administrative rights.
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Logical Tab

The Logical Tab pane describes the configuration of a logical library and shows the logical element
properties. The starting Logical pane shows the properties of Scalar DLC host PC.

Figure 60 Logical Controller
& Scalar DLC M= E3

Connection  Wizards Esended Service  Help

dmin connected to computer

rLibrawrCDnﬂguratinn rE\tents rSewice |
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©-[In Library2 {online) CPU Vendar ldentifier w6 Family § Model 4 Stepping 3
2|l |L brarySlionline) CPU Speed (MH2) 200
Total Physical Memary (5 G4548
Free Physical Memory (k) f400
Total Virtual Mermary (k) 2087024
Free Vittual Memaory (k) 1938524

14:27 Please wait for deleting Likrary Libraryd
14:27 Deleting finished successiully,

14:45 Initializing element status for library Library?
14:46 Inventary for likrary Librand completed.Found 62 cartridges. -

Selecting the Controller causes the Scalar DLC host PC property list to appear.

Field/Button Icon Operation Description
CPU Identifier = Supplied The CPU identifier
CPU Vendor ID & Supplied The CPU vendor identifier
CPU Speed & Supplied The CPU speed
Total Physical Memory = Supplied The total physical memory size
Free Physical Memory = Supplied The free physical memory size
Total Virtual Memory = Supplied The total virtual memory size
Free Virtual Memory = Supplied The free virtual memory size
Add new Logical Library H Click The pop-up window of Iogigal library creation

appears. Refer to Create Library on page 107.
Help =2 Click Open online help for the current pane.
¢
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Library

There are three sets of properties associated with the Logical Library. The properties are indicated in the

following list:

* Properties. Main library properties. Refer to Properties on page 89.

* Resource. The resources of physical library that current logical library has in use. Refer to Resource

on page 91.

« Statistics. The statistics of operations executed within current logical library. Refer to Statistics on

page 92

Properties

In the Select Components area of the pane, selectable Logical Libraries appear. Clicking the expand/

collapse button results in an element expansion.

Figure 61 Logical Library Properties
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Select component Property yalue
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B
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o & Paol Clientt ‘3|
o £5 EN
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& & Drives |
1 v | ]\ Froperties LResnurce LStatistics 7
BT T T A LI AT L L OTTTETE TS, —
19:59 Initializing element status for likrary Librane3 —
19:59 Irventary far likrary Library3 completed.
19:59 Initializing element status for likrary Librane3
19:59 Irventary far likrary Library3 completed.
Field/Button Icon Operation Description
Name o Enter Logical library name (editable).
Also refer to Table 6 on page 16.
ID & Supplied Logical library identification number.
Number of cartridges & Supplied Number of available cartridges found during the last
inventory.
Number of drives & Supplied Number of available drives.
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Field/Button

Number of slots
Number of I/E slots

State

Clients

Inventory

Update

Remove

Assign new Partition

Add new Scratch
pool

Add new Clean pool

Add new Mailbox

Reset Alarm flag

Refresh Alarm flag

Help

90

Icon

{5

B

%

cad ()

Operation
Supplied
Supplied

Select

Supplied

Click

Click

Click

Click

Click

Click

Click

Click

Click

Click

Description
Number of available storage slots.
Number of available mailbox slots.

Logical library state. See Table 10 on page 63.

Can be changed manually (from online to not ready
and vice versa) to make the library unavailable but this
does not affect the tape device and/or other logical
libraries.

The clients authorized to use the logical library.

Initialize all the library elements and assign a home
position to cartridges. Affects all libraries included the
shared partitions.

Save the logical library properties after edit.

Remove the logical library with all its contents. The
shared partitions are not affected.

Assign new partition to the logical library. A pop-up
assignment window opens. Refer to Assign Partition
on page 108.

This button is disabled if the physical library contains
no partitions that are not assigned to the current
logical library.

Add new scratch pool to the logical library. A pop-up
creation window opens. Refer to Create Pool on page
109.

Add new clean pool to the logical library. A pop-up
creation window opens. Refer to Create Pool on page
109.

Add new mailbox to the logical library. A pop-up
creation window opens. Refer to Create Mailbox on
page 110.

Remove Alarm flag (active only when the library is in
Alarm state).

Refresh Management GUI for Alarm.

Open online help for the current pane.
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Resource

Figure 62 Logical Library Resources
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Field/Button Icon Operation Description
Storage Supplied Storage slots usage, % and chart.

I/E slots Supplied Insert/eject slots usage, % and chart.
Drives Supplied Drives usage, % and chart.
Cartridges Supplied Cartridges usage, % and chart.
Refresh E Click Refresh Logical Library resources.
Help Click Open online help for the current pane.

cod

The resource charts show the total coverage of the logical library. For example, if the physical library
contains 1000 storage slots, and the configured logical library covers 800 slots, the Storage chart shows
80%. Same for the Mailbox (I/E), Drives, and Cartridges.
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Statistics

Figure 63 Logical Library Statistics
4. Sealar DLC 101 =l
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Field/Button Icon Operation Description

Statistics rate Select Show daily/weekly statistics.

Start date Select Start date in range.

End date Select End date in range.

Statistics type Select Statistics type (All / Mounts only / Errors only / Requests only).

Mounts Supplied Mounts executed in logical library.

Errors Supplied Errors encountered in logical library.

Requests Supplied Requests received by logical library.

Refresh E Click Refresh Logical Library statistics.

Help Click Open online help for the current pane.

cod

Select the statistic rate, the date range, and the statistics type, and click on Refresh button to show the
statistic for the current logical library. By default, all statistics in daily range will be shown from the install
date up to current day.
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Partition

In the Select Components area of the pane, selectable Partitions appear. Clicking the expand/collapse
button results in an element expansion.

Table 13 on page 65 shows the different partition classes.

Figure 64 Logical Partition
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12:586 Initializing element status for Partition Pardition10.. =
12:56 Irventary completed successfully.
12:586 Initializing element status for library Library2 [
12:56 Irventary far likrary Librar2 completed. -
Field/Button Icon Operation Description
Name = Supplied Partition name.
Element = Supplied Partition class (storage, I/E, drive). See Table 13 on page 65.
class
Element type = Supplied Partition element type.
Start & Supplied Start element of partition range.
End & Supplied End element of partition range.
Allocation = Supplied Robot1 /| Robot2 indicates the robotic device where the
partition is located.
Shared means the partition is shared between two robots.
Unassign |:s Click Unassign the partition from the logical library (the partition
partition itself remains useful and can be assigned to another logical
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Field/Button Icon Operation Description

Inventory Click Initialize a range of elements, assign home positions to
range cartridges if necessary. A pop-up inventory range window
appears. See Figure 65.

Help =2 Click Open online help for the current pane.

L

Figure 65 Inventory Elements Range
& Inventory Elements Range il

Elements Range:

| LIB1_1000 Generic 3mm JE - | | LIB1_1017 Generic 8mm VE - |

[ ][ %]

Select start and end elements in the range. Press OK to launch the Inventory Range operation (it has the
same effect as the DAS Partinventory command, refer to DAS Administration Guide). Press Cancel to exit
without executing Inventory Range.

Cartridge

In the Select Components area of the pane, selectable Cartridges appear. Clicking the expand/collapse
button results in an element expansion.

Figure 66 Normal Cartridge
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Field/Button

Name

ID

Assigned drive

Type
Current slot
Previous slot

Home slot

State

Status
Owner

Media type

Use count

Number of cleanings
done

Update

Reset Alarm flag

Refresh Alarm flag

Help

Icon

En

B B %

%Y R %Y BDEDD % BB B %

cad ()

Operation
Supplied

Enter

Supplied

Select

Select
Supplied
Supplied

Supplied

Select

Supplied
Supplied

Supplied

Select

Supplied

Supplied

Click

Click

Click

Click

Description

Name (volser), stable for a normal cartridge.

Name (volser), editable for a foreign cartridge.
Also refer to Table 6 on page 16.

Cartridge identification number.

A drive assigned to cartridge, if any. If the Generic
mount operation is executed, the cartridge loads into
the assigned drive if it is available.

Cartridge type (data/clean)
The slot where the cartridge is right now.
The slot where the cartridge was previously.

The cartridge home position. Refer to Home Position
on page 79.

Cartridge state. See Table 19 on page 78 for the
details.

The cartridge availability for the commands.
The cartridge owner (client), if any.

Media type, stable for a normal cartridge. Refer to
Media Types on page 246.

Media type, changeable for a foreign cartridge. Refer
to Media Types on page 246.

Number of mounts performed (for the data cartridge
only).

Number of cleanings performed (for the cleaning
cartridge only).

Save the cartridge properties after edit.

Remove Alarm flag (active only when the cartridge is
in Alarm state).

Refresh Management GUI for Alarm.

Open online help for the current pane.

If the cartridge is not found in the library after the Inventory has been executed, its state changes to offline.
After that, the cartridge is removed from the cartridge list of the Logical library and goes to archive list, or
the list of the offline cartridges. It is shown under the Physical tab and contains the information about
cartridges that were removed from the physical library. Refer to Offline Cartridge on page 121.
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_ The only method available from the Management GUI to correctly identify the
41y CAUTION  cleaning cartridges after Inventory has been completed is to manually change
the desired individual cartridge type from data to cleaning. Then, if necessary,

the acquired cleaning cartridges can be added into the clean pool.

There is also a foreign cartridges category (see Figure 67). These cartridges are either duplicates (another
cartridge with the same name exists in the library), or not readable (the barcode scanner that reads the
volsers cannot scan the name of current cartridge).

To operate with the foreign cartridges, their properties have been extended: Admin can change the cartridge
name (volser) and media type. The foreign cartridge has a media type that is the default for the slot where
it is found after the first Inventory. The foreign cartridge has a name with a small “u* (for not readable
volser), or with a small “d“ (for duplicated volser).

'\i_;.i Note The foreign cartridge media type is changeable in the ranges of media domain only. That
means the foreign cartridge recognized by default as DLT IV can be changed, for
example, to SDLT or DLT HlIIXT, but not to 3590. Refer to Media Types on page 246.

Figure 67 Foreign Cartridge
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Pool

In the Select Components area of the pane, selectable Pools appear. Clicking the expand/collapse button
causes an element expansion.

Figure 68 Pool
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Field/Button Icon Operation Description

Name o Enter Pool name.
ADIC recommends using Pxx for scratch pools and
CLx for clean pools.
Also refer to Table 6 on page 16.

ID & Supplied Pool identification number.

Media Pool type & Supplied Pool type (data/clean)

Device & Supplied Name of device (physical library) where the pool is
located.

Media Type & Supplied The type of media contained in the pool. Refer to
Media Types on page 246.

Number of volsers = Supplied The number of cartridges currently contained in the
pool.

Watermark o Enter The minimal number of valid cleaning media the pool

should contain.
For clean pools only.
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Field/Button Icon Operation Description

Maximum cleanings o Enter The number of times the cleaning cartridge belonging
per tape to the pool can be used.
For clean pools only.

Volsers Supplied The list of cartridges that are currently contained in the
pool. The cartridge state is also indicated.
Also refer to Cartridge on page 94.

Assign/Unassign i+ Click Pop-up Assign/Unassign window opens. Refer to

L+ Assign Media to Pool on page 98.

&

Update ﬁ Click Save the pool properties after edit.
Remove ﬁ Click Remove the scratch pool (the cartridges remains in
the library).
ﬁ Remove the clean pool (the cartridges remains in the
library).
Help =2 Click Open online help for the current pane.
+
@ Note Pool names are unique for a logical library. Using the default name ensures uniqueness.

Assign Media to Pool

The pop-up window allow assigning cartridges to the existing pool and unassigning the cartridges from it as
well.

Figure 69 Assign/Unassign Cartridges to Pool
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The left pane (Unassigned) contains all available media of appropriate type that are not assigned to the
pool. The right pane (Assigned) contains all cartridges that are already assigned to the pool.

Select a cartridge that should be assigned to the pool (or removed from it) and press the appropriate arrow
button (“left” from Assign to Unassign, and “right” vice versa). Multiple cartridge selection is possible, too,
by <ctr1>+Click.

Press OK to close the window and update the pool. Press Cancel to close the assignment window without
applying the changes.
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_ Only the data cartridges can be assigned to the scratch pool; only the cleaning
A¥\ CAUTION  cartridges can be assigned to the clean pool.

@ Note The operation of assigning a pack of cartridges to the pool or unassigning a number of
cartridges from the pool can be executed as many times as necessary. Itis also available
from the client side (for DAS clients).

Mailbox

In the Select Components area of the pane, selectable Mailboxes appear.

Figure 70 Mailbox
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& ? Fartition5 (Quant MName | Elementtype | Partition
©- dl Partitionf (Guant ca P2_IE1000 Generic DLT WE Partition2
@ 2 Partition? (Quant c1 P2_IE1001 Generic DLT WE Partition2
@ Enfi EO ca P2_IE1002 Generic DLT WE Partition2
o3 P2_IET000 ca P2 _IE1003 Generic DLT WE Partition2
c3 P2 |E1001 c1 P2 _IE1004 Generic DLT FE Parition2
£ P2_IE1002 c 3 P2_IET005 Generic DLT iE Partition2
c1 P2 IE1003 c1 P2 |E1006 Generic DLT IiE Paritionz
capz IE1004 |= ||=3 F2_IE1007 Generic DLT IE Partition2
] |_ [ ’|L 3 P2_IE1008 Generic DLT VE Partition2 =
12:56 Initializing element status for Padition Parition10... =l
12:86 Inventory completed successfully.
12:56 Initializing element status for likrary Librar2 [
12:56 Inventary for library Library2 completed. -
Field/Button Icon Operation Description
Name o Enter Mailbox name.
Also refer to Table 6 on page 16.
ID & Supplied Mailbox identification number.
Number of I/E slots & Supplied The number of assigned slots.
I/E slots Supplied The slots currently assigned to the mailbox. The slot

names, element type, and partition are indicated.
Refer also to Mailbox Slot on page 102.
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Field/Button Icon Operation Description

Assign/Unassign E% Click Pop-up Assign/Unassign window opens. Refer to
Assign Slots to Mailbox on page 100.
Update ﬁ Click Save the mailbox properties after edit.
Remove Eni Click Remove the mailbox.
Help 2 Click Open online help for the current pane.
+
@ Note Mailbox names are unique for a logical library. Using the default name ensures
uniqueness.
@ Note If the DAS interface is used, the mailbox names must adhere to the DAS standards.

ADIC recommends “Exx” and “Ixx” as names for the Export and Import mailboxes
respectively (they can consist of the same mailbox slots).

Assign Slots to Mailbox

The pop-up window allow assigning insert/eject slots to the existing mailbox and unassigning the slots from
it as well.

Figure 71  Assign/Unassign Slots to Mailbox

& Assigning,/UnAssigning import-export logical elements to mailbo; |
Unassigned Assigned
MNarme Element type | Parition Mame Element type | Partition
=3 P2_IE1006 |Generic DLT IVE|Partition2 =
=3 P2_IE1007 |Generic DLT E |Partition2 g [=PZIE101010enenc DLT ... Partiion2
; " =3 PZ_IE1011 |(Generic DLT .. |Partition2
—1 PZ_IE1008 |Generic DLT VE|Partition2 = F'3_IE1D19 po CDLT . Partitiona
-3 P2_IE1008 |Generic DLT E |Partition2 =<| o3 iEiom GEEE:E . P:n:t:E:S
—31 P3_IE10M8 |Generic DLT VE |Partition3 = F'3:IE1DE1 Generic DLT _|Partitions
=31 P3_IE1022|Generic DLT ... |Parition3
=3 P3 IE1023|Generic DLT ... [Partition3

[ ][ %]

The left pane (Unassigned) contains all available insert/eject (mailbox) slots that are not assigned to the
current mailbox. The right pane (Assigned) contains all mailbox slots that are currently assigned to the
mailbox.

Select a slot that should be assigned to the mailbox (or removed from it) and click the appropriate arrow
button (“left” from Assign to Unassign, and “right” vice versa). Multiple slot selection is possible, too, by
<Ctrl>+Click.

Click OK to close the window and update the mailbox. Click Cancel to close the assignment window without
applying the changes.

@ Note The operation of assign and unassign a pack of slots to and from the mailbox can be
executed as many times as necessary.
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Storage Slot

In the Select Components area of the pane, selectable Storage Partitions are displayed. Clicking the
expand/collapse button results in an expansion that shows the Storage slots.

Figure 72 Storage Slot

-0 %]
Connection  Wizards Exiended Service  Help
rLibrar\;rCUnﬂguratiDn rEvents |/Senrice |
angical |/F'h\,rsical rugers |/Clients rSCSITarget |
Select component FProperies
£ P28_ST19385 &= Froperty | Yalle ,/|
&3 P28_ST19386 [ Marne P29_ST19395
£ P29_8T18387 I 16055 [
el Physical coordinate 19305 2|
&2 P239_8T19384 = :
£ p29_5T18390 Rohot! coordinate 7011
&3 P28 _5T19361 Robot? coordinate G011
&3 P28_5T19382 LS coordinate Lw07011201
£5 P28_5T19383 Current cartridge Mane
S-CiiTg |
=
— P29_ST19396 Es Ownerl . Mone
= P28_5T19207 # Exclusive resemvation
= P29_5T19388
= P23_5T19399 |
— B70 _CT10400 I
Il ] 7
14:37 move carridge 000007 =
14:37 mowe cafridge 000007 finished
14:38 mount cartridge 000011 [
14:38 mount cartridge 000011 finished =
Field/Button Icon Operation Description
Name 5 Supplied Slot name.
ID & Supplied Slot identification number.
Physical coordinate & Supplied Slot physical (SCSI) coordinate. Refer to Element
Addressing on page 244.
Robot1 coordinate 5 Supplied The slot coordinate in Robot1 (None means the slot is
assigned to another robot). Refer to Element
Addressing on page 244
Robor2 coordinate = Supplied The slot coordinate in Robot2 (None means the slot is
assigned to another robot). Refer to Element
Addressing on page 244
LSCI coordinate & Supplied Slot LCSI coordinate. Refer to Element Addressing on
page 244.
u i uppli i i , i .
Current cartridge S lied A contained cartridge, if an
State & Supplied Slot state (empty/occupied)
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Field/Button Icon Operation

Owner f’ Select

Exclusive reservation W Supplied
Update ﬁ Click
Update 5@ Click
Reset Alarm flag w Click
Refresh Alarm flag o Click

L=
Help Click

?

Mailbox Slot

Description

A slot owner (client). The reserved slot can be used
only by its owner.

None means the slot is not reserved.

The reservation may be either normal (another owner
can un-reserve the slot) or exclusive (only the owner
can change the reservation).

Save the slot properties after edit.
Save the cartridge properties after edit.

Remove Alarm flag (active only when the slot is in
Alarm state).

Refresh Management GUI for Alarm.

Open online help for the current pane.

In the Select Components area of the pane, selectable Mailboxes and Insert/Eject Partitions appear.
Clicking the expand/collapse button causes an expansion that shows the Mailbox slots.

Figure 73 Mailbox Slot
g Scalar DLC

Connection  Wizards Edended Service  Help

fLibraw r Configuration |/ Events |/ Service |

=101 %]

fLogicaI |/F'hysica| rUsers |/ Clients rSCSITarget |

Select component Fropeties
; ;l_lt:enenc LJLI_: Propery | Yalue
o EE'ID & Name PE1_IETE
& PE1_IETE & ID 1649
=3 PE1_IE1T & Physical coordinate 16
=2 FE1_IETE & Robott coordinate 16
=a PAY_IETS = -
== PE1_IE20 & Robot2 coordinate one
=a PE1 IEZ1 & LSCIcoordinate EG0Z010101
= PE1_IE22 & Current cartridge MHane =
ca PE_IE23 : _
£ PE1_IEZ4 MailBoxes
.3 PE1_IEZA Assigned lnassigned
.3 PA1_IEZG £
=3 PEI_IE27 ﬂ
wapai_Eas ||| ' B
=a PAY_IE3S - ==
q Z DN ¢

P S0 THIETT T T T A LOT T T L OTTETE e,

19:28 Robothas a physical problem with the cartridge

19:28 Initializing element status for likrary Libran
19:28 Irventary far likrary Librar! completed.
19:29 Ticket created successfully

[ »
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Field/Button

Name
ID

Physical coordinate

Robot1 coordinate

Robor2 coordinate

LSCI coordinate

Current cartridge
State

Owner

Exclusive reservation

Assigned/Unassigned
Mailboxes

Update

Reset Alarm flag

Refresh Alarm flag

Help

Scalar DLC Reference Guide

Icon
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Operation
Supplied
Supplied

Supplied

Supplied

Supplied

Supplied

Supplied
Supplied

Select

Supplied

Select and
click

Click

Click

Click

Click

Description

Slot name.
Slot identification number.

Slot physical (SCSI) coordinate. Refer to Element
Addressing on page 244.

The slot coordinate in Robot1 (None means the slot is
assigned to another robot). Refer to Element

Addressing on page 244

The slot coordinate in Robot2 (None means the slot is
assigned to another robot). Refer to Element

Addressing on page 244

Slot LCSI coordinate. Refer to Element Addressing on
page 244.

A cartridge contained in the slot, if any.
Slot state (empty/occupied)

A slot owner (client). The reserved slot can be used
only by its owner.

None means the slot is not reserved.

The reservation may be either normal (another owner
can un-reserve the slot) or exclusive (only the owner
can change the reservation).

Select mailbox and click arrow button to assign/
unassign the current slot to/from it.

Save the slot properties after edit.

Remove Alarm flag (active only when the slot is in
Alarm state).

Refresh Management GUI for Alarm.

Open online help for the current pane.
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Drive

There are two sets of properties associated with the Drive. The properties are indicated in the following list:

* Properties. Main drive properties. Refer to Properties on page 104.

+ Statistics. The statistics of operations executed within current drive. Refer to Statistics on page 106.

Properties

In the Select Components area of the pane, selectable Drives and Drive Partitions are displayed. Clicking
the expand/collapse button results in an element expansion.

Figure 74 Drive Properties

4. scalar DLC 101 =l
Connection  Wizards Edended Service  Help
f Library r Configuration |/ Events |/ Service |
f Laogical |/ Phiysical r Lsers |/ Clients |/ S8l Target |
DR Ganiom SOCT 770 Property | Ve
— — M PTOCRZE0
DR_Quantum SDLT 600_{ | & "ame
E_Generic DLT IE__61 @D 1647
ST_Genetic DLT__G0 @ Physical coordinate 260
A Foolt & Robot! coordinate 260
g 53011 | || & Robot? coordinate Mot
5 Drives @ LSClcoordinates CHYO0a010101
& PEZDR256 Quantum [ & Current cartridge Mone
= PE4DR257 Quantum [ & State Erripty
= PEEDR258 Quanturm 3
&= PB7DR262 Quantum & | || B Numeer of mounts -
£ PE3DR259 Quanturm § | ||# Time (ms) 300000
= PEIDR 265 Guanturm 3 & Clean Poals Mo
= F'TEIDREED Guanturm 8 ﬂ Automatic c|eamng D
brary2 (Dnl!ne) % Maxuse 1000 hhd
hrary3 fanling) -
1] [»] ]\ FProperies LStatistics | ?J
17:47 Initializing element status for library Likiraryl -
17:47 Inventary for library Library? completed.
17:449 move carridge 000007 B
17:449 move carridge 000011 —
A 740 1 rtriclo 000007 fimickhod ¥
Field/Button Icon Operation Description
Name ﬁ' Enter Drive name.
Also refer to Table 6 on page 16.
ID & Supplied Drive identification number.
Physical coordinate & Supplied Drive physical (SCSI) coordinate. Refer to Element
Addressing on page 244.
Robot1 coordinate = Supplied The drive coordinate in Robot1 (None means the slot

is assigned to another robot). Refer to Element
Addressing on page 244
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Field/Button

Robot2 coordinate

LSCI coordinate

Current cartridge
State

Number of mounts
Time (ms)

Clean pool
Automatic cleaning
Max Use
Dismount

management

Delay (ms)

Loops

Owner

Exclusive reservation

Update

Reset Alarm flag

Refresh Alarm flag

Help

T4 Note
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Icon
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Operation

Supplied

Supplied

Supplied
Supplied
Supplied
Enter

Select

Check

Supplied

Check

Supplied

Supplied

Select

Supplied

Click

Click

Click

Click

Description

The drive coordinate in Robot2 (None means the slot
is assigned to another robot). Refer to Element

Addressing on page 244

Drive LCSI coordinate. Refer to Element Addressing
on page 244.

A cartridge contained in the slot, if any.

Drive state (empty/occupied).

A total number of mounts executed into the drive.
The cleaning time for the drive.

A pool that is used by clean manager to get the
cleaning cartridges.

Configure auto-cleaning. If checked, the Max Use field
is editable.

Shows how long the drive could be used without
cleaning (number of mounts between cleanings).

Configure the dismount manager. If checked, the
Delay and Loops fields are editable.

A time the drive requires to unload the cartridge.

Number of retries if the drive does not unload the
cartridge.

A slot owner (client). The reserved slot can be used
only by its owner.

None means the slot is not reserved.

The reservation may be either normal (another owner
can un-reserve the slot) or exclusive (only the owner
can change the reservation).

Save the slot properties after edit.

Remove Alarm flag (active only when the slot is in
Alarm state).

Refresh Management GUI for Alarm.

Open online help for the current pane.

If the DAS interface is being used, the drives are to be named according to the DAS
standards. ADIC recommends using names no more than 9 alphanumeric characters
long and beginning with a letter.
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Statistics

Figure 75 Drive Statistics
£ gealar DLC ;Iglll

Connection  Wizards Edended Service  Help

r admin connected to computer

fLibraw r Configuration |/ Events |/ Service |
fLogicaI |/F'hysica| rUsers |/ Clients rSCSITarget |

StellDE ColEshL [Daily v 27122004 w | 29112/2004  w [Mounts =[]
ML A ER MR- ayy————————
CR_Quantum SOLT 600_| Mounts
|E_Generic DLT WE__EB1 i
ST_teneric DLT__B0

M Poalt 5

3 EM

3 101 Ml E

F Drives
= PE2DR256 Quanturm O
= PE4DR247 Quanturm O
= PEEDR258 Quanturm 3
= PETDR262 Quanturm 3
= PEBDR259 Quanturm 3
= PEIDR265 Quanturm 3
= PYODR260 Quantum 8

hrary2 fanling)

hrary3 fanling)

2712 28112 2912

T | Properties | Statistics 7
17:47 Initializing element status for library Librany1 B
17:47 Inventory for library Library! completed.
17:49 move cartridge 000007 B
L e 00 -

Field/Button Icon Operation Description

Statistics rate Select Show daily/weekly statistics.

Start date Select Start date in range.

End date Select End date in range.

Statistics type Select Statistics type (All / Mounts only / Errors only / Cleanings only).

Mounts Supplied Mounts executed by the drive.

Errors Supplied Errors encountered in the drive.

Cleanings Supplied Cleanings done in drive.

Refresh E Click Refresh Logical Library statistics.

Help Click Open online help for the current pane.

cod
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Create Library

Under the Controller properties, the Add new Logical Library button appears. Clicking it opens a pop-up
library creation pane.

@ Note Only administrator users can create the library. For the user without administrative
privileges, the Add new Library button is disabled.

Figure 76  Logical Library Creation

&ndd new Library x|
Propetties
Fraoperty | Yalue ||=/

& Mame Library3 x

D ]

Humber of cartridges ]

Mumber of drives ]

Mumber of slots ]

Number of fE slots ]

State

Clients

i
Field/Button Icon Operation Description
Name o Enter New logical library name.
Also refer to Table 6 on page 16.
ID = Supplied Logical library identification number.
Number of cartridges & Supplied Number of available cartridges.
Number of drives & Supplied Number of available drives.
Number of slots & Supplied Number of available storage slots.
Number of I/E slots & Supplied Number of available mailbox slots.
State & Supplied Logical library state. See Table 10 on page 63.
Clients Supplied The clients attached to the logical library.
Always empty for the library that is being created.
Create vy Click Create logical library.
Cancel x Click Cancel creation.
Help e Click Open online help for the current pane.
o
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/1y, CAUTION

The created logical library is invalid and not operable. To complete the library
configuration, at least two partitions (storage and drive, three recommended
— storage, insert/eject, and drive) should be assigned to the logical library
before the inventory can be executed. Refer to Assign Partition on page 108

and Assign Partitions on page 38.

Assign Partition

Under the Library properties, the Assign Partition button appears. Clicking it opens a pop-up partition

assignment pane.

@ Note Only administrator users can assign the partitions. For the user without administrative
privileges, the Assign Partition button is disabled.

'\‘(’.&' Note There is a more powerful engine for the multiple partition assignment operation. It is
accessible from the Main Menu bar. Refer to Assign Partitions on page 38.

Figure 77  Partition Assign

Field/Button

Name

Element class

Element type
Start
End

Allocation

Assign

108

Icon

B B BB B %

&nssign Partition il
Properies

Froperty | Yalle II?
& Marne Partition13 | %
& Element Class Storage
& Element Type LTO

& Start

LIB2_35768 LTO (200021}

& End LIBZ_36767 LTO
& Allocation Robot! K
Operation Description

Select Select the partition to assign

Supplied Partition class (storage, I/E, drive). See Table 13 on
page 65.

Supplied Partition element type.

Supplied Start element of partition range.

Supplied End element of partition range.

Supplied Robot1 /| Robot2 indicates the robotic device where
the partition is located.
Shared means the partition is shared between two
robots.

Click Assign partition
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Field/Button Icon Operation
Cancel x Click
Help Click
7
Create Pool

Under the Library properties, the Add new Scratc
Clicking either opens a pop-up pool creation pane.

‘1_;% Note Only administrator users can cre
privileges, both the Add new Sc
disabled.

Figure 78 Pool Creation

Description

Cancel assignment.

Open online help for the current pane.

h Pool and Add new Clean Pool buttons appear.

ate the mailboxes. For the user without administrative
ratch Pool and Add new Clean Pool buttons are

£ Add new Clean Pool ﬂ
Propetties i
Froperty | Walue |
= [+
& ID 10 -
& Media Poal type Clean - X
& Device ADIC Scalar1000#%.. |
# Media Type armm
Mumber of valsers 1
& \Watermark 3
& Maximum cleanings pertape 10 E
Wolsers
Mame | State |
000010 7
Field/Button Icon Operation Description
Name o Enter Pool name.
Also refer to Table 6 on page 16.
ID & Supplied Pool identification number.
Media Pool type & Supplied Pool type (data/clean).
Device & Supplied The name of device (physical library) where the pool is
located.
Media type 4 Select The type of media contained in the pool. Refer to
Media Types on page 246.
Number of volsers & Supplied The number of cartridges currently contained in the
pool.
Watermark o Enter The minimal number of valid cleaning media the pool
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should contain.
For clean pools only.
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Field/Button

Icon Operation

Description

Maximum cleanings o Enter The number of times the cleaning cartridge belonging
per tape to the pool can be used.
For clean pools only.
Volsers Supplied The list of cartridges that are currently contained in the
pool. The cartridge state is also indicated.
Also refer to Cartridge on page 94.
Assign/Unassign = Click Pop-up Assign/Unassign cartridges dialog opens.
] Refer to Assign Media to Pool on page 98.
Create Ny Click Create pool.
Cancel x Click Cancel creation.
Help =2 Click Open online help for the current pane.
+
@ Note Pool names are unique for a logical library. Using the default name ensures uniqueness.

Create Mailbox

Under the Library properties, the Add new Mailbox button appears. Clicking it opens a pop-up mailbox

creation pane.

% Note Only administrator users can create the mailboxes. For the user without administrative
privileges, the Add new Mailbox button is disabled.

Figure 79 Mailbox Creation

Field/Button

Name

ID

110

£ ndd new MailBox x|
Propetties E(}J
Praperty | Walue
# Name E0Z v
D n X
& Mumber of NE slots a0
|IESIots
Mame | Element type | Fatition |
c3 P20_IET1026 |Generic halfinc... |Padition20
c3 P20_IET102Y |Generic halfinc... |Padition20
c3 P20_IE1028 |Generic halfinc... |Padition20 T
Icon Operation Description

f’ Enter

& Supplied

Mailbox name.
Also refer to Table 6 on page 16.

Mailbox identification number.
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Field/Button Icon Operation Description

Number of I/E slots & Supplied The number of assigned slots.

I/E slots Supplied The list of slots that are currently assigned to the
mailbox. The slot names, element type, and partition
are indicated.

Assign/Unassign E% Click Pop-up Assign/Unassign mailbox slots dialog opens.
Refer to Assign Media to Pool on page 98.

Create vy Click Create mailbox.

Cancel x Click Cancel creation.

Help 2 Click Open online help for the current pane.

+

‘Qﬁ Note Mailbox names are unique for a logical library. Using a default name ensures

uniqueness.
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Physical Tab

The Physical Tab pane describes the configuration of a physical library. The starting Physical pane shows
the Scan SCSI properties of the Scalar DLC host PC.

) Only administrator users can modify the Scalar DLC system configuration. For the user
T4 Note : PO , o
without administrative privileges the operation buttons remain disabled.

Figure 80 Physical Controller
& Scalar DLC = B

Connection Wizards Exiended Service Help

dmin connected to camputer

rLihrawrCDnﬂguratinn rEvents rSENiCE |

[Logical | Physical | Users [ Clients | 205 Taret |

Select component Properties

¢ = lcomputer Property Yalue | i
@ [m ADIC Scalar 10K #1 || # Rescan numhber 5
@ [ ADIC Scalar 1000# | # Timeout () 180 &

@ [g ADIC Scalar 10K #3

L 7|

1527 Please wait. Azsigning .. -]
148:23 Lagical likrary "Library1" has no DRIVES to match "3590E" media.
1528 Initializing element status for library Library? . =
18:29 Inventary for likrary Librarn completed Found 67 cartridges.

ilf:

Field/Button Icon Operation Description
Rescan number o Enter The number of Rescan SCSI Bus operations done.
Timeout(s) & Enter The default timeout time, ms.
Scan SCSI Bus % Click Scan SCSI bu_s and create the physical library objects
for each new library found.
Update 5@ Click Save properties after edit.
Help =2 Click Open online help for the current pane.
@
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Library

In the Select Components area of the pane, selectable Physical Libraries appear. Clicking the expand/
collapse button causes an element expansion.

There are three sets of properties associated with a physical library.
» Properties. The properties of physical library. Refer to Properties on page 113.
* Media Rules. Setting the media rules for the physical library. Refer to Media Rules on page 115.
+ Statistics. Monitoring the statistics fir the physical library. Refer to Statistics on page 117.

Properties
Figure 81 Physical Library Properties
4. scalar DLC 101 =l
Connection  Wizards Edended Service  Help
fLibraw r Configuration |/ Ewents |/ Semice |
f Laogical |/ Phiysical r Lsers |/ Clients |/ S8l Target |
Select component Froperty | value [ e
o computer Mame ADIC Scalar1000 #11111 'ﬁ'
& &5 [DIC Scalar 1000 #1 State Online
@ [Ig ADIC Scalar 10K #22 ([ b o
& [lg ADIC Scalar 10KDA 4 ProductiD Scalar 1000
vendorD ADIC B
Command gueue execution Activated ¥
Mumber of storage 50 g
Mumber of VE slots 36
Murmber of drives 10
Murmber of cartridges 29
= [ ]\ Properties L Media rules LStatistics 7
17:47 Initializing element status for library Likiraryl -
1747 Inwventary for library Library? completed.
17:49 mowe carridge 000007 [
1749 move carridge 000011 —
A 740 1 rtricdo 000007 fimickhood x
Field/Button Icon Operation Description
Name & Supplied Tape device name.
State & Supplied Physical library state. See Table 11 on page 64.
Product ID = Supplied Library product ID.
Vendor ID 5 Supplied Library vendor ID.

Scalar DLC Reference Guide 113



Field/Button

Command queue
execution @

Number of storage
Number of I/E slots
Number of drives
Number of cartridges

Remove

Add new Partition

Freeze
Activate

Reset Alarm flag

Refresh Alarm flag

Help

Icon

E R e a o

oV ¥

cad ()

Operation

Supplied

Supplied
Supplied
Supplied
Supplied

Click

Click

Click
Click

Click

Click

Click

Description

Activated means commands should be executed when
they arrive to the physical library.

Frozen means commands should be executed only
after the library will be activated again.

Number of available storage slots.
Number of available mailbox slots.
Number of available drives.
Number of available cartridges.

Remove the physical library.

Add new partition. Refer to Create Partition on page
127.

Freeze command queue execution.
Activate command queue execution (after freeze).

Remove Alarm flag (active only when the library is in
Alarm state).

Refresh Management GUI for Alarm.

Open online help for the current pane.

a. The Freeze command queue execution feature currently is implemented for the Scalar 10K DA libraries only.

If the physical library properties are changed (for example, another drive

/I\ CAUTION

added), the Scan SCSI Bus operation does not update the existing library

properties. The update can be done only by the Teach command from the
device operator panel.

When new drive(s) and/or insert/eject slot(s) have been added to the physical

/1\ CAUTION

library that already contains a working configuration (logical library, clients,

etc.), the admin must check whether the configuration of partitions is still
correct. Refer to Partition on page 119.

The operation of assign-unassign partitions may be required. Refer to Assign
Partition on page 108 and Assign Partitions on page 38.

If the physical library is removed, all partitions, media rules, and offline

/1\ CAUTION
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cartridges are lost. Library delete confirmation is required.
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Media Rules

The physical library cannot always correctly identify the cartridge media type by recognizing its barcode
label (especially for the old models of barcode readers). The media domain is always recognized correctly,
the media type is not. In such cases the un-recognized volser receives the media type as default to the slot

where it has been found during Inventory.

However, this may lead to incorrect assignment of media type to cartridge, and that can even lead to a
hardware crash (for example, if the SDLT cartridge has been mis-identified as DLT Ill and mounted to the

Quantum DLT 4000 drive).

To improve the situation, a Media rules feature has been provided so the Scalar DLC administrator can
assign a correct media type to the range of volsers. The typical rule is, “if the cartridge is in the specified
volser range and has the specified media domain, check whether it has the specified media type®. The
volser ranges specified in different rules cannot overlap by media domain (that means, two rules cannot
have both same media domain and overlapped volser ranges). See Figure 82 on page 115.

Also refer to Media Types on page 246 and Drive Types on page 249.

@ Note The media rules do not work automatically and require the manual appliance and
confirmation.

_ The media rules feature should be used only by very experienced users. The
41 CAUTION  jncorrect assignment of media type to cartridge can cause a hardware crash.

Figure 82 Media Rules
4. gealar DLC
Connection  Wizards Edended Service  Help

=10l x|
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17:47 Initializing element status for library Likiraryl
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AT7-A0 ke striclean OOOONOT finmicbood

[ »

4[]

Scalar DLC Reference Guide 115



Field/Button Icon Operation Description

Media domain Supplied The domain of media selected by the rule.

Volser Range Supplied The range of volsers selected by the rule.

Media type Supplied The media type that should be assigned.

Add Click Add a new media rule. A pop-up window opens, refer to Create
-+ Media Rule on page 116.

Remove Click Remove an existing rule.

Apply 5@ Click Apply the selected rule. A pop-up window opens, refer to Apply

Media Rule on page 116.

Help ] Click Open online help for the current pane.

o

Create Media Rule

The pop-up pane allows to create media rule.

) Only administrator users can create the media rules. For the user without administrative
£ Note ) S
privileges the button is disabled.

Figure 83 Media Rule Creation

&ndd Yolser range x|
Volserrange 000002 | - [240000 |
Media damain | 8 mm e ‘
Media type ‘AIT v‘

R EN

Enter the volser range. Select the media domain. Specify the media type that should be assigned to the
cartridges in the specified range, if they do have an appropriate media domain. Click OK to create and apply
the media rule. Click Cancel to exit without creating the media rule.

Apply Media Rule

The pop-up pane allows to apply the existing media rule.

@ Note Only administrator users can apply the media rules. For the user without administrative
privileges the button is disabled.
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Figure 84 Apply Media Rule

& Use new media kype

S

Wolgser 0ld media type |New media type Uze
000042 amm AT 4]
222101 gmm AT 4]
222202 gmm AT 4]
2223u3 gmm AT 4]

For every Volser, check whether the New media type should be used instead of Old media type. Leave Use
check box blank if it is not true. Click OK to apply the media rule. Press Cancel to close the pane without
applying the rule.

Statistics

Figure 85 Physical Library Statistics

4. scalar DLC 101 =l
Connection  Wizards Edended Service  Help
fLibraw r Configuration |/ Events |/ Service |
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StellDe: solmpEstl [ Daily v 27122004 w 2911272004 w Al 1z
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B = computer
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@ [Im ADIC Scalar 10K #22
@ [Im ADIC Scalar 10KDAR
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203
152
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51
2 2712 2812 2912
[ [ » L Properties LMedia rules LStatistics | 7
17:47 Initializing element status for library Likiraryl -
17:47 Inventary for library Library? completed.
17:49 mowe carridge 000007 [
17:449 move carridge 000011 —
AT7-A0 ke stricleae OOOOOT finmicbood il
Field/Button Icon Operation Description
Statistics rate Select Show daily/weekly statistics.
Start date Select Start date in range.
End date Select End date in range.
Statistics type Select Statistics type (All / Mounts only / Errors only / Requests only).
Mounts Supplied Mounts executed in physical library.
Errors Supplied Errors encountered in physical library.
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Field/Button

Requests

Refresh

Help

Robot

Description

Requests received by physical library.

Refresh Physical Library statistics.

Icon Operation
Supplied
Click
B
Click
7

Open online help for the current pane.

Depending on type, the physical library can have either one robotic controller (single-aisle library - Scalar
1000, Scalar 10K), or two (dual-aisle library, Scalar 10K DA).

Figure 86 Robot Online

Connection  Wizards

Extended Service

rLibrar\;rCUnﬂguratiDn rEvents |/Senrice |

Help

=101 %]

angical |/F'h\,rsical rugers |/Clients rSCSITarget|
Select component

FProperies

@ [o ADIC Scalar 10K]~|

Froperty | Yalle

=C Rohotl
== Rohot2

& & Offline Cartri
B storage Slot
Eﬂ MailBoxes
B Drives
T Partition10 (G~
2 Partition11 (G
2 Partition12 (G
T Partition1 3 (G
2 Partition14 (G
2 Partition15 (G
T Partition16 (G
2 Partition1 7 (L}

A3 Mame
5 Mumber
5 State

5 Barcode mode &

Raohot

1 k]

active

12:586 Initializing element status for Partition Pardition10..

12:56 Irventary completed successfully.

12:586 Initializing element status for library Library2

12:56 Irventary far likrary Librar2 completed.

| »

Field/Button

Name

Number

State

Barcode mode

Start
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Icon Operation
Supplied

Supplied

Supplied
Supplied

Click

W OB B B B

Description

Robotic controller name.

Robotic controller number (1 for single-aisle robot, 1 or
2 for dual-aisle robots).

Robotic controller state. See Table 12 on page 64.
Barcode reader is always active for the Scalar robots.

Start the robot that is currently offline.
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Field/Button Icon Operation Description

Stop @ Click Stop the robot that is currently online.

Update 5@ Click Update the robot parameters after edit.

Help =2 Click Open online help for the current pane.
+

Figure 87 Robot Offline

=1
Connection  Wizards Exitended Service Help
rLibrar\; rCUnﬂguratiun rEvents |/Senrice |
angical |/F'h\,rsical rugers |/Clients rSCSITarget |
Select component FProperies
@ [o ADIC Scalar 10K]~| Propery | Yalue E‘5>|
=C Rohott H Mame Robot2
e [Robotz & Murnber 2 C1or)
@ Offline Cartrid State offling 7
g Storage Slots Barcode made
Eﬂ MailBoxes
B Drives
1 Partition10 (G
2 Partition11 (G
2 Partition12 (G
1 Partition13 (G
‘2 Partition14 (G
2 Partition15 (G
=1 Partition16 (G
2 Partition17 (L]—|
q [ | 7
12:586 Initializing element status for Partition Pardition10.. =
12:56 Irventary completed successfully.
12:586 Initializing element status for library Library2 [
12:56 Irventary far likrary Librar2 completed. -

Partition

Partition is a segment of the physical library that contains a continuous range of slots of single class (for
example, Storage) and type (for example, DLT). The partitions cannot overlap, so if the admin wants to
create a partition that includes a part of an occupied range, it is required to remove the previous partition
and create two new partitions instead.

Table 13 on page 65 shows the different partition classes.

B Only administrator users can modify or remove the partition. For the user without
L Note L . o . o
administrative privileges, the operation buttons remain disabled.
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Physical Partition

-0 %]
Connection  Wizards Exitended Service Help
rLibrar\; rCUnﬂguratiun rEvents |/Senrice |
angical |/F'h\,rsical rugers |/Clients rSCSITarget |
Select component FProperies
@ camputer || Fropetty | Yalle @
@ [ ADIC Scalar 100 # Marme Partition3 =
RD‘_:'DH _ Element Class ImportExport =]
AL Gl Gl Elerment Type Genetic DLT VE
B storage Slots -
E3 MailBoxes # Start LIB1_1018 Generic DLT IE
& Drives # End LIB1_1039 Generic DLT IE
Allocation Rohbotl
Ranges
Start End Partition
1011 Partition2
1039 Partition3
@ [Im ADIC Scalar 10K
@ [Ip ADIC Scalar 10K *)
D ?
15:54 Updating for partition Parition3. Please wait... =
19:54 Undating far parition Parition3 campleted.
15:54 Updating for partition Parition3. Please wait... [
19:54 Updating far parition Padition3 campleted. =
Field/Button Icon Operation Description
Name & Enter Partition name. Should be unique throughout all physical
libraries.
Also refer to Table 6 on page 16.
Element = Supplied Partition class (storage, I/E, drive). See Table 13 on page 65.
class
Element type & Supplied Partition element type. Refer to Storage Types on page 247,
Mailbox Types on page 248, or Drive Types on page 249.
Start & Supplied Start element of partition range.
End & Supplied End element of partition range.
Allocation & Supplied Robot1 /| Robot2 indicates the robotic device where the
partition is located.
Shared means the partition is shared between two robots.
Ranges Supplied The element ranges of selected class and type inside the
current physical library.
The ranges already occupied with the partitions are shown in
gray, and the partition name is indicated. The ranges that are
free for the new partition are shown in black.
Update ﬁ- Click Save partition properties after edit.
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Field/Button Icon Operation Description

Remove EE Click Remove the partition.
Help 2 Click Open online help for the current pane.
+
@ Note The shared partitions are always based on tower storages. Non-shared storage partition

may be based either on tower, or on linear shelve.

Offline Cartridge

If the cartridge is not found in the library after the Inventory has been executed, its state changes to offline.
After that, the cartridge is removed from the Cartridge list of the Logical library and goes to the archive list,
or the list of offline cartridges. It is displayed on the Physical tab and contains the information about
cartridges that were removed from the physical library.

The offline cartridge typically contains a short description (for example, when and why it has been removed).
The user can physically remove the offline cartridge if this cartridge should not be returned to the system.

The offline cartridges could either save their home position (if they were removed from the library in either
stored, ejected, or mounted state), or lose it (if they were removed in problem box or unloaded state). If the
offline cartridge resided in the home position right before it was removed, this coordinate is saved. If the
cartridge later returns to the library, the executed Inventory restores its old home position. However, when
the cartridge is offline, another cartridge may occupy its old home slot because it is not marked as the home
position of a valid cartridge. Should that be the case, the user can either move that cartridge to another
storage slot to free the home position of the offline cartridge that he wants to return to the library later, or he
can simply return the cartridge to the library. If the user prefers the last, an Inventory assigns a new valid
home position to a cartridge.

In the Select Components area of the pane, selectable Offline Cartridges is displayed. Clicking the expand/
collapse button results in an element expansion.
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Figure 89 Offline Cartridges

& Scalar DLC =l B
Connection  Wizards Exitended Service Help
rLihrawrCDnﬂguratinn rEvents rSENiCE |
[Logical | Physical [ Users [ Clients [ 5051 Target |
Select component Offline Cartriges
(] computer Yolzer | Haorme poasition | Qccupied by =
9 [Ip ADIC Scalar 10 O 0000328 |LSCI: LWi1020502 SCEI: 2029
© 3§l Offline Cartri O 000058 |LSCI: LWi1020602 SCEI: 2020 @
E SUER 1ol 07 000028  |LSCI: LW01040604 SCS1: 2080
5 gi:g:}{ea [ 000043  |LSCI: LW01041204 SCSI: 2086
Sy Partitiont (G O 000018 |LSCI: LW02082402 SCEI: 2108
SN Partition2 (G P 000008 |LSCI: Lw02080103 SCEI: 2200 00066
‘A Partiion3 (G
‘2l Partitiond (G
A Partiions (G
2l Partitionk (G
‘2 Pattiion? (G
‘2l Partitions (G
"2 Partitiond (G4,
= 7
e [ »] H
148:48 Inventary for likrary Librarn completed. Found 61 cartridges. =
16:03 admin connected to computer
16:08 Initializing elerment status for Partition Partition. .. [
1608 Inventory completed successiully. -
Field/Button Icon Operation Description
Volser 1 Supplied Data cartridge offline, home position is free.
& Cleaning cartridge offline, home position is free.
EF[::: Data cartridge offline, home position is occupied.
EP Cleaning cartridge offline, home position is occupied.
Home position Supplied An offline cartridge home position, in both LSCI and SCSI
format. Refer to Element Addressing on page 244.
Occupied by Supplied A cartridge that occupies offline cartridge home slot, if any.
Remove m Click Remove selected offline cartridge(s) from the archive.
Refresh ':D Click Force refresh the offline cartridges and apply changes in case
of any difference. The offline cartridges list itself is not
refreshed.
Help =2 Click Open online help for the current pane.

#

To remove a cartridge from the archive list of the offline cartridges, select it and press Remove button.
Multiple cartridges can be selected by the <Ctr1>+Click, too, and removed the same way.
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Selecting a single cartridge opens Offline Cartridge pane with its properties.

Figure 90 Offline Cartridge
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Comment

148:48 Inventary for likrary Librarn completed. Found 61 cartridges.
16:03 admin connected to computer

16:08 Initializing elerment status for Partition Partition. ..

1608 Inventory completed successiully. -

Field/Button Icon

Volser 5

Home
position

Offlined at

&
Occupied by &
&

Comment

Remove i

Update ﬁ-
@

Refresh

Help =2

Operation Description

Supplied Offline cartridge name.

Supplied An offline cartridge home position, both SCSI and LSCI format.
Refer to Element Addressing on page 244.

Supplied A cartridge that occupies offline cartridge home slot, if any.

Supplied The date (mm/dd/yyyy) when the cartridge has gone to offline.

Enter The comment about the situation with the cartridge (for
example, the reason why it is offline).

Click Removes an offline cartridge from the archive.

Click Save offline cartridge properties after edit.

Click Force refresh the offline cartridges and apply changes in the
event of any difference. The offline cartridges list itself is not
refreshed.

Click Open online help for the current pane.
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Storage Slots

In the Select Components area of the pane, selectable Storage Slots are displayed.

Figure 91 Physical Storage Slots

Connection  Wizards
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Field/Button

Name

Media Type

Current volser

Refresh

Help
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Icon Operation

Supplied

Supplied
Supplied

(D Click

2 Click

Description

The slot name. The icon also shows the slot state. See Table
14 on page 65.

The slot type. Refer to Storage Types on page 247.

If the slot is occupied, a contained cartridge is shown. For the
optical disk, two cartridges are shown.

Force refresh the cartridge list and apply changes in case of
any difference.

Open online help for the current pane.
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Mailboxes

In the Select Components area of the pane, selectable Mailboxes is displayed.

Figure 92 Physical Mailboxes
-0 x|
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e

Field/Button Icon Operation Description

Name Supplied The slot name. The icon also shows the slot state. See Table
15 on page 66.

Media Type Supplied The slot type. Refer to Mailbox Types on page 248.
Current volser Supplied If the slot is occupied, the contained cartridge is shown. For
the optical disk, two cartridges are shown.
Refresh (D Click Force refresh the cartridge list and apply changes in the event
of any difference.
Help =2 Click Open online help for the current pane.
+
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Drives

In the Select Components area of the pane, selectable Drives appear.

Figure 93 Physical Drives
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Field/Button

Name

Media Type

Current volser

Refresh

Help
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Icon

Supplied

Supplied
Supplied

(D Click

Click

Operation

Description

The slot name. The icon also shows the slot state. See Table
16 on page 67.

The slot type. Refer to Drive Types on page 249.

If the slot is occupied, the contained cartridge is shown. For
the optical disk, two cartridges are shown, active side first.

Force refresh the cartridge list and apply changes in the event
of any difference.

Open online help for the current pane.
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Create Partition

Under the Library properties, the Add new Partition button appears. Click it to open a pop-up partition

creation pane.

@ Note Only administrator users can create the partitions. For the user without administrative
privileges, the Add new Partition button is disabled.

Figure 94 Partition Creation

Field/Button

Name

Element class

Element type

Start
End

Allocation

Ranges

Create
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Icon

&

En

&Ereate new Partition il
Properies
Froperty Walue ||=/
# Mame Partitiond
# Elerment Class Drrive X
# Element Type Quuantum DLT 4000
# Start LIB1_100 Quantum DLT 4.
# End LIB1_100 Quantum DLT 4.
& Allocation Robot1
Ranges
Start End Partition
100 1100
?
Operation Description
Enter Partition name. Should be unique throughout all
physical libraries.
Also refer to Table 6 on page 16.
Supplied Partition class (storage, I/E, drive). See Table 13 on
page 65.
Supplied Partition element type.Refer to Storage Types on page
247, Mailbox Types on page 248, or Drive Types on
page 249.
Supplied Start element of partition range.
Supplied End element of partition range.
Supplied Robot1 | Robot2 indicates the robotic device where
the partition is located.
Shared means the partition is shared between two
robots.
Supplied The element ranges of selected class and type inside
the current physical library.
The ranges already containing the partitions are
shown in gray, and the partition name is indicated. The
ranges that are free for the new partition are shown in
black.
Click Create partition.
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Field/Button Icon Operation Description

Cancel x Click Cancel creation.
Help 2 Click Open online help for the current pane.
+
\@ Note Using the default partition name is recommended but not required.
Users Tab

The user is the person who has the rights to log on the Scalar DLC Management GUI.

All users have access to the Users Tab. Users that are known to the Scalar DLC software are indicated by
different icons.

Name Icon Description
Logged user ﬁ A user is currently logged into the system
Not logged user .ﬁ. A user is not logged into the system.

The user access lever is described in Table 20.

Table 20 User Access Level

Access Level Explanation
Admin Administrator of Management GUI is authorized to create/manage
configuration and execute all service operations. Refer to Table 21 on page
129.
CE Customer Engineer is authorized ot manage customer requests (tickets) and
execute basic operations. Refer to Table 21 on page 129.
User Typical user with changeable rights. Refer to Table 21 on page 129.

Depending on the access level, the user may have additional rights to manage the Scalar DLC via the
Management GUI and execute some Scalar DLC operations. The user access level cannot be changed,
however the administrator can grant the user additional rights beyond those of a typical user. Refer to Table
21 on page 129 for the details.
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Table 21 User Rights
User Access Level
Privilege Description
Admin User CE

Change Manage Logical library, Pools, Yes No No
configuration Mailboxes, Cartridges

Scan SCSI bus; stop/start robotic

controller; manage the partitions of

Physical library

Manage barcode reader and

command execution

Manage Media rules

Manage Users and user rights

Manage Clients, reserve slots and

cartridges, define drives and

cartridges

Manage SCSI Targets and LUNs

Manage command queue

Manage Cluster settings

Manage SNMP settings
Logical Inventory Yes Yes/No Yes/No
library
manipulation
Standard Mount Yes Yes/No Yes/No
move Dismount
commands Import

Export

Drag&drop
Expert move Move Yes No/Yes Yes/No
commands Execute logical library diagnostic

tests
Rules Create rule Yes No/Yes No
manipulation Remove rule

Update rule
Logs Save log to file Yes No/Yes Yes/No
manipulation Send log via email
Physical Execute service diagnostic for the Yes No/Yes Yes/No
library robotic accessor
diagnostic
Acknowledge Acknowledge the notification sent Yes Yes/No No/Yes
notification via Management GUI
Ticket Update problem report No/Yes No Yes
manipulation Close problem report

Remove problem report
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The starting Users pane shows the properties of Scalar DLC host PC.

Figure 95 User Controller
& Scalar DLC = e

Connection Wizards Exiended Service Help

rLihrawrCDnﬂguratinn rEvents rSENiCE |
[Logical | Physical [ Users | Clients [ 5051 Target

Select component Properties
¢ = lcomputer Property Yalue |ﬁ
&L admin & CPU ldentifier Genuinelntel
i atac & CPUvendor ldentifier K86 Family 4 Model 4 Stepping 3
& CPU Speed (MHz) 200
& Total Physical Memory (k) F4948
& Free Physical Memory (k) 5312
& Total Virtual Memory (k3 2097024
& Free Yirual Memory (k) 1938780

16:24 Lagical library "Library1" has no DRIVES to match "3590E" media. =
16:24 Scalar DLC configuration was successfully created
16:24 Please wait for updating ...

16:24 Updating finished successfully =
Field/Button Icon Operation Description

CPU Identifier & Supplied The CPU identifier

CPU Vendor ID & Supplied The CPU vendor identifier

CPU Speed & Supplied The CPU speed

Total physical = Supplied The total physical memory size

memory

Free physical = Supplied The free physical memory size

memory

Total virtual memory & Supplied The total virtual memory size

Free virtual memory = Supplied The free virtual memory size

Add new User ﬁ Click Pop-up user creation window appears. Refer to Create

User on page 132.

Help Click Open online help for the current pane.

cod
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User

The Select Component area of the pane indicates a list of users. When the user is selected from the list, the
user is highlighted.

Figure 96 User
-0 x|
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& Logical Libraries manipulation [
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19:24 admin cannected to computer
Field/Button Icon Operation Description
Logon Name o Enter User logon name (changeable).
Access Level & Supplied User access level (refer to Table 20 on page 128).
Email Address o Enter User’s email when sending notifications.
SMTP Server Name o Enter SMTP server name.
SMTP Port Number & Enter SMTP port number.
From Address o Enter Email address appears in the email field from.
Change password o Check If the field is checked, the password and confirm fields
become editable. Otherwise, user’s password cannot
be changed.
Note that the user cannot change own password.
Password W Supplied User’s password must be entered here.
Confirm e Supplied User’s password must be confirmed here.
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Field/Button Icon Operation Description

User rights o Check The list of user rights as described in Table 21 on
page 129.
& Supplied
Update ﬁ Click Save user properties after edit.
Remove ﬁ Click Remove the user. The user cannot remove himself.
Help 2 Click Open online help for the current pane.
o
@ Note Even though the email server parameters are configured during the installation, the
value can be edited.
@ Note User access level is not changeable after it is created. The default CE atac cannot be

removed. The user cannot remove himself.

Create User

Under the Controller properties, the Add new User button appears. Clicking it opens a pop-up user creation
pane.

@ Note Only administrator users can create additional users. For the user without administrative
privileges, the Add new User button is disabled.

Figure 97 User Creation
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& Ticket manipulation (]
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Field/Button
Logon Name
Access Level
Email Address
SMTP Server Name
SMTP Port Number
From Address

Change password

Password
Confirm

User rights

Create
Cancel

Help

Roh R R R % R

el MOS @ W W W
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Operation

Enter
Select
Enter
Enter
Enter
Enter

Check

Supplied
Supplied
Check

Supplied

Click
Click

Click

Description
User logon name.
User access level (refer to Table 20 on page 128).
User’s email when sending notifications.
SMTP server name.
SMTP port number.
Email address appears in the email field from.
If the field is checked, the password and confirm fields

become editable. Otherwise, user’'s password cannot
be changed.

User’s password must be entered here.
User’s password must be confirmed here.

The list of user rights as described in Table 21 on
page 129.

Create user.
Cancel creation.

Open online help for the current pane.
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Clients Tab

Clients connect to the Scalar DLC software through various interfaces. This release of Scalar DLC software
supports application-based DAS, ROBAR, and SCSI clients. A host software application client connects
through the DAS or ROBAR interface, or SCSI.

The selected client area of the pane indicates a list of clients. When a client is selected from the list, the
client is highlighted.

Table below shows the icons that represent the Clients tab objects.

Name Icon Description
Client interface Iﬁ] A client interface (DAS, SCSI, and ROBAR).
Client (online) Iﬂ_ﬂ This icon indicates a client that is currently online.
Client (offline) i This icon indicates a client that is currently offline.
3{_

The three compatible client interfaces are:

+ DAS. Refer to DAS on page 135.
+ SCSI. Refer to SCSI on page 146.
*  ROBAR. Refer to ROBAR on page 156.

W Note DAS and SCSiI clients are considered online when a client-sent command is being
executed. ROBAR client is considered online when a TCP/IP connection with the client
host is established.
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DAS

The DAS Interface needs no pre-configuration.

Figure 98 DAS Interface Pane

& Scalar DLC -0l =]
Connection  Wizards Exiended Service  Help
fLihraw r Configuratian |/ Ewvents |/ Semice |
f Logical |/ Physical r Uszers |/ Clients |/ SCEl Target
Select component
o] computer ‘ |b+|
% (B DAS Clients
JB Clientt Jir]
B Client2
® (B 5CSI Clients ‘ B
gl
7
o s TuweE LT UL e ooy —
13:04 move carridge 000008 finished —
13:04 move carridge 000006
13:04 move carridge 000006 finished 2]
13:04 Diagnostic procedure terminated. -
Button Icon Operation Description
Add new Ef]+ Click Pop-up client creation window appears. Refer to Create DAS
Client Client on page 144.
Enable g Click Enable DAS Interface.
Disable —@ Click Disable DAS interface. All requests send by DAS Clients will
receive ‘interface is disabled’ error.
Help =2 Click Open online help for the current pane.
o

DAS Client

There are four sets of properties associated with the DAS Client:

» Properties. The basic client properties, statistics, and operational settings. Refer to Properties on
page 136.

« Drives. The list of drives that are reserved for the clients and that are defined for the selected client.
Refer to Drives on page 138.
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* Volsers. The list of volsers (cartridges) that are reserved and that are defined for the selected client.
Refer to Volsers on page 141.

» Aliasing. The media and drive aliasing properties for the selected client. Refer to Aliasing on page

143.
) Only administrator users can modify or remove clients. For the user without
£ Note L . o g )
administrative privileges, the operation buttons are disabled.
Properties

Figure 99 DAS Client Properties

=10l x|

Connection  Wizards Exiended Service  Help

fLibrar\;rCnnﬂguration |’E\rents |’Senrice |

angical |/F'h\,rsical rugers rCIients rSCSITarget |
Select component Property | Valug [
o] camputer & Mame Client2
¢ & DEQS Clients # Likrary Library2 (online}
= g::gzg # Client Host Name computer
9 & EESI Clients & Respond When Eject Area Full [¢]
x@ ScsiClientt # Dismount Before Mount [
- @ ROBAR Clients # Supervisor ]
## Check IE Area Mames [
& 2vnid Media ldentifier Contenti. ]
# Reguires Drive Allocation [
# Priority tedium
& Sequence [
# Waitinser before mount [
& Command pause [ =
—LPropenies LDrives L\mlsers LAIiasing | ?
LJESLIS I B | = P ) AL TUT OO atnmy .. o
15:37 Updating finished successfully. —
15:41 Scalar DLC configuration was successfully created
15:41 Please wait for updating .. :
15:41 Updating finished successiully. -
Field/Button Icon Operation Description
Name e Enter The client name. It must not duplicate an existing
client name.
Also refer to Table 6 on page 16.
Library o Select The client will operate with the selected logical library

and its resources.
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Field/Button

Client Host Name

Respond When Eject
Area Full

Dismount Before
Mount

Supervisor

Check I/E Area
Names

Avoid Media Identifier
Contention

Requires Drive
Allocation

Priority

Sequence

Wait insert before
mount

Command pause

Drive pause
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Icon

F

&

%

L S

Operation

Enter

Check

Do not check

Do not check

Do not check

Check

Do not check

Select

Do not check

Do not check

Do not check

Do not check

Description

The host name of the computer running the client
software. ADIC recommends using the following:

¢ client host |IP address
¢ client host DNS name, short
« client host DNS name, full

* localhost for the client operating from local host
(possible but not recommended because of security
reasons)

+ any for the client operating from any host (possible
but not recommended because of security reasons)

Scalar DLC software returns an error (Area Full) if the
client tries to eject a cartridge into an eject area with
no free slots.

Scalar DLC software does not execute a dismount
when a client tries to mount a cartridge into an
occupied drive.

A client without the supervisor rights is not authorized
to use drives and/or cartridges that are reserved by
another client.

The I/E (mailbox) area names that can be used by the
client are not limited with the DAS naming standard.

Cartridge media identifiers are shown only as a result
of executing a cartridge information operation.

A client does not need to reserve the drive before
executing a mount or dismount.

Low means the client-sent commands have the lowest
priority in a queue. Refer to Queue Tab on page 174.

Medium means the client-sent commands have the
standard priority in a queue. Refer to Queue Tab on
page 174.

High means the client-sent commands have the
highest priority in a queue. Refer to Queue Tab on
page 174.

A commands sent by client without sequence option
will be executed as they’re ready. The system will not
wait until the previous client command is finished.

A client without wait insert option cannot wait until the
ejected cartridge will be inserted for the mount could
be executed.

A client without command pause rights is not
authorized to execute “pausedas“ DAS command.

A client without drive pause rights is not authorized to
execute “pausedrive“ DAS command.
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Field/Button Icon

Number of reserved
storages

Number of reserved
I/E slots

Number of reserved
drives

Remove

&
5
5
Update Vs
[

Help
¢

Operation

Supplied

Supplied

Supplied

Click
Click

Click

Description

The total number of storage slots reserved by the
client.

The total number of mailbox (I/E) slots reserved by the
client.

The total number of drives reserved by the client.

Save client properties after edit.
Remove the client.

Open online help for the current pane.

@ Note If a firewall exists between the client host and the Scalar DLC, the DAS/ACI firewall PC
should be specified under the client host name. Refer to Scalar DLC Installation Guide,
Installing DAS Client section.

Drives

The Drives pane shows the list of all drives in the library, defines what drives are defined to the current client,
shows the drives reserved by the client, and allows the status to be changed.

Figure 100 DAS Client Drives

Connection Wizards Esxtended Service  Help

|/Librar\,r |/ Configuration r Events r Service |

=10l ]

(Lngical rthsicaI rUsers r Clients rSCSITarget |

Select camponent

@ computer
@ & DAS Clients
B clientt
@ & SCSl Clients
& @ ROBAR Clients

Resening =
Ditive | Media type | Client |
= PIDRZ56 Sany S0 3105500 Client1 j"‘
= PIDRZa7 Sany S0 3100500 j
= PIDRZ54 Sony S0 310500 *
Tt
4
Ciefining R
Ditive | Media type | Client |
= PIDRZ47 Sany S0 3105500 Client1
Properties Drives LVDIsers LAIiasing ?'

16:06 admin connected to computer
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Field/Button

Reserving

Defining

Unreserve All

Up

Down

Force Up

Force Down

Define

Help

T4 Note

Icon Operation

Supplied
Select

Select

Select
Supplied
Select

Select

Select

Click

‘j‘f Click
j+ Click
j"’ Click

‘j* Click

g Click
Click
Kt

Description

The drive reserving list.

Drive The drive name.

Media Type The drive type. Refer to Drive Types on page
249.

Client The drive owner, if any.

The drive defining list.

Drive The drive name.

Media Type The drive type. The drive type. Refer to Drive
Types on page 249.

Client The drive owner.

Unreserve all slots currently reserved for the client (storage,
I/E, and drives).

Reserve the selected drive for the client, the drive should be
empty. Has the same effect as the DAS command “allocd
drive UP”. Refer to DAS Administration Guide.

Unreserve the selected drive for the client, the drive should be
empty. Has the same effect as the DAS command “allocd
drive DOWN?’. Refer to DAS Administration Guide.

Reserve the selected drive for the client. Has the same effect
as the DAS command “allocd drive FUP”. Refer to DAS
Administration Guide.

Unreserve the selected drive for the client. Has the same
effect as the DAS command “allocd drive FDOWN”. Refer to
DAS Administration Guide.

Open pop-up Define Drives pane. See Figure 101 on page
140.

Open online help for the current pane.

The client may access only the reserved drives if there is Requires Drive Allocation
property checked (refer to Properties on page 136); if this property is not checked, the
client does not need reserving the drive(s).

Reserving drive(s) however guaranties that no other client will access the reserved drive,
especially when the reservation is exclusive (refer to Drive on page 104).
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Define Drives

The drives defined by the client may represent only the drives that are currently installed and successfully
recognized by the library.

The client with no drives defined (empty list) may access all drives in the
/1\ CAUTION |ogical library. The client with drives defined may access only the defined
drives.

Figure 101 Define Drives

Eﬁneﬁne;"UnDeﬁne drives il
Undefined Defined
Mame | Wedia Type ! Marme | Media Type
= P3DR256 |5onySDX310/500 - =1 P30R257 |SonyE0%31 0500
= P30R2549 | SonySD310/400 o

%]

With the arrow buttons define the required drive(s) for the current client. Press OK when finish. Press
Cancel to exit without changing the drive defining settings.
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Volsers

The Volsers pane describes the volser ranges reservation and definition list for the DAS clients authorized
to work with the library.

Figure 102 DAS Client Volsers

$ Scalar DLC IS[=] E3
Connection Wizards Esxtended Service  Help
(Lihrawroonﬂguratinn rEvents rSENiCE |
rLDgicaI rPhysical |/Users rCIients rSCSITarget
Select component . Resening i
: L
¢ = computer : Range | Client |
9 & DAS Clients : Tape04-Tapel2? Clientt &
I8 clientt :
% & 5CSI Clients e
I8 gesiclientt :
e & ROBAR Clients § 5
Defining
Range | Cliert
¢ Tapell Clientl
: Tapef3-TapeBd Client1
LPerenies LDrives L‘mlsers LAIiasing | K
16:09 admin connected to camputer
Field/Button Icon Operation Description
Reserving Supplied Reserving volser list.
Select Range The volser range. It can be either a
single volser or a range separated by
a hyphen.
Select Client An owner of the volser range.
Defining Supplied Defining volser list.
Select Range The volser range. It can be either a
single volser or a range separated by
a hyphen.
Select Client An owner of the volser range.
Add Reserved Range it Click Pop-up volser range reservation window appears. See
L+ Figure 103 on page 142.
Remove Reserved = Click Remove the selected volser range from the list of
1

Range reserved volsers.
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Field/Button Icon Operation Description

Add Defined Range Click Pop-up volser range definition window appears. See
L+ Figure 103 on page 142.
Remove Defined == Click Remove the selected volser range from the list of
Range 4 defined volsers
Help 2 Click Open online help for the current pane.
+

Reserve or Define Volsers

The volsers reserved or defined for the client may represent the cartridges that are currently not in the
library. However, if the cartridge appears in the library, it is marked automatically as ‘allocated’/reserved, or
‘defined’, and can be accessed and managed only by its owner. The ownership can be changed either by
the client himself or by the Scalar DLC Management GUI administrator.

‘Qﬁ Note The client may access all cartridges in the logical library and does not need to reserve
volsers before using media.

Reserving volser(s) however guaranties that no other client will access the reserved
media, especially when the reservation is exclusive (refer to Cartridge on page 94).

Figure 103 Reserve/Define Volser Range
& 2dd new Volsers Range

Elements Range:

| | |
][ x]

Enter the start and end volser in the range. Press OK to reserve/define them for the current client. Press
Cancel to exit without adding volsers to the range of reserved or defined volsers.

@ Note The client cannot reserve or define only half of an optical disk. Only the whole disk can
be reserved/defined. Even if the volser reservation or definition table contains only one
volser for the one side, the other is also reserved/defined for the client. This is shown
under Cartridge properties (refer to Cartridge on page 94).

_ The client with no volsers defined (empty list) may access all cartridges in the
41 CAUTION  ogical library. The client whose volser defining list is not empty may access
only the defined cartridges.
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Aliasing

The DAS Client Aliasing feature is required for certain DAS interface-based applications that use the media
type and element type that differs from default Scalar-based types.

@ Note DAS Client aliasing takes effect only on the data output in DAS interface, and only on
the client that has executed this aliasing.

Figure 104 DAS Client Aliasing
& Scalar DLC =l B

Connection  Wizards Extended Service  Help

rLihrawrCDnﬂguratinn rEvents rSENiCE |

rLogicaI rPhysicaI |/Users rCIients rE:CEiiTafSi“t |
Select component

Element type aliasing

? E computer e | Dotault | aiis @
v @ D[QS Clients IBM 3580 IBM Magstar (3590) | 1BM Maastar (3...
& SI:EQE NCTP Philips LMS (3430) | Philips LMS (3...
;E Clientl Philips 361 0ADIC 8. |Philips LMS {3490} | Philips LMS (3.
(o] @J SCS| Clients Quantum DLT 4000 |DLT drive {low profile) | DILT drive {lowe ...
1

& B ROBAR Clients
Media type aliasing

Media Default | Alias
3480 3480 | 3480
3490E 3480 | 3480
3580 3580 | 3590
3590E 3590 | 3590
|
LPrUper‘[ies LDri\tes LVDIsers LAIiasing | ?
13:32 admin connected to computer =~
13:33 Pleasewait. Scanning .. ==
1340 Scanning finished successiully
13:41 Scalar OLC configuration was successfully created for ADIC Scalar 10K #11111 =
Field/Button Icon Operation Description
Element type aliasing  Supplied Assign the alias to the drive accessible by the client.
Drive Supplied The drive type in the library accessible by the client.
Default Supplied The drive type as in the Scalar DLC-DAS specification. Refer

to Drive Types on page 249 and also to the DAS
Administration Guide.

Old models of drives are seldom used in modern tape libraries,
but still supported by some backup applications.

Alias Select The same drive type that is in the client specification.
Media type aliasing Supplied Assigns the alias to the media accessible by the client.
Media Supplied The media type in the library accessible by the client.
Default Supplied The same media type that is in the Scalar DLC-DAS

specification. Refer to Media Types on page 246.

Scalar DLC Reference Guide 143



Field/Button Icon Operation Description

Alias Select The media type as in the client specification.
Update ﬁ Click Save client properties after edit.

Help e Click Open online help for the current pane.

L

Create DAS Client

Under the DAS Interface properties, the Add new Client button appears. Clicking it opens a pop-up client

creation pane.

@ Note Only administrator users can create additional clients. For the user without

administrative privileges, the Add new Client button is disabled.

Itis recommended that the default name be accepted, but it is not required. Be sure that the name specified
manually does not duplicate an existing client name.

Figure 105 DAS Client Creation

Field/Button

Name

Library

144

£ add new DAS Client i x|
Property | Yalue

& Mame Clienta 7

& Librany Libraryl {anling)

& ClientHost Mame any X

# Respond When Eject A [v]

# Dismount Before Mount [

& Supervisor [

& Check VE Area Mames [

# fvoid Media dentifier ... [v]

# Fequires Drive Allocation] ]

& Priority Medidm

& Seguence [v]

 Wiaitinsert before mount [

& Command pause [

& Drive pause ]

[ Properties | ¥aleer recenation | 7

Icon Operation Description
e Enter The client name. It must not duplicate an existing

client name.

Also refer to Table 6 on page 16.

o Select The client will operate with the selected logical library

and its resources.
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Field/Button

Client Host Name

Respond When Eject
Area Full

Dismount Before
Mount

Supervisor

Check I/E Area
Names

Avoid Media Identifier
Contention

Requires Drive
Allocation

Priority

Sequence

Wait insert before
mount

Command pause

Drive pause
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Icon

F

&

%

L S

Operation

Enter

Check

Do not check

Do not check

Do not check

Check

Do not check

Select

Do not check

Do not check

Do not check

Do not check

Description

The host name of the computer running the client
software. ADIC recommends using the following:

¢ client host |IP address
¢ client host DNS name, short
« client host DNS name, full

* localhost for the client operating from local host
(possible but not recommended because of security
reasons)

+ any for the client operating from any host (possible
but not recommended because of security reasons)

Scalar DLC software returns an error (Area Full) if the
client tries to eject a cartridge into an eject area with
no free slots.

Scalar DLC software does not execute a dismount
when a client tries to mount a cartridge into an
occupied drive.

A client without the supervisor rights is not authorized
to use drives and/or cartridges that are reserved by
another client.

The I/E (mailbox) area names that can be used by the
client are not limited with the DAS naming standard.

Cartridge media identifiers are shown only as a result
of executing a cartridge information operation.

A client does not need to reserve the drive before
executing a mount or dismount.

Low means the client-sent commands have the lowest
priority in a queue. Refer to Queue Tab on page 174.

Medium means the client-sent commands have the
standard priority in a queue. Refer to Queue Tab on
page 174.

High means the client-sent commands have the
highest priority in a queue. Refer to Queue Tab on
page 174.

A commands sent by client without sequence option
will be executed as they’re ready. The system will not
wait until the previous client command is finished.

A client without wait insert option cannot wait until the
ejected cartridge will be inserted for the mount could
be executed.

A client without command pause rights is not
authorized to execute “pausedas“ DAS command.

A client without drive pause rights is not authorized to
execute “pausedrive“ DAS command.
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Field/Button Icon Operation Description

Create ;'” Click Create client.
Cancel x Click Cancel creation.
Help =2 Click Open online help for the current pane.
Ll
@ Note If a firewall exists between the client host and the Scalar DLC, under the client host

name, specify the DAS/ACI firewall PC name. Refer to Scalar DLC Installation Guide,
Installing DAS Client section.

% Note The new DAS Client is functional immediately after creation. No Scalar DLC service
restart is required.

SCSI

All the operations with the SCSI Clients are enabled only after the configuration of SCSI Target software.
That can be done via the SCSI Target tab. Refer to SCSI Target Tab on page 162.

Figure 106 SCSI Pane

4. Scalar DLC

=10l x|

Connection  Wizards Edended Service  Help

fLibraw r Configuration |/ Events |/ Service |

f Laogical |/ Phiysical r Lsers |/ Clients |/ S8l Target
Select component

o] computar
9 (B DAS Clients
s Client!
B Clientz
9 (& SCS| Clients

JB SesiClientt
o i

il A K24

P s THUWE L AT L e oG
13:04 mowe cafridge 000008 finished
13:04 mowe cafridge 000006
13:04 mowe cafridge 000006 finished
13:04 Diagnostic procedure terminated. -

[ »
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Button Icon Operation Description

Add new Ef]+ Click Pop-up client creation window appears. Refer to Create SCSI
Client Client on page 155.

Enable e Click Enable SCSI Interface.

Disable _@ Click Disable SCSI interface.

The following commands are serviced in the regular way then:

* Inquiry for the Standard Inquiry Data page
¢ Request Sense
* Report LUNs (SCSI-3 mode)

All other commands and the Inquiry command for other pages
are rejected with the CHECK CONDITION SCSI status, and
02/04/00 “Not ready due to unknown cause” SCSI sense data.

Help ] Click Open online help for the current pane.

#

SCSI Client

There are five sets of properties associated with the SCSI Client.
* Properties. Main client properties. Refer to Properties on page 148.
*  Mode. SCSI mode parameters. Refer to Mode on page 150.

» Drives. The library drives as they are seen from the client side. Refer to Drives on page 152.

* |I/E slots. The library I/E slots as they are seen from the client side. Refer to |/E Slots on page 153.

+ Storages. The library storages as they are seen from the client side. Refer to Storages on page 154.

B Only administrator users can modify or remove clients. For the user without
£ Note e . .
administrative privileges, the operation buttons are disabled.
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Properties

Figure 107 SCSI Client Properties

B ] [
Connection  Wizards Exiended Service  Help
fLihraw r Configuratian |/ Ewvents |/ Semice |
f Logical |/ Physical r Uszers |/ Clients |/ SCEl Target |
Select component Froperty | value B
§ = computer # Name SesiClientd
©- (& DAS Clients # Library Liarary! (anling) 4
v ® Sge'slci'i'gﬂt;nﬂ @ Port ADIC Local SCSI Target Part 0 o]
el
B gesiclientz & Target Taryetds
M5 Scsiclient3 & LUN LUINA
- &2 SesiClients # Priotity Wedium
B ROBAR Clients # Sequence T No
& Mumber of reserved Storage a
& Mumhber of reserved IVE Slots 0
&= Numbernfresewed Drives 0
LPrnper‘cies Lh.ﬂnde LDri\res LIEslots LStorage ?
13:32 admin connected to computer
18:33 Initializing element status for library Likiraryl
18:33 Inventary for library Library? completed.
The SCSI Client Properties pane indicates the main client properties.
Field/Button Icon Operation Description
Name o Enter The client name.
Also refer to Table 6 on page 16.
Library & Select The client operates with the selected logical library.
Port & Supplied The client is connected to the SCSI bus via the
selected port.
Target = Supplied The client is assigned to the selected target.
LUN & Supplied The client is assigned to the selected LUN on the
target.
Priority & Select Low means the client-sent commands have the lowest
priority in a queue. Refer to Queue Tab on page 174.
Medium means the client-sent commands have the
standard priority in a queue. Refer to Queue Tab on
page 174.
High means the client-sent commands have the
highest priority in a queue. Refer to Queue Tab on
page 174.
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Field/Button Icon

Sequence 4

Operation

Do not check

Description

A commands sent by client without sequence option
will be executed as they are ready. The system will not
wait until the previous client command is finished.

Number of reserved & Supplied The number of storage slots reserved by the client.
storages
Number of reserved & Supplied The number of mailbox (I/E) slots reserved by the
I/E slots client.
Number of reserved = Supplied The number of drives reserved by the client.
drives
Unreserve All E=p Click De-allocates all slots currently reserved by the client
(storage, I/E, and drives).
Update 5@ Click Save client properties after edit.
Remove Ef;l- Click Remove the client.
Help e Click Open online help for the current pane.
o

_ The SCSI Client connection parameters (port-target-LUN) cannot be modified.

41y CAUTION t s only possible to remove the client, or change its name and the assigned

library.

‘Qﬁ Note Because of interface properties, only one SCSI Client can be assigned to the single LUN
of the specified SCSI Target.

_ After the client is assigned to the LUN 0 of any target, all other clients
41y CAUTION  assigned to the non-zero LUNs of this target are activated.
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Mode

Figure 108 SCSI Client Mode

4. Sealar DLC

Connection  Wizards Edended Service  Help

=10l x|

fLibraw r Configuration |/ Events |/ Service |

fLogicaI |/F'hysica| rUsers |/ Clients rSCSITarget |

Select component Froperty | walug
? computar # Parity checking enabled [
¢ & D[*QS Clients # Maxirmurm parity retries 1
’E Cl!enﬂ & Storage address 4096
w2 Client2
@ @ 505 Clients # Import export address 16
JB SesiClientt # Drive address 256
o [ # Accessoraddress 1 i
# Mixed media enabled O ||
# Edend RES [
# Vendor ASCGQ [
# Volser extension enabled [
B Post-fix media 1D
# Extended meadia D [
# Auta cleaning enakled [ -l
L Properties LMUde L Drives LlESlDtS L Storage 7
P s THUWE L AT L e oG —
13:04 mowe cafridge 000008 finished —
13:04 mowe cafridge 000006
13:04 mowe cafridge 000006 finished :
13:04 Diagnostic procedure terminated. -

The SCSI Client Mode pane indicates the SCSI mode parameters.

@ Note The details about SCSI Client Mode Parameters can be found in the Scalar 10K
Operator Guide and the Scalar 1000 Operator Guide (Mode Sense (1Ah) Response).

Field/Button Icon
Parity checking &
enabled
Maximum parity o
retries

Storage address

Import/export
address

Drive address
Accessor address

Mixed media enabled

o % % R

150

Operation Description

Do not check  Whether the parity checking enabled

Enter The maximum number of times to retry the message
out, command out, or data out phase after a parity
error.

Enter First storage address (0O=default).

Enter First mailbox address (0O=default).

Enter First drive address (O=default).

Enter Accessor address (O=default).

Do not check  Manage whether the library operates in mixed media
mode or not.
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Field/Button

Extended res

Vendor Ascq

Volser extension
enabled

Post-fix media ID

Auto cleaning
enabled

Delayed cleaning
enabled

Cleaning hour
Cleaning minute
Auto teach enabled

Auto inventory
enabled

Operation mode

LCD security valid
LCD security enabled
LCD write line1

LCD write line2

LCD write line3

LCD write line4

LCD display line1
LCD display line2
LCD display line3

Update

Help
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Icon

% %

W oR R R R R R % R % R % % R O% % % K

Operation

Do not check

Do not check

Do not check

Supplied

Do not check

Do not check

Enter
Enter
Do not check

Do not check

Enter
Do not check
Do not check
Do not check
Do not check
Do not check
Do not check
Enter
Enter
Enter

Click

Click

Description

Manage whether the Read Element Status and
Request Volume Element Address commands
return extended element status information.

The ASC/ASCAQ returned if a Move Media command
is issued to an incompatible location.

The Volser extension identification for Read Element
Status and Request Volume Element Address
commands.

The media ID pre-pend or post-pend. Selectable for
the enabled Volser Extension.

Whether the auto-cleaning is enabled.

Whether the delayed cleaning is enabled.

Cleaning schedule, hour.
Cleaning schedule, minute.
Whether the auto-teach is enabled.

Whether the auto-inventory is enabled.

Operation mode parameter.

Whether the LCD security is valid.
Whether the LCD security is enabled.
LCD write line1.

LCD write line2

LCD write line3

LCD write line4

LCD display line1

LCD display line2

LCD display line3

Save client properties after edit.

Open online help for the current pane.
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Drives

Figure 109 SCSI Client Drives

= Scalar DLC
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19:01 admin connected to computer

The SCSI Client Drives pane indicates the Drives coordinates as the SCSI client will see them.

Field/Button Icon

Target
Element
Physical
Robot1

Robot2

Help

Operation Description

Supplied The element coordinate as seen to the client.
Supplied The element, as shown in the Management GUI.
Supplied The element physical coordinate.
Supplied The Robot1 element coordinate.

-1 means the element does not belong to Robot1.
Supplied The Robot2 element coordinate.

-1 means the element does not belong to Robot2.
Click Open online help for the current pane.

Refer also to Drive on page 104.
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I/E Slots

Figure 110 SCSI Client I/E Slots

The SCSI Client I/E slots pane indicates the I/E slots coordinates as the SCSI client will see them.

= Scalar DLC

Connection  Wizards Exiended Service  Help

fLihraw r Configuratian |/ Ewvents |/ Semice |

fLDgicaI |/F'h5tsical rUsers |/ Clients rSCSITarget |

Select component

o] computer
@ (& DAS Clients
@ & SCEI Clients
B gesiClientt
o & ROBAR Clients

Target | Element | FPhysical | Robotl | Robotz |
16 =a P2 |[E16 |16 16 -1
17 =a P2 _|[E17 [17 17 -1
18 =a P2 |[E18 (18 18 -1
19 caP2 |[E19 [19 19 -1
20 =a P2 |E20 |20 20 -1
21 ca P2 IE21 |21 1 -1
22 caP2 |[E2Z |22 22 -1
23 =a P2 OJE2S |23 23 -1
24 caP2 |E24 (24 24 -1
258 caP2 |[E2S |25 248 -1
26 caP2 IE2E |26 26 -1
27 caP2_IE2TY |27 27 -1
28 =a P2 |[E2E |28 28 -1
29 caP2 |E29 (29 29 -1
LPrnperties Lh.ﬂnde LDri\res LIEslots LStorage ?

19:01 admin connected to computer

Field/Button Icon Operation

Target
Element
Physical
Robot1

Robot2

Help

Supplied
Supplied
Supplied
Supplied

Supplied

2 Click

Description

The element coordinate as seen to the client.
The element, as shown in the Management GUI.
The element physical coordinate.

The Robot1 element coordinate.
-1 means the element does not belong to Robot1.

The Robot2 element coordinate.
-1 means the element does not belong to Robot2.

Open online help for the current pane.

Refer also to Mailbox Slot on page 102.
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Storages

Figure 111 SCSI Client Storages

= Scalar DLC

Connection  Wizards  Exended Service

Help

fLihraw r Configuratian |/ Ewvents |/ Semice |

fLDgicaI |/F'h5tsical rUsers |/ Clients rSCSITarget |

Select component

@ = computer
@ (& DAS Clients
@ & SCEI Clients
B gesiClientt
o & ROBAR Clients

1
LPrnperties Lh.ﬂnde LDri\res LIEslots LStorage

Tatget | Element | Fhysical | Robotl | Robotz |
4096 = P1_S5T4.. 4096 4096 =
4097 = P1_S5T4... 4007 4097 -1
4098 = P1_5T4... 4008 4098 -1
40949 = P1_5T4... 4009 40949 -1
4100 = P1_S5T4.. 4100 4100 -1
4101 = P1_ST4.. 4101 4101 -1
4102 = P1_S5T4.. 4102 4102 -1
4103 = P1_S5T4.. 4103 4103 -1
4104 = P1_S5T4.. 4104 4104 -1
4104 = P1_S5T4.. 4105 4104 -1
4106 = P1_S5T4...|4106 4106 -1
4107 = P1_S5T4.. 4107 4107 -1
4108 = P1_S5T4.. 4108 4108 -1
4109 = P1_S5T4.. 4109 4109 -1
4110 = P1_S5T4.. 4110 4110 -1
4111 = P1_ST4. (4111 4111 -1
A1147 — D1 T4 A1147 A147

19:01 admin connected to computer

The SCSI Client Storages pane indicates the storage slots coordinates as the SCSI client will see them.

Field/Button Icon

Target
Element
Physical
Robot1

Robot2

Help

Supplied
Supplied
Supplied
Supplied

Supplied

e Click

Operation

Refer also to Storage Slot on page 101.
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The element coordinate as seen to the client.

Description

The element, as shown in the Management GUI.

The element physical coordinate.

The Robot1 element coordinate.

-1 means the element does not belong to Robot1.

The Robot2 element coordinate.

-1 means the element does not belong to Robot2.

Open online help for the current pane.
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Create SCSI Client

Under the SCSI properties, the Add new Client button appears. Click it to open pop-up client creation pane.

@ Note Only administrator users can create clients. For the user without administrative
privileges, the Add new Client button is disabled.

Figure 112 SCSI Client Creation Properties

& Add new SC3I Client il
FProperty | Walue | o
# Marne ScsiClients %
& Library Libraryl (online)
# Port ADIC Local SCE1 Target Pa...
# Target | Targetes |
# LU LUMD
& Priority Medium
# Sequence [ Ma
LPrnpenies | Hoder | I ?
Field/Button Icon Operation Description
Name o Enter The client name.
Also refer to Table 6 on page 16.
Library o Select The client operates with the selected logical library.
Port e Select The client is connected to the SCSI bus via the selected port.
Target 4 Select The client is assigned to the selected target.
LUN o Select The client is assigned to the selected LUN.
Priority e Select Low means the client-sent commands have the lowest priority
in a queue. Refer to Queue Tab on page 174.
Medium means the client-sent commands have the standard
priority in a queue. Refer to Queue Tab on page 174.
High means the client-sent commands have the highest
priority in a queue. Refer to Queue Tab on page 174.
Sequence e Do not check A commands sent by client without sequence option will be
executed as they’re ready. The system will not wait until the
previous client command is finished.
Create vy Click Create client.
Cancel x Click Cancel creation.
Help =2 Click Open online help for the current pane.
+
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T4 Note

/1 CAUTION

restart is required.

The new SCSI Client is functional immediately after creation. No Scalar DLC service

— Because of interface properties, only one SCSI Client can be assigned to the single
4 Note LUN

After the client is assigned to the LUN 0 of any target, all other clients

ROBAR

Figure 11

3 ROBAR Interface Pane
£ Scalar DLC

Connection  Wizards  Exended Service

assigned to the non-zero LUNs of this target are activated.

M=l B3

Help

rLihrawrCDnﬂguratinn rEvents rSENiCE |

[Logical | Physical [ Users [ Clients [ 5051 Target |

Select component
? E computer

Property Walue |

@ (& SCEI Clients
@ & ROBAR Clients

& (& DAS Clients # Port 1313

[ 17:03 admin connected to camputer

Field/Button Icon Operation

Port

Update

Add new
Client

156

ﬁu Enter

f@ Click

Ef;l+ Click

Description

The port to establish the ROBAR client TCP/IP connection(s).
Note that the default value of 0 is not valid.

Save port properties after edit.

Pop-up client creation window appears. Refer to Create
ROBAR Client on page 160.
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Field/Button Icon Operation Description

Enable e Click Enable ROBAR Interface.
Disable _@ Click Disable ROBAR interface. All requests send by ROBAR
Clients will receive ‘interface disabled’ error.

Because of ROBAR interface properties, this is the same error

as “invalid client®, “server stopped®, etc.).

Help e Click Open online help for the current pane.

#

_ The ROBAR interface must be valid before the ROBAR client can be created
41y CAUTION either manually or by the configuration wizard (refer to Create Configuration
on page 32).

‘Qﬁ Note Changing the port number applies to all ROBAR clients. The Scalar DLC service restart
is required.

Scalar DLC Reference Guide 157



ROBAR Client

Figure 114 ROBAR Client Properties

=10l %]

Caonnection Wizards Extended Service  Help

admin con ed to computer

rLihrawrCnnﬂguratinn rEventS rBewice |

angicaI |/F'hﬁ;5i|:al rUsers rCIients rBCBITarget|

Select component Froperies
@ computer Property | Walue
&= @1 DAS Clients & e ALY
® & SCSI Clients & Library Library {online
B sesiclientt & Client Hostname localhost
@ [ ROBAR Clients # Hostalias H1
B a1 ClientH # Numeric systern Decirmal system
# Clean pool prefix F
# Dismount atter clean ¥l Yes
# Hostis allowed to setthe time [ Mo
# Motification sender name A
& Priority Medium
& Seguence [ ] Mo
& HCC Majar [ ] Mo

@ Mumber of resered Storages [0
& Murmher of recered IE Slnts Il

14:37 move cartridge 000007 =
14:37 move cartridge 000007 finished
14:38 mount cartridge 000011 ]
14:38 mount carridge 000011 finished -

B Only administrator users can modify or remove clients. For the user without
£ Note T o . .
administrative privileges, the operation buttons are disabled.

Field/Button Icon Operation Description

Name e Enter Client name. It must not duplicate an existing client
name.
Also refer to Table 6 on page 16.

Library o Select The client works with the selected logical library.
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Field/Button

Client Host Name

Host alias
Numeric system
Clean pool prefix

Dismount after clean

Host is allowed to set
the time

Notification sender
name

Priority

Sequence

HCC Major

Number of reserved
storages

Number of reserved
I/E slots

Number of reserved
drives

Unreserve All

Scalar DLC Reference Guide

Icon

F

LU Y T T S S

J 2 2 @

Operation

Enter

Enter
Select
Enter

Check

Do not check

Enter

Select

Do not check

Do not check

Supplied

Supplied

Supplied

Click

Description

The host name of the computer running the client
software. ADIC recommends using the following:

¢ client host |IP address
¢ client host DNS name, short
« client host DNS name, full

* localhost for the client operating from local host
(possible but not recommended because of security
reasons)

+ any for the client operating from any host (possible
but not recommended because of security reasons)

Host alias (ROBAR format).
Numeric system format (decimal/hexadecimal).
Clean pool prefix used by ROBAR client.

Indicates whether the cleaning cartridge should be
dismounted after the cleaning ends.

A client host should not be allowed to set the time.

Notification sender (ROBAR format).

Low means the client-sent commands have the lowest
priority in a queue. Refer to Queue Tab on page 174.

Medium means the client-sent commands have the
standard priority in a queue. Refer to Queue Tab on
page 174.

High means the client-sent commands have the
highest priority in a queue. Refer to Queue Tab on
page 174.

Commands sent by client without sequence option will
be executed as they are ready. The system will not
wait until the previous client command is finished.

Commands send by client without major host
parameter cannot be addressed/replied via the HCC/
MVS application.

The number of storage slots assigned to the client.
The number of mailbox (I/E) slots assigned to the
client.

The number of drives assigned to the client.

De-allocates all slots currently allocated for the client
(storage, I/E, and drives).
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Field/Button Icon Operation Description

Update ﬁ’ﬁ' Click Save client properties after edit.

Remove EfJ- Click Remove the client.

Help =2 Click Open online help for the current pane.
+

Create ROBAR Client

Under the ROBAR Interface properties, the Add new Client button appears. Clicking it opens a pop-up
client creation pane.

B Only the administrator users can create the clients. For the user without administrative
£ Note - ; e
privileges, the create client button is disabled.

It is recommended that the default name be accepted, but it is not required. Be sure that the name specified
manually does not duplicate an existing client name.

Figure 115 ROBAR Client Creation

£ ndd new ROBAR Client o x|
Properties
Fraoperty | Yalle ||=/
# Marne A1 CligntH1
& Library Libraryl {online) X
# Client Hostname localhost
# Hostalias H1
& Mumeric system Diecirmal system
& Clean pool prefix P
# Dismaount after clean ¥l ves
# Hostis allowed to set the time [ Mo
# Motification sender name Al
& Priority Medium
# Sequence [ Mo
# HCC Major 1 Mo K
Field/Button Icon Operation Description
Name 4 Enter The client name. It must not duplicate an existing
client name.
Also refer to Table 6 on page 16.
Library o Select The client works with the selected logical library.
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Field/Button

Client Host Name

Host alias
Numeric system
Clean pool prefix

Dismount after clean

Host is allowed to set
the time

Notification sender
name

Priority

Sequence

HCC Major

Create
Cancel

Help

T4 Note

Icon

F

LU Y T T S S

%

w XA
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Operation

Enter

Enter
Select
Enter

Check

Do not check

Enter

Select

Do not check

Do not check

Click

Click

Click

Description

The host name of the computer running the client
software. ADIC recommends using the following:

¢ client host |IP address
¢ client host DNS name, short
« client host DNS name, full

* localhost for the client operating from local host
(possible but not recommended because of security
reasons)

+ any for the client operating from any host (possible
but not recommended because of security reasons)

Host alias (ROBAR format).
Numeric system format (decimal/hexadecimal).
Clean pool prefix used by ROBAR client.

Indicates whether the cleaning cartridge should be
dismounted after the cleaning ends.

A client host should not be allowed to set the time.

Notification sender (ROBAR format).

Low means the client-sent commands have the lowest
priority in a queue. Refer to Queue Tab on page 174.

Medium means the client-sent commands have the
standard priority in a queue. Refer to Queue Tab on
page 174.

High means the client-sent commands have the
highest priority in a queue. Refer to Queue Tab on
page 174.

Commands sent by client without sequence option will
be executed as they're ready. The system will not wait
until the previous client command is finished.

Commands send by client without major host
parameter cannot be addressed/replied via the HCC/
MVS application.

Create client.
Cancel creation.

Open online help for the current pane.

The new ROBAR Client is functional immediately after creation. No Scalar DLC service
restart is required.
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SCSI Target Tab

The SCSI Target tab is designed for the configuration of the Target part of the SCSI interface.

‘Qﬂ Note This tab is accessible only if the Scalar DLC SCSI Client component is installed.

The SCSI Target is an intermediary between the logical library (configured by the Scalar DLC) and the
SCSI. This intermediary requires a configuration that is executed into two steps. First, the SCSI target must
be configured. Second, the Scalar DLC SCSI Client(s) must be created and assigned to the appropriate
logical libraries. The fist step is executed here. The second step is executed via the Clients tab. Refer to
SCSI Client on page 147.

The SCSI client (either a person or a software application) connects to the Scalar DLC via the LUN object
that is shown to it as a part of the Target on a SCSI bus. One LUN may contain one client (SCSI Client).
The Target always contains LUN 0 and may contain other LUNs; the number is limited by the SCSI HBA
properties. All initiators of the SCSI bus may use the LUN configured for that bus. The physical connection
is established via the host bus adapter (this hardware is called SCSI Adapter, the model of adapter does
not matter if it is supported by the Scalar DLC software). Table 1 on page 6 describes the target adapters
the Scalar DLC software currently supports.

The host bus adapter sends and receives commands via the channels called SCSI Ports. Depending on the
command stream direction, the ports are operating either in Initiator or Target mode (called Initiator ports or
Target ports). The Scalar DLC works with the Target ports only, the initiator mode is not used for the port
configured as Target. The configuration of the Target mode for the SCSI Ports is executed via the SCSI
Target Port Tool (refer to SCSI Target Port Tool on page 217).

The Targets and LUNs are created manually. After the LUN is created, a SCSI client can be added as an
intermediary between the logical library and the LUN object that represents an initiator of the SCSI bus (it
can be either a user or a software application).

Table below shows the icons that represents the SCSI Target tab objects.

Table 22  SCSI Target Icons

Name Icon Text Color Description
Available % Black Indicates a SCSI Port (available).
port The port is functional, and the connection with the initiators
can be established.
Not available @b Gray Indicates a SCSI Port (not available).
port The port will be functional after enabling, but the connection

with the initiators currently cannot be established. The new
targets cannot be added but all operations with the existing
targets are enabled.

Absent port Light-gray Indicates a SCSI Port (not present).
The port is not functional. The new targets cannot be added

but all operations with the existing targets are enabled.

iy

Active target Black Indicates a SCSI Target (active).
There is a client configured for this target at LUN 0. The SCSI

bus initiators may now work with the target.

a

Not active =e= | Gray Indicates a SCSI Target (not active).
target The target LUN 0 is ready to accept a SCSI client. The SCSI
bus initiators may not work with the target until it will be active.

=
=
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Table 22  SCSI Target Icons (Continued)
Name Icon Text Color Description
Active LUN <> Black Indicates a LUN (active).
The SCSI client is configured to use this LUN.
Not active '> Gray Indicates a LUN (not active).
LUN ! The SCSI client is not configured to use this LUN.

The Target may work either in SCSI-2 or in SCSI-3 mode. All the LUNSs of this target will work in this mode,
too, and this will be the standard for all clients assigned to these LUNs. For the details refer to the SCSI/
Primary Commands 2 (SPC-2) and SCSI Primary Commands 3 (SPC-3) manuals.

Depending on the adapter model and the SCSI operating mode, the number of targets pro port and the
number of LUN per target are indicated in Table 23.

Table 23  SCSI and Fibre Channel Adapter Target-LUN Settings
Adapter Type Max target | Max SCSI ID Max LUNs per target
LSI 20860 SCSlI 7 7 8
LSI1 8751D SCsl 15 15 8
LSI 8951U SCSI 15 15 8
QLA 2200 Fibre Channel 1 1 256 (8) @
QLA 23xx Fibre Channel 1 1 256 (8)
Local SCSI 128 128 255 (8)

a. Indicated max LUN number in SCSI-3 (SCSI-2) mode.
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Port

In the Select Components area of the pane, selectable Ports appear. Clicking the expand/collapse button
will result in an element expansion.

@ Note The SCSI ports cannot be configured by means of the Scalar DLC Management GUI
because they are built-in external system objects. The Scalar DLC software can only use
them or indicate that the port is not usable.

The operation of enable/disable the Port is executed by means of the SCSI Target Port Tool. Refer to SCSI
Target Port Tool on page 217.

Figure 116 Port: SCSI

=0l x|

Connection Wizards Esxtended Service  Help

(Librar\; |/ Canfiguration r Events r Service |

angicaI rPhysicaI |/Users r Clients rSCSITarget |

Select component Properies
@ = cormputer Froperty | Yalug | :ﬁt|
@ € ADIC Local 5CSITa PortID 0
? yTarﬁ?\;‘u Name ADIC Local SCSI Taraet Port 0
LUMA State Pailable
- Targetds Mumber of targets 3
LU Max nurmber of targets 128
LM =
= & Max nurmber of LUNS 255
© @ Targetst = - e
{» LUND

1B 1 [» 7
1832 admin connected to computer
18:33 Initializing element status for library Librargl
18:33 Inventory for library Likrary! completed.
Field/Button Icon Operation Description
Port ID & Supplied The port ID.
Name & Supplied The port unique name.
State & Supplied The port state. See Table 22 on page 162.
Number of & Supplied The number of targets currently configured for the SCSI port.
targets
Max number & Supplied The maximum number of targets that can be configured for the
of targets SCSI port. Refer to Table 23 on page 163.
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Field/Button Icon Operation Description

Max number & Supplied The maximum number of LUNs that can be configured for the
of LUNs targets of the SCSI port. Refer to Table 23 on page 163.
World wide = Supplied (only for the Fibre Channel)
name The world wide port name, hexadecimal.
Add new fﬁt Click Pop-up target creation window appears. Refer to Create
Target Target on page 169.
Help ] Click Open online help for the current pane.

o

Figure 117 Port: Fibre Channel

=10l x|

Connection  Wizards Esended Service  Help

dmin connected to computer

fLibrar\;l’Cnnﬂguration |/E\rents |/Senrice |

angicaI rthsicaI rUsers |/Clients rSCSITarget|

Select component Fropeties
@ = computer Froperty | Walue L
&@ADIC Local SCEITal ||& PartID 1

& & ASC-UWIH PCIbus | || g ame

GQLAZIN0 PCl bus 2, device 9, func...
& & QLAZZ00 POl bus 2

& € QLA2300 PCI bus 2 @ State Available
& Mumber oftargets 1
& Max nurmber of targets 1
& Max number of LUNS s _
&@ "World wide name 210000EQSB04CFAC

4 | :§:|

[ »

16:49 admin cannected to computer
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Target

In the Select Components area of the pane, selectable Targets appear.

Figure 118 SCSI Target

Connection  Wizards

Extended Service  Help

=101 ]

fLibraw r Configuration |/ Events |/ Service |

f Laogical |/ Phiwsical r Lsers |/ Clients |/ S8l Target |
Select component Fropeties
o] computer Froperty | Walue " w
@ & ADIC Local SCSITa| || @ TargetID 1 :
? ¥Tar?jjffu & Mame Targetsd \?
_8 LUMI & scsliD Fid
@ ) Targetss & SCSImode SCE-2
LLIND
- LLINY
¢ & Targetfh
¥ LUND
= 7
4 |;:;:;: :;:;:| | ] v
18:32 admin cannected to computer
18:33 Initializing element status for likrary Librane
18:33 Inventary far likrary Librar! completed.
Icon Operation Description

Field/Button

Target ID
Name
SCSI'ID

SCSI Mode

Add new
LUN

Remove

Help

& Supplied
& Supplied
& Supplied
& Supplied
% Click
S
fﬁg Click
=2 Click

L

The target ID (internal).

The target name. Contains ‘Target’ and the SCSI ID.

The target SCSI ID (external, seen by SCSlI initiator).

The target operating mode.
Only SCSI-2 and SCSI-3 are currently supported.
Also refer to Table 23 on page 163

Pop-up LUN creation window appears. Refer to Create LUN

on page 170.

Remove the SCSI Target.

Open online help for the current pane.

The not active Target becomes active after a client (SCSI Client) assigned to the LUN 0 of this target. Refer
to SCSI Client on page 147.
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For the details of the SCSI command format, refer to:

+  SCSI Reference Manual for the Scalar 10K library.
+  SCSI Reference Manual for the Scalar 1000 library.

@ Note The newly created target already contains LUN 0. If the other LUNs are required, they
should be created manually.

_ When the SCSI Target is removed, all SCSI Clients configured for LUNs of this
41y CAUTION  target are removed as well.

The Target can operate either in SCSI-2 or in SCSI-3 mode. All the LUNSs of this target will work in this mode
as well, and this will be the standard for all clients assigned to these LUNs. For the details of the SCSI Mode
refer to:

»  SCSI Primary Commands 2 (SPC-2) Manual
»  SCSI Primary Commands 3 (SPC-3) Manual

— Because of interface properties, one and only one SCSI Client can be assigned to the
4 Note :
single LUN.

_ After the client is assigned to the LUN 0 of any target, all other clients
41y CAUTION  assigned to the non-zero LUNS of this target are activated.
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Logical Unit Number (LUN)

Figure 119 SCSI LUN

Connection  Wizards

Extended Service  Help

=101 ]

fLibraw r Configuration |/ Events |/ Service |

1 [

f Logical |/ Phiwsical r Lsers |/ Clients |/ S8l Target |
Select component Fropeties
@ computer Froperty | Value " &
@ & ADIC Local 5CSI T3 ||@ LUNID 2 >
? ¥Tar?_ﬂffu & Name LUN1
L LUNT & LUMN number 1
@ ) Targetds & YendorID slle
Lura & Product ID Scalar 1000
— LLINT @ Firreeare Revision 3.00
¢ & Targetfh - —
<> LUMO & Full Firrmware Revision 1.00.0000
&@ Client ScsiClient!
7
;:;:;:l | ] v
18:32 admin cannected to computer
18:33 Initializing element status for likrary Librane
18:33 Inventary far likrary Librar! completed.

Field/Button

LUN ID
Name

LUN Number
Vendor ID

Product ID

Firmware revision
Full firmware revision
Client

Remove

Help
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Icon

wd O p DD D DD B D

Operation
Supplied
Supplied
Supplied
Supplied

Supplied

Supplied
Supplied
Supplied

Click

Click

Description
LUN ID (internal).
LUN name. Contains ‘LUN’ + LUN Number.
LUN SCSI ID (external, seen by SCSI initiator).
Vendor ID, as will be seen by the SCSI Initiator.

Product ID. The format of the data transferred from/to
the SCSI initiator.

The firmware revision level, short form.
The firmware revision level, complete.
The assigned SCSI Client (for the active LUN only).

Remove the LUN.

Open online help for the current pane.
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@ Note The LUN 0 cannot be removed manually. It is deleted only with the Target.

The not active LUN becomes active after a client (SCSI Client) assigned to it. Refer to SCSI Client on page
147.

B Because of interface properties, one and only one SCSI Client can be assigned to the
£ Note .
single LUN.

_ After the client is assigned to the LUN 0 of any target, all other clients
41y CAUTION  3ssigned to the non-zero LUNSs of this target are activated.

Create Target

Under the SCSI Port properties, the Add new Target button appears (active for the enabled ports only).
Clicking it opens a pop-up target creation pane.

@ Note Only administrator users can create targets. For the user without administrative
privileges, the Add new Target button is disabled.

Figure 120 SCSI Target Creation

£ add new target e i x|
Froperies
Propery | Value |||_/

& Target D i

& Mame Targets7? ol

# 5C3IID 7] |

# SCEI mode SCER2

# LUM Vendor 1D ADIC

& LUN Product 1D Scalar 100

& LU Firrroaeare Revision  (3.00

& LUN Full Firreeare Revi...[1.00.0000 ‘?’

Field/Button Icon Operation Description
Target ID & Supplied The target ID (internal).
Name & Supplied The target name. Contains ‘Target’ and the SCSI ID.
SCSI ID o Enter The target SCSI ID (external, seen by SCSl initiator).
SCSI Mode & Select The target operating mode.
Only SCSI-2 and SCSI-3 are currently supported.

LUN Vendor ID o Select Current target LUN 0 vendor ID.
LUN Product ID & Select Current target LUN 0 product ID. The format of the

data transferred from/to the SCSI initiator.
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Field/Button

Icon Operation

Description

LUN Firmware o Enter Current target LUN 0 firmware revision level, short
revision form.
LUN Full Firmware ﬁ' Enter Current target LUN 0 firmware revision level,
revision complete.
Create vy Click Create SCSI target
Cancel x Click Cancel creation.
Help ] Click Open online help for the current pane.
o

_ The target creation is not possible if the port already contains the maximum
A1\ CAUTION  number of targets.
@ Note The newly created target will not be active until there is a SCSI client assigned to the

LUN O of that target.

@ Note The newly created target already contains LUN 0. If other LUNs are required they should
be created manually

Create LUN

Under the SCSI Target properties, the Add new LUN button is displayed. Clicking it opens a pop-up target

creation pane.

@ Note Only administrator users can create LUNs. For the user without administrative privileges,
the Add new LUN button is disabled.

Figure 121 SCSI LUN Creation
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& Add new LUN il
Propetties

Froperty | Walue |||7
& LUMID I
# Mame Lun1 x
# LUN number 1] |
# Wendor D ADIC
# Product ID Scalar 100
& Firmware Revision 3.00
& Full Firrmweare Rewision  [1.00.0000 ?
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Field/Button Icon

LUN ID
Name

LUN Number
Vendor ID

Product ID

Firmware Revision

Full Firmware
Revision

Create

Cancel

Help

ed N R R R R R OR D

Operation
Supplied
Enter
Enter
Select

Select

Enter
Enter
Click
Click

Click

Description

LUN ID (internal).

LUN name. Contains ‘LUN’ + LUN Number.

The LUN SCSI ID (external, seen by SCSI initiator).
Vendor ID, as will be seen by the SCSI Initiator.

Product ID. The format of the data transferred from/to
the SCSI initiator:

The firmware revision level, short form.

The firmware revision level, complete.

Create SCSI LUN
Cancel creation.

Open online help for the current pane.

_ The LUN creation is not possible if the target already contains the maximum
A1 CAUTION  humber of LUNS.

\.g Note The newly created LUN will not be active until there is a SCSI client assigned to this LUN.

Moreover, the LUN requires the target to be active, and the target becomes active only
when the SCSI client is assigned to the LUN O.
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Events Tab

The Events Tab is designed for viewing event notifications or modifying rules that govern event reporting.
The Events Tab contains an additional level with the following tabs:

Queue Tab. Managing command queue. Refer to Queue Tab on page 174.
Monitoring Tab. Monitoring the current login session events. Refer to Monitoring Tab on page 176.
Acknowledge Tab. Acknowledging the notifications. Refer to Acknowledge Tab on page 178.

History Tab. Monitoring the events during all sessions. Refer to History Tab on page 179.
Rules Tab. Managing the rules. Refer to Rules Tab on page 179.
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Queue Tab

Figure 122 Queue Tab

=10l x|

Connection  Wizards Exiended Service  Help

fLibrar\;rCnnﬂguration |’E\rents |’Senrice |

f@ueue rMUnitnring r.v'-\cknuwledge rHistnr\,r |/RLI|ES|

[ Time | command | Client | Library | Farameters
& 16:2410 Dismountvolser | Clientt Libraryl  wolser=000003

& 16:2414 Dismountvolser |Client!  |Librargl  volser=000001

- |- )TII

T UL STTTOUT LA T e oo oS s sy
15:583 Initializing element status for library Likrary? =]
18:84 Inventary for library Library2 completed. Found 40 cartridoges.
18:84 Initializing element status for library Library2 _
18:84 Inventary for library Library2 completed. |

The Queue Tab shows the queue of commands currently accepted and executed by the Scalar DLC
software. Typically these commands are sent by client backup applications.

'{z’ﬁ; Note This tab is accessible for all users. The operation buttons are active for the Admin only.
Field/Button Icon Operation Description
Time Select The current command arriving/execution time

(HH:MM:SS format). A command status is indicated
here (see below).

Running/Preparing . Select The command is running or preparing to be executed.

Pending h Select The command is pending the required resources.

Waiting, normal - Select The command is waiting, its priority is normal.

Waiting, high % Select The command is waiting, its priority has been raised.
174
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Field/Button

Waiting, low
Idle

Command
Client
Library
Parameters

Cancel

Raise priority

Lower priority

Stop

Help
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Icon
L
L

X

i @ < [

Operation

Select

Select

Select
Select
Select
Select

Click

Click

Click

Click

Click

Description

The command is waiting, its priority has been lowered.
The command is idle (stopped).

The current command.

The client who send a command.

The logical library where the command is executed.
The command operating parameters.

Cancel command execution and remove command
from list.

Raise waiting command priority.
Lower waiting command priority.
Stop command execution. The command remains idle.

Open online help for the current pane.
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Monitoring Tab

Figure 123 Monitoring Tab
4. Sealar DLC 101 =l

Connection  Wizards Edended Service  Help

fLibraw r Configuration |/ Events |/ Service |

f@ueue rMDnitoring rAcknnwledge rHistow rRuIes |
Filter Events: Ewent List:

[ A 10M 152002 1541 Initialization in Library] -
101152002 15:51 Begin dismount in Likiraryt
101152002 15:51 Dismount in Librany

v Hardware 10/11/2002 15:54 Initialization in Library2

[ Firmuware 10/11/2002 18:22 Begin mount in Library]
S Configuration 0/ 12002 16:22 Mount in Libraryt

[ Statistical 10/11/2002 16:22 Begin mount in Library]
[CiSemice Call  {10/11/2002 16:22 Mount in Libraryl
10152002 16:22 Begin dismount in Likiraryt
101152002 16:22 Dismount in Librany

[¥] Operator

4]

More information:

The carridge 000002 is heing mounted
from P1_5T2001
to p3dr1 o

16:29 admin cannected to computer

The Monitoring Tab pane describes notifications that it receives during the current login session.

In the Filter Events area of the pane, there are seven predefined event classes. Each event class is shown
in a different color. See Table 24.

Table 24 Event Classes

Event Class Color Checked Description
All Black Yes All received notifications are displayed.
No Only checked notifications are displayed.
Operator Red Yes Operator notifications are displayed.
No Operator notifications are not displayed.
Hardware Pink Yes Hardware notifications are displayed.
No Hardware notifications are not displayed.
Firmware Blue Yes Firmware notifications are displayed.
No Firmware notifications are not displayed.
Configuration | Turquoise Yes Configuration notifications are displayed.
No Configuration notifications are not displayed.
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Table 24  Event Classes (Continued)
Event Class Color Checked Description
Statistical Dark Blue Yes Statistical notifications are displayed.
No Statistical notifications are not displayed.
Service Call Green Yes Service Call notifications are displayed.
No Service Call notifications are not displayed.

In the Event List area of the pane, every event is detailed in a series of single rows. The description of the
event is copied from the internal table of events. See Table 25. The event information for the current login
session is updated automatically, but the information is lost after the Scalar DLC Management GUI is

closed.
Table 25  Event Data
Event Description
Date This is the date of the event in the MM/DD/YYYY format.
Time This is the time of the event in the HH:MM format.
Event This is the event notification data.

In the More Information area of the pane, additional information about the current session is listed. If the
Event List area cannot contain the complete message, the entire message appears in the More Information

area.

Scalar DLC Reference Guide

177




Acknowledge Tab

Figure 124 Acknowledge Tab
4. Sealar DLC

=10l x|

Connection  Wizards Edended Service  Help

fLibraw r Configuration |/ Events |/ Service |

f@ueue rMDnitoring rAcknnwledge rHistow rRuIes |
Filter Events: Ewent List:

(1

[¥] Operator

[¥l Hardware

[ Firrmware

] Canfiguration
[] Statistical

] Service Call

Mare information: v

16:29 admin cannected to computer

The Acknowledge Tab pane describes the notifications received during current login sessions that require
a user acknowledgement.

If the Acknowledge button is clicked after an event is selected from the Event List, the event is
acknowledged by the Scalar DLC software. If a rule associated with the event specifies a service ticket, the
Scalar DLC software service generates the service ticket. Refer to ATAC Calls Tab on page 189 for the
description of procedures associated with ticket generation.

In the Filter Events area of the pane, there are seven predefined event classes. Each class of event is shown
in a different color (see Table 24 on page 176).

In the Event List area of the pane, every event is detailed in a series of single rows. The description of the
event is copied from the internal table of events. The event information is updated automatically. See Table
25 on page 177.

In the More Information area of the pane, additional information about the current session is listed. If the

Event List area cannot contain the complete message, the entire message appears in the More Information
area.
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History Tab

Figure 125 History Tab
4. Scalar DLC 101 =l

Connection  Wizards Edended Service  Help

fLibraw r Configuration |/ Events |/ Service |

f@ueue rMDnitoring rAcknnwledge rHistow rRuIes |
Filter Events: Ewent List:

[ Al 12128/2004 1556 Beain mount in Librard -
1202872004 1546 Move in Libran il
1212872004 1556 Beagin dismoaount in Library?
1202872004 1546 Move in Libran
1212872004 1546 Begin mount in Librang
1202872004 1546 Move in Libran
1212872004 1556 Beagin dismoaount in Library?
1202872004 1546 Move in Libran
1212872004 1546 Begin mount in Librang |

1] I

More information:

The cartricdge 000011 is heing mounted
from PEO_ST4111
to PY1DR264

16:29 admin cannected to computer
19:148 Ticket created successfully

The History Tab pane contains the last 200 notifications that were received during all login sessions.

In the Filter Events area of the pane, there are seven predefined event classes. Each class of event is shown
in a different color (see Table 24 on page 176).

In the Event List area of the pane, every event is detailed in a series of single rows. The description of the
event is copied from the internal table of events. The event information is updated automatically. See Table
25 on page 177.

In the More Information area of the pane, additional information about the current session is listed. If the
Event List area cannot contain the complete message, the entire message appears in the More Information
area.

Rules Tab

The Rules pane displays the list of both pre-defined and user-created rules along with their properties.

‘{.‘g Note This section is available only for the users with the rules management rights.

The rules are used to act when a specific event occurs. The actions include simple notification of event,
notification of events that require acknowledgment, and service call ticket generation.

It is also possible to launch the wizard-based process for adding user-defined rules. Refer to Create Rule
on page 45.
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Figure 126 Rules Tab
4 Scalar DLC =lo =]

Connection  Wizards Exiended Service  Help

fLihraw r Configuratian |/ Ewvents |/ Semice |

f@ueue rMDnitDring rAcknnwledge rHistDw |/Rules |
List of rules Fropeties
SDLC has heen started (SNMP) Property | Walue Hl}
Library state has heen changed (SMNMF) # Rule Name SDLC has been started (SM... =
SDLC has been started (E-Mail) # State ¥ =
SDLC is gaing to be stopped (E-Mail) # Event group Statistical o
Licence expiration warning (E-Mail) & Motification of events Scalar DLC has been succe. .
SDLC is gaing to he stopped (SHMP) # Errar code 0
Mew library has been created (SHMPY -
Lilrary has been deleted (ShMF) # Devics Al
Library Tape Alert Trap (SNMP) # Library Al
Drive Tape Alert Trap (SMMF) # Client A
Cluster Mode Changed (E-Mail) & wia SHMP
Mowe cafridge to problerm box (SHMPY
?
16:29 admin cannected to computer
19:14 Ticket created successiully
Field/Button Icon Operation Description
Rule Name & Enter Rule name.
State o Check Whether the rule is active.
Event group o Select The event group. See Table 8 on page 45.
Notification of events e Select The event to notify. See Table 8 on page 45.
Error code o Select Error code. Refer to Error Codes on page 251 and
Table 8 on page 45.
Device 4 Select Physical library. See Table 8 on page 45.
Library e Select Logical library. See Table 8 on page 45.
Client o Select Client. See Table 8 on page 45.
via & Supplied The method of sending notifications: Email, SNMP, or
GUI.
The notification method can not be changed.
Email Destination o Select The notification email destination (email only).
Email Template 4 Select The notification email template (email only).
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Field/Button Icon Operation Description
User o Select The user who should acknowledge the notification
(GUI only).
Generate ticket o Check Whether a ticket should be generated after
acknowledge (GU/ only).
Update 5@ Click Save the rule properties after edit.
Remove .btg Click Remove the rule.
Wizard -l;": Click Launch the Rule wizard. Refer to Create Rule on page
T 45,
Help =2 Click Open online help for the current pane.
+
@ Note The rules configured to send email notifications cannot be activated when the Email

Notifications field in the Registration Info pane is not checked. Refer to Registration
Information on page 55.

@ Note The rules configured to send SNMP notifications cannot be activated when the SNMP
service is not started. Refer to SNMP Tab on page 199.
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Service Tab

The Service Tab is designed for the Customer Engineer (CE) and Admin users. The Service Tab has an
additional level with the following tabs:

* Logs Tab. Monitoring the library command log and error log. Refer to Logs Tab on page 183.
» Diagnostic Tab. Executing the library diagnostics. Refer to Diagnostic Tab on page 187.
+ ATAC Calls Tab. Managing the service requests (tickets). Refer to ATAC Calls Tab on page 189.

»  Operator Panel Tab. Executing operator panel commands from a remote console. Refer to
Operator Panel Tab on page 195.

» Cluster Tab. Viewing and changing the cluster settings. Refer to Cluster Tab on page 198.

*  SNMP Tab. Managing the SNMP service settings. Refer to SNMP Tab on page 199.

Logs Tab

This pane allows the user to view the error log and the command history for the selected robot of the
physical library. When a specific event is selected, the information that has been collected can be sentto a
specified email address.

This section provides an additional level with the following tabs:

+ Command Log. The commands executed by the physical library. Refer to Command Log on page
184.

« Error Log. The errors occurred in the physical library. Refer to Error Log on page 186.

T4 Note The Command Log and Error Log features are not available for the Scalar 1000 library.

@ Note The Scalar 10K DA library has two robots, so it contains two different Command logs
and Error logs.
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Command Log

Figure 127 Command Log

4. scalar DLC 101 =l
Connection  Wizards Edended Service  Help
f Library r Configuration |/ Ewents |/ Semice |
f Logs |/ Diagnostic |/ ATAC Calls r Operator Panel |’C|uster rSNMP |
Select component Logs
9 computer 05/05/03 14:08:27 SCSIDOME MDEN: Status good [

% [m ADIC Scalar 10KDA| | 05i05/03 14:08:28 SC1.5 LGSN: SVIF] CHGIF] Poct]il] PoCdl3E] =
=C Fohot 05/05/03 14:09:28 PrmSt0000] Alloc[FFFF] =
=C Rohot2 05/05/03 14:09:28 SCSIDONE LESM: Status gaod

05/05/03 14:10:27 SC1.8 LGSM: 5Y[F] CHG[F] PaCtr[01] PoCd[2E]
0560503 14:10:27  PrmSt0000] Alloc[144]
05/05/03 14:10:27 SCSIDOME LGSM: Status good
0560503 14:10:28 5C1.5 MDEN: PgCtI[00] PgCd[1D] Allac[18]
05/05/03 14:10:28 SCSIDOME MDEN: Status good
05605003 14:10:28 5C1.5 LGEM: 8V[F] CHG[F] Pactr[01] PgCd[3B]
05/05/03 14:10:28 PrmSt0000] Alloc[FFFF]
0560503 14:10:28 SCEIDOME LGEN. Status good
05/05/03 14:11:27 5C1.8 LGSM: 5Y[F] CHG[F] PaCtr[01] PoCd[2E] B8
0560503 14:11:27  PrmSt{0000] Alloc[144] I
NAI0AMN3 141127 SCSIDONE | GEN' Status annd | |
[» —LCnmmand Log LErroang | ?
14:12 The drive containing the cartridge i=s out of Library range Je=d
14:12 dismount cartridge 001137
1413 dismount cartridge 001137 finished [
14:14 mowe cafridge 000132 =
Button Icon Operation Description
Save to file 3 Click Save log to file.
=
Send email = Click Send the log via email. Refer to Send Log via Email on page
—- 185.
Help e Click Open online help for the current pane.
o
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Send Log via Email

Figure 128 Email Data

To | |
Subject | |
Description
= send | | X Cancel
Field/Button Icon Operation Description
To Enter The recipient email address associated with the data. Multiple

email addresses must be separated with semicolons.

Subject Enter The subject of the email.
Description Enter The email message text (the data will be attached in a
separate file).
Send = Click Send the email to the recipient.
—
Cancel x Click Close the Email dialog without sending email.
@ Note The email will be sent successfully only if the email parameters of the current user are

valid. Refer to User on page 131 for the details on the user's email parameters.
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Error Log

Figure 129 Error Log
4. Sealar DLC 101 =l

Connection  Wizards Edended Service  Help

fLibraw r Configuration |/ Events |/ Service |

fLogs rDiagnostic |/ATAC Calls r Operator Panel |’C|uster rSNMP |

Salact component Logs
@ camputer 0204703 12 46:05 HT[OO000000] M_rmclef_fiducial_not_found -
@ [ ADIC Scalar 10KDA 05/04/03 12:48:08 HT[00000000] W_rmclef_fiducial_not_found
= Robot1 05604503 12:48:13 HT[000O0000] M_mclef_fiducial_not_found =
=C Rohot? 0504503 12:51:16 HT[00000000] M_meclef_fiducial_not_found

05604503 12:53:10 HT[00000000] M_mclef_fiducial_not_found
0504503 12:55:03 HT[00000000] M_melef_fiducial_not_found
03r05/03 10:83:19 HT[O0010002] M_delkunlk_retry_command
05/05/03 13:52:39 HT[00010002] M_dclkunlk_retry_command
03r05/03 15:16:22 HT[O0010002] M_delkunlk_retry_command
05/05/03 15:33:47 HT[00010002] M_dclkunlk_retry_command L5
03r05/03 16:25:28 HT[O0010002] M_delkunlk_retry_command
05/05/03 16:27:11 HT[00010002] M_dclkunlk_retry_command
03r05/03 18:94:95 HT[O0010002] M_delkunlk_retry_command
05/05/03 19:24:02 HT[0h02114d] G_dcvecend_endine_failed
05/05/03 19:24:03 HT[022225ed]) G_meproeng_extend_for_oet_failed | «|

[» [ Command Log | Error Lag |

13:22 move cardridge 0007189
13:22 mowe cafridge 0007 27 finished
13:23 move carridge 000719 finished

|1|§:

ol

Button Icon Operation Description
Save to file H Click Save log to file.
=
Send email = Click Send the log via email. Refer to Send Log via Email on page
- 185.
Help e Click Open online help for the current pane.
o
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Diagnostic Tab

Figure 130 Diagnostic Tab

=T
Connection  Wizards Esended Service  Help
fLibrar\; rCnnﬂguration |/E\rents |/Senrice |
angs rDiagnnstic |/ATAC e[} rOperatorF‘anel |’C|uster r ShMP |
Select component Select Diagnostic
o] computer Selftest 5
&~ [In ADIC Scalar1000# ||Horme accessor
©- [ ADIC Sealar 10K#2| ||oyeia Gripper Finger Z
@ [ ADIC Scalar 10KDA Cycle Vertical Axis
=C R ohotl Cele Horizantal
=C Rohats wile Horizantal Axis
Cycle Inser/Eject Station Door Lock
Teach Mew
Teach Current
Take Code Dump
Diagnostic information
L 7
14:37 mowe cafridge 000007 =l
14:37 move carridge 000007 finished
14:38 mount cartridge 000011 [
14:38 mount cartridge 000011 finished -

This Diagnostic pane specifies diagnostic tests that can be executed on a robot.
Select the diagnostic test and click on Execute button to launch it.

The result of the diagnostic test appears in the Diagnostic Information area on the right.
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Field/Button Icon Operation Description

Select Diagnostic Select Self test is the complete test included in all of the steps
described in the following text.

Home Accessor moves the accessor to the home position on
the vertical and horizontal axes.

Cycle Gripper Finger opens and closes the gripper fingers.

Cycle Vertical Axis moves the accessor to the home position
on the vertical axis, then to the top of the vertical axis, and
returns it to the home position.

Cycle Horizontal Axis moves the accessor to the home
position on the horizontal axis, then to the far right of the
horizontal axis, and returns it to the home position.

Cycle Insert/Eject Station Door Lock locks and then unlocks
the Insert/Eject solenoid.

Teach New reteaches the library configuration.
Teach Current reteaches the library current configuration.

Take Code Dump saves the current state of code execution in

DRAM.

Diagnostic Supplied The results of the diagnostic test.

information

Execute % Click Execute the selected diagnostic test.

Description (;. Click Show the selected diagnostic test description. See Figure 131
on page 188.

Help ] Click Open online help for the current pane.

#

Figure 131 Diagnostic Description
£ pescription |

he accessaris moved ta the hame pasition
on the harizontal axis, moved ta the far right of
he horizantal axis and returned to the haome

pasitian.
&
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ATAC Calls Tab

The ATAC Calls tab shows the list of report issues (tickets) either created by the customer or generated
automatically.

\Qi Note This tab is accessible only by Customer Engineers (CE) and the users with the ticket
management rights. All CEs are a part of the ADIC Technical Assistance Center (ATAC).

Selecting the ATAC Calls Tab pane is the first step to solving a problem. A written description of the problem
is shown under the ticket properties.

Tickets can be generated manually by the customer or automatically by a notification rule.

The customer creates tickets with the help of the Ticket wizard launched from the Management GUI main
menu. Refer to Create Ticket on page 40.

Figure 132 ATAC Calls Tab

& Scalar DLC =l e
Connection  Wizards Extended Service  Help
adic | User atac connected to computer
rLihrawrCDnﬂguratinn rEvents rSENiCE |
fLogs rDiagnostic rATAC Calls rOperatorF‘anel rCIusterrSNMP |
List of reported problems: Properties
AR1385728573 Property | Yalue | Ly
& D 1 =
ARZ & Criginator My _Mame e
AR4 & Telephone My_Phone =2
& Priority ] o
==
1] DN
Cescription:
Status
[oe] Al 7
18:29 Ticket created successiully =
18:25 Ticket created successfully
18:29 Ticket created successiully B
18:25 atac connected to computer -

In the List of reported problems area of the pane, all of the reported problems are listed. The ticket reports
are color-coded for identification.

List Color Description
Open Red This color indicates an opened problem. The CE has not start working
under the issue.
Suspended Black This color indicates a solved problem but the ticket has not been
closed.
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Description

This color indicates that a CE is working on the problem.

List Color
In Process Yellow
Closed Green

This color indicates a solved problem, and the ticket has been closed.

In the Properties area of the pane, the ticket properties are shown for the selected problem report.

Field/Button Icon

ID &
Originator &
Telephone &
Priority =
Description

Status, All problems
Status, Opened

Status, Suspended
Status, Closed

Start Repair L,
Under Repair Ly
Close L
History '-'E
Remove ';E
Wizard -l;":
Help -\?I
190

Operation

Supplied

Supplied
Supplied
Supplied

Supplied
Check
Check
Check
Check
Click

Click

Click
Click
Click
Click

Click

Description

The ticket ID (generated by the Scalar DLC software or applied
manually by the CE).

The ticket originator.
The originator’s phone number.
The problem priority selected by the originator.

The brief description of the problem entered by the originator.
Display all problems.

Display all opened problems.

Display all suspended problems.

Display all closed problems.

Display the Start Repair dialog (for the opened tickets only).
See Figure 133 on page 191.

Display the Repair dialog (for the suspended or in process
tickets only). See Figure 134 on page 192.

Close ticket (for the opened or suspended tickets only).
Display the History pane. See Figure 137 on page 194.
Remove ticket (for the closed tickets only).

Launch the Ticket wizard. Refer to Create Ticket on page 40.

Open online help for the current pane.

Service Tab



Figure 133 Start Repair

CE narne: [zE-1 |
Service Code; | Do not know - |
Ticket: .-Q\R|2224322314 |
Start Time: 0450452002 1826

v 0K H X Cancel

Field/Button Icon Operation

CE Name Enter
Start Time Supplied
Service Code Select
Ticker AR Enter
Start Time Supplied
OK VY Click
Cancel x Click

Scalar DLC Reference Guide

Description

The CE name. It indicates a person assigned by ATAC as
responsible for solving a problem.

The start time of the repair.

Do not know means the CE cannot make a problem
determination based on the service ticket information.

Unscheduled Repair means an unexpected repair is required.

Scheduled Repair means a pre-arranged time has been
allocated for the repair.

Information Call means information is being sent to ATAC.

Customer Resp. means the problem is caused or belongs to
the customer.

Preventive Maint. means routine preventive maintenance is
scheduled.

Installation means the ticket is generated to notify ATAC about
the installation of the system.

De-Installation means the ticket is generated to notify ATAC
about a system de-installation.

EC/Field Bill means a service call is the result of an EC/Field
build installation.

Feature Code Change means a new feature or function is
added to the system.

The AR registration number supplied by ATAC support.
The time when the CE start the work.

Accept entered information.

Return to the ATAC Calls pane, changes discarded.
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Figure 134 Repair

Field/Button Icon

End Time
Travel h.

Logistics h.

Diagnostic h.

Repair h.

Parts Usage Installed
Support Diary

Fixed

Not fixed ¥

Cancel x

192

End time:
Travel h. 00.00 |
Lagistic h. 00.00 |
Diagnastic h. M
Repair h. 00.00 |
Fars Usage installed [
Support Diary
%8 Fixed H =% Mot fixed H 7% Cancel
Operation Description

Supplied The time repair ended.

Enter The time required to travel to the customer site.

Enter The time for administrative functions associated with the
repair. Parts ordering is an example of the logistics associated
with a repair.

Enter The time it took to diagnose the problem.

Enter The time necessary to repair the problem.

Check Total repair parts usage.

Enter Comments about the repair process.

Click The problem is fixed. See Figure 135 on page 193.

Click The problem is not fixed. See Figure 136 on page 193.

Click Return to the ATAC Calls pane, changes discarded.
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Figure 135 Fixed Problem Confirmation
&Conﬁmmﬁon
Ifthere are no additional activities required,

please press the OK button and then close the prokblem.
Ifyou want to finish this repair action, please describe the current status.

[] Close the ticket for me. + 0K X cancel
Field/Button Icon Operation Description
Current Status Enter A description of the current problem status.
OK vy Click Return to the ATAC Calls pane. The ticket can be closed.
Cancel x Click Return to the Repair dialog.
Close the ticket for Check The Scalar DLC software closes the problem ticket
me automatically.

Figure 136 Not Fixed Problem Confirmation
&Conﬁmmﬁon
Please press the Ok button. The problem remains open.

Ifyou wwant to finish this repair action,
please describe the current status.

v Ok & Ccancel
Field/Button Icon Operation Description
Current Status Enter A description of the current problem status.
OK y Click Return to the ATAC Calls pane. The ticket will be In process.
Cancel x Click Return to the Repair dialog.
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The Repair History dialog lists the events associated with a specific repair.

Figure 137 Repair History

§& History
Starttime: 040452002 18:27 =]
Service Code: Do not know
2. |
End tirre: 040452002 1530
Travel h.. 01.00

Lagistic b, 02.00
Diagnostic b 01.00
Repair h.: 01.30

Fars Usage installed
Suppoart Diarny: suppaort diary

v 0K
Field/Button Icon Operation Description
Ticket ID Supplied The ticket identifier generated by the Scalar DLC software
service.
CE Name Supplied The ticket originator identification.
Start Time Supplied The start time of the repair service.
Service Code Supplied Do not know means the CE cannot make a problem

determination based on the service ticket information.
Unscheduled Repair means an unexpected repair is required.

Scheduled Repair means a pre-arranged time has been
allocated for the repair.

Information Call means information is being sent to ATAC.

Customer Resp. means the problem is caused or belongs to
the customer.

Preventive Maint. means routine preventive maintenance is
scheduled.

Installation means the ticket is generated to notify ATAC about
the installation of the system.

De-Installation means the ticket is generated to notify ATAC
about a system de-installation.

EC/Field Bill means a service call is the result of an EC/Field
build installation.

Feature Code Change means a new feature or function is
added to the system.

Ticket AR Supplied The AR registration number supplied by ATAC support.
End Time Supplied The Scalar DLC software service supplies the end time.
Travel h. Supplied The travel time for arriving at the customer location.
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Field/Button

Logistics h.

Diagnostic h.

Repair h.

Parts Usage Installed

Support Diary
OK

Operator

Icon

Supplied

Supplied

Supplied

Supplied

Supplied
Click

s

Panel Tab

Operation

Description

The time for administrative functions associated with the
repair. Parts ordering is an example of the logistics associated
with the repair.

The time to diagnose the problem.

The time necessary to repair the problem.
The total repair parts.

Comments about the repair process.

Return to the ATAC Calls pane.

This tab mimics the operator panel on the actual device and provides an interactive path between the
operator and the library indicators and push-buttons that control the library.

T4 Note

The Scalar 10K DA library has two different robots and respectively two different

operator panels.

Figure 138 Operator Panel Tab for the Scalar 10K

Connection  Wizards

Extended Service

=10l x|

Help

rLibrar\;rCUnﬂguratiDn rEvents |/Senrice |

angs rDiagnnstic |/ATAC Ealls rOperatDrF’anel rCIusterrSNMF' |

Select component

? = computer
@ [ ADIC Scalar 1000 #

@ [ ADIC Scalar 10k #2

@ [ ADIC Scalar 10KDA

=C Fohotl

=C Fohotl

=C Fohotl
=C Rohot?

B

[ »

14:3

14:37 mowe cafridge 000007 finished

14:3

14:38 mount cartridge 000011 finished

T move cartridge 000007

8 mount cartridge 000011

| »
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Item

LCD Screen

P B B =

.

A\ WARNING

196

Description

The vendor ID, library type, date, and time are shown on the operator LCD screen. The
operations with push-buttons are indicated here, too.

The Locked indicator is lit whenever the I/E station is locked (only for Scalar 1000
libraries).

The Power On indicator is lit whenever the Control Module is connected to the power
source, the Control Module switch, and the AC Power Compartment(s) circuit breakers
are ON.

The Ready indicator is lit whenever Power is available in the aisle and the library is
ready to perform motion commands from the host.

The Up Arrow push button:
+ scrolls the display to show previous line(s).

* moves the cursor (>) up from selection to selection.
* increases the current value to the next value when used in an entry field.

The Down Arrow push button:
+ scrolls the display to show the next line(s).

* moves the cursor (>) down from selection to selection.
» decreases the current value to the previous value when used in an entry field.

The Escape push button:
 leaves the current display and returns to the previous display, if it exists.

* moves from the Initial Screen to the Main Menu.

The Enter push button:
+ selects the current option as the next action to be performed by the library, the cursor
(>) indicates the chosen option.

» acts as a TAB button to the next required entry field when multiple field entries are
being entered. In this case, the button cycles through all the entry locations until the
Accept option is chosen (with Y).

The Ready push button:
« transitions the library from a Ready state to Not Ready or Not Ready to the Ready
state.

The Help push button:

« displays help text for the current selected item if available. In this mode, the Arrow
buttons scroll through the help text, and the Escape button is used to exit the help
display.

LOOK INTO THE AISLE TO MAKE SURE THERE ARE NO OBSTRUCTIONS OR
PERSONNEL PRESENT PRIOR TO APPLYING LIBRARY POWER.
MOVEMENTS OF MECHANICAL COMPONENTS IN THE LIBRARY CAN CAUSE
SERIOUS INJURY.
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T Refer to Scalar 1000 Operator Guide and Scalar 10K Operator Guide for detailed
£ Note .
description of LCD Operator Screen

Figure 139 Operator Panel Tab for the Scalar 1000
_|Ol x|

Connection Wizards Esended Service  Help

fLibrar\;l’Cnnﬂguration |/E\rents |/Senrice |
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Cluster Tab

The Cluster tab shows current Scalar DLC Cluster settings.

@ Note This tab is available only when the Scalar DLC is installed as a failover (redundant)
solution.

When the Scalar DLC software is installed on the host, it can be accessed by this host name (for example,
computer). In a Cluster solution, there are two ways: either login to the active host (for example,
sdlcclust2) or use a cluster virtual name (for example, sdlccluster). ADIC strongly recommends the

second way because there is no way to predict what host is active when the customer tries to access the
Scalar DLC host.

Figure 140 Cluster Tab

-0 x|
Connection  Wizards Exiended Service  Help
radmin connected to sdloclustz
rLibrar\; rCUnﬂguratiun rEvents |/Senrice |
angs rDiagnnstic |/K!"§\C Ealls rOperatDrF’anel rCIuster r ShMP |
Property | value | ]
Cluster Mame SOLCCLUSTER - [l—
Mode 1 SDLCCLUST2 Active
Made 2: SDLCCLUST Passive
State node 1 The node is Up
State node 2 The node is Down
IP address sdlccluster182.168.1.2145
= 2
1] [*] ¥
11:33 admin connected to sdicclust?
Field/Button Icon Operation Description
Cluster name = Supplied The virtual host name used to access both cluster nodes.
Node1 & Supplied Cluster Node1 name and status.
Node2 & Supplied Cluster Node2 name and status.
State node1 & Supplied Scalar DLC state on Node1.
State node2 & Supplied Scalar DLC state on Node2.
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Field/Button Icon Operation Description

IP address = Supplied The IP address of the current cluster host.
Change i~ Click Change active cluster node. The node that is currently active

goes down and the node currently passive goes up.
Note that this operation will be successful only when both
node PCs are running.

cluster node

Help e Click Open online help for the current pane.

SNMP Tab

The SNMP tab displays current SNMP Service settings.

— This tab is available only when the SNMP Agent service is successfully started on Scalar
4 Note
DLC host PC.

To install the missing SNMP service, use Control Panel > Add-Remove Windows Components >
Management and Monitoring Tools > Simple Network Management Protocol. Windows 2000 / 2003
system disk is required.

SNMP (Simple Network Management Protocol) is a network protocol used to manage TCP/IP networks. In
Windows, the SNMP service is used to provide status information about a host on a TCP/IP network.

The SNMP Tab provides the same service as the SNMP Service options (Windows Desktop > Start >
Settings > Control Panel > Administrative Tools > Services > SNMP Service Properties). It contains
three additional tabs with the following properties:

* Agents is used to configure the settings for SNMP agents. Refer to Agents on page 200.
* Trapsis used to configure the settings for SNMP traps. Refer to Traps on page 201.
«  Security is used to configure the settings for SNMP security. Refer to Security on page 203.
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Agents

Figure 141 SNMP Agents
£ Scalar DLC =lo =]

Connection  Wizards Exiended Service  Help

fLihraw r Configuratian |/ Ewvents |/ Semice
[ Logs | Diagnostic | ATAC Calls | Operator Panel | Cluzicr [[SNMP

[ Agents | Traps | Security | @

Internet management systems may requestthe contact persan, -
system location, and network services for this computer fram
the SMMF service.
| |
Contact: | |
Location: | |
Service
[] Physical [v] Applications [] Datalink and subnetwark
[¥] Internet [v] End-ta-end

| »

18:58 Initializing element status for library Likiraryl
15:88 Inventary for library Library? completed.
18:58 Initializing element status for library Likiraryl
15:88 Inventary for library Library? completed.

4 [

Agentis a computer running simple network management protocol (SNMP) agent software. In the Windows
implementation of SNMP, agent information includes comments about the user, the physical location of the
computer, and the types of service to report, based on the computer's configuration.

Field/Button Icon Operation Description

Contact Enter Administrator or user (network account, local or domain) with
the SNMP settings managing rights.

Location Enter Physical location of the computer or contact.

Service Supplied SMNP agent service settings

Physical Do not check  Manage physical devices, such as a hard disk partition.

Internet Check IP gateway (router).

Applications Check Use any applications that send data using the TCP/IP protocol

suite. This service should always be enabled.
End-to-end Check IP host. This service should always be enabled.
Datalink and subnet Do not check  Manage a bridge.

Update 5@ Click Save SNMP properties after edit.

Start SNMP > Click Start SNMP service (active when SNMP service is stopped).
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Field/Button Icon Operation Description

Stop SNMP B Click Stop SNMP service (active when SNMP service is started).
Help 2 Click Open online help for the current pane.
+

Traps

SNMP Traps
4. Scalar DLC - 101 =l

Connection  Wizards Edended Service  Help

fLibraw r Configuration |/ Events |/ Service |

fLogs rDiagnostic rATACCaIIs rOperatananeI |’C|uster ShMP

[ Agents | Traps | Security | IE

The SMMP Service provides netwark managerment over TCRIP and -
IPHIEPY protocols. Iftraps are reguired one or mare comimunity

names must he specified. Trap destinations may be host names. IP ]
addresses ar IP addresses.

Community name

] |

Femove

Trap destinations

Add Edit Remave

19:58 Initializing element status for likrary Libran
19:58 Irventary far likrary Libram! completed.
19:58 Initializing element status for likrary Libran
19:58 Irventary far likrary Libram! completed.

FY

-

Trap is a message sent by an agent to a management system indicating that an event has occurred on the
host running the agent. For example, the SNMP service can be configured to send a trap when it receives
a request for information that does not contain the correct community name and does not match an
accepted host name for the service.

Field/Button Icon Operation Description
Community name Enter/Select = Community to send traps.
Add Click Add new Trap community
Remove Click Remove community from list.
Trap destinations Click to Current trap destinations
select
Add Click Add new trap. Pop-up SNMP Service Configuration dialog

opens, see Figure 142 on page 202.
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Field/Button Icon Operation Description

Edit Click Edit trap. Pop-up SNMP Service Configuration dialog opens,
see Figure 142 on page 202.

Remove Click Remove trap.
Update 5@ Click Save SNMP properties after edit.
Start SNMP > Click Start SNMP service (active when SNMP service is stopped).
Stop SNMP B Click Stop SNMP service (active when SNMP service is started).
Help 2 Click Open online help for the current pane.

+

SNMP traps can be used for limited security checking. When configured for an agent, the SNMP service
generates trap messages any time specific events occur. These messages are sent to a trap destination.
For example, an agent can be configured to initiate an authentication trap if a request for information is sent
by an unrecognized management system. Trap messages can also be generated for events such as host
system startup or shutdown.

Trap destinations consist of the computer name or the IP or IPX address of the management system. The
trap destination must be a network-enabled host that is running SNMP management software. Trap
destinations can be configured, but the events (such as a system reboot) that generate a trap message are
internally defined by the SNMP agent.

Figure 142 SNMP Service Configuration: Trap Destination
4. SNMP Seryice Configuration il

‘ Add ‘

Host name, IP ar IPX address: ‘ Cancel ‘
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Security

Figure 143 SNMP Security
g Scalar DLC

Connection  Wizards

Extended Sermice

=101 %]

Help

fLihraw r Configuratian |/ Ewvents |/ Semice
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18:58 Initializing element status for library Likiraryl
15:88 Inventary for library Library? completed.

| »

4 [

Field/Button Icon

Send authentication
trap

Accepted community
names

Rights

Add

Operation

Check

Click to
select

Supplied

Click
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Description

Authentication is the process of verifying that a host name or
address is valid. When the SNMP agent receives a request
that does not contain the correct community name or is not
sent from a member of the acceptable host list, the agent
sends an authentication trap message to one or more trap
destinations (management systems), indicating the failure of
authentication. This option is checked by default.

The service requires at least one default community name.
‘Public’ is the common community name that is universally
accepted in all SNMP implementations.

If an SNMP request is received from a community which is not
on this list, it will generate an authentication trap.

A permission level can be selected, determining how the
SNMP agent processes requests from a selected community.
For example, configure the permission level to block the
SNMP agent from processing any requests from a specific
community.

Add new community. Pop-up SNMP Service Configuration
dialog opens, see Figure 144 on page 204.
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Field/Button Icon

Edit

Remove

Accept SNMP
packets

Add

Edit

Remove
Update
Start SNMP

Stop SNMP

Help

o WOW %

Operation

Click

Click

Select

Click

Click

Click
Click

Click

Click

Click

Description

Edit security settings for the community. Pop-up SNMP
Service Configuration dialog opens, see Figure 144 on page
204.

Remove community from list.

From all hosts means that the source host and list of
acceptable hosts are the source SNMP management system
and the list of acceptable management systems. No SNMP
packets are rejected on the basis of the name or address of
the source host or the list of acceptable hosts.

From these hosts means that the acceptable hosts enlisted the
acceptable SNMP management systems. When selected, only
SNMP packets received from the hosts in this list are
accepted. Otherwise, the SNMP message is rejected and an
authentication trap sent. This selection provides greater
security than using a community name, which might contain
many hosts.

Add new destination. Pop-up SNMP Service Configuration
dialog opens, see Figure 142 on page 202.

Edit destination. Pop-up SNMP Service Configuration dialog
opens, see Figure 142 on page 202.

Remove destination from list.

Save SNMP properties after edit.
Start SNMP service (active when SNMP service is stopped).
Stop SNMP service (active when SNMP service is started).

Open online help for the current pane.

_ If all the community names will be removed including the default name
41 CAUTION  <pyplic’, SNMP will not respond to any community names presented.

Figure 144 SNMP Service Configuration: Security

% SNMP Service Configuration

Community rights:

|NONE

Cammunity narme:

‘ Add ‘

‘ Cancel ‘
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Tools and Utilities

This chapter describes the Tools and Utilities used as a part of the Scalar DLC software.
The available tools are:

« Database Tool on page 206. Managing the database.

+ SCSI Target Port Tool on page 217. Managing SCSI Target Ports/Adapters.

+  Cluster Configurator Tool on page 219. Making cluster configuration.

» Problem Report Tool on page 220. Preparing report issues for ATAC in case of unusual problems.

+ Log Viewer Utility on page 221. Viewing the Scalar DLC log.

« Trace Manager Utility on page 226. Configuring the Scalar DLC trace.
« Trace Viewer Utility on page 230. Tracing the Scalar DLC.

+ Scalar DLC Software Licensing on page 232. Requesting and/or installing the Scalar DLC software
license.
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Database Tool

To launch the tool, right-click on Scalar DLC status icon, or launch a shortcut: Start > Programs > ADIC

Distributed Library Controller > Scalar DLC DB Tool.

This tool can execute a backup, a compact or a restore of a database, as well as create schedules for the
backup and compact jobs. The following functions are offered:

+ Database Backup on page 207 is for setting up the automatic database backup or executing a

manual backup.

+ Extended Mode on page 209 is for setting up the database recovery mode and setting up the

transaction logs backup.

+ Database Compact on page 212 is for setting up the database compact or executing the same

operation manually.

+ Database Restore on page 214 is for restoring the database with or without ttransaction logs from

a regular backup, or restoring the database and transaction log from device (file).

+ Database Save on page 216 is for saving the database archive excluding the temporary data.

The DB Tool requires a separate log on, as shown in Figure 145.

Figure 145 Log On Dialog

List
SQL Server
Database

User

Password

Integrated
security

OK

Cancel

206

Scalar DLC DB Logon

SOL Server

Databasze:

Wzer

Fassword:

Operation

Enter
Enter
Supplied
Enter
Supplied
Enter

Check

Do not check

Click
Click

The SQL server name.

x|
[ocalhost]
|sDLC
¥ Integrated security
|sa
Cancel |
Description

The database name, ‘SDLC’ by default.

SQL user with the admin rights (disabled for the trusted connection).

SQL user password (disabled for the trusted connection).

The user tries to access the database via trusted connection.

The SQL Server admin name & password are to be specified.

Log on.

Clear the dialog and end the process.
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@ Note PC administrator rights are required to log on the SQL database via the trusted
connection.

After the password is accepted and verified, the Backup dialog appears. Refer to Database Backup on page
207.

Database Backup

Figure 146 Database Backup
']j:l'ScaIarDLE Database Service Tool N [=E

Backup | Extended model Cnmpactl Heslorel Save I

Database: ISDL':

—Automatic backup

Destination
IE:'\F'rogram Files\Microzaoft SGL ServerstSSOLAE ackuphSDLC _backup |

[ Time-generated file names

Schedule
Occurs every 1 day(z), at 07:00 Ak

¥ Enable schedule

¢ Database - Complete
Apply Remove

— Manual backup

Destination
Execute |
Exit |
List Operation Description
Database Supplied The original database name.
Automatic backup The automatic (scheduled) backup settings.
Destination Supplied The backup destination file.
The “...“ button on the left can be used to change the backup
folder and enter the file name manually.
Time-generated Check If the box is checked, the name of the backup file will end with
file names the backup date in typical SQL format
(YYYYMMDDHHMMSS).
Schedule Supplied Schedule the automatic backup task. See Figure 147 on page
208.
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List Operation
Enable schedule Check
Database - complete  Supplied
Apply Click
Remove Click
Maunal backup
Destination Supplied
Execute Click
Exit Click

Figure 147 Backup Schedule Dialog
Edit Recurring Job Schedule

Description

The schedule is applied only if this box is checked.
Only complete backup is supported in current version.
Apply automatic backup settings.

Remove automatic backup job settings.
After remove, all backup settings are lost and the backup must
be configured again.

The manual backup settings.

The backup destination file.
The “...“ button on the left can be used to change the backup
folder and enter the file name manually.

Execute the backup to a file.

Exit the dialog without applying any changes.

Job Mame: [SDILCRackURDEob

— Doours Wiaekp
£ Daip Every I1 j week(s] on
& wfeekly [T Mon Miug [ wed I Thur [ Fi
™ Monthly [ Sat [ Sun

r— Daily frequency

" Dcours every

% Oecuws once at |'|2:DD A j
|1 j [Roufs) =] Statingjat |12;uu M=

Ending at |11:59 PR j

r— Dwration

Start date: | Thu 23;’10.:"2003;I

" End date: IWed 2541042003 j

% Noend date

o]

Cancel

List Operation
Job Name Supplied
Occurs Select

Description

The original Job name for Backup.

A daily backup.

A weekly backup.

A monthly backup.
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List Operation Description

Daily/ Select Daily specifies the job execution days.

Weekly/ . . . .

Monthly Weekly specifies how often (in weeks) and the day for job execution.
Monthly specifies how often each month or the exact day of each
month.

Daily Click The single time or period of occurrence.

Frequency

Duration Click The start and end date. The end date can be left unspecified.

OK Click Accept the input and exit.

Cancel Click Clear the dialog and exit.

@ Note Always schedule different jobs at different times so that they do not overlap and will not

conflict with each other.

Extended Mode

The Extended mode page is created to set up the database recovery mode and the log backup schedule.

Figure 148 Database Extended Mode Dialog

jj]'ScaIarDLE Database Service Tool _ |D|ﬂ

Backup Extended mode | Cnmpactl Hestorel Save I

[ Full recoveny mode

—Automatic tranzaction log backup

Destination

Database:  |SDLC

IE:'\F‘IDgram Filez\Microzoft SGL ServertMSSOLAB ackuphSOLE_backuplog |

Scheduls

Occurs every 1 day(z), at 01:00 &k [

¥ Enable schedule

Apply | Cancel |

Enit |
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List Operation Description

Database Supplied The original database name.

Full recovery mode Do not check  In full recovery mode the database is back up with all its logs
which dramatically increase the size of backup file. Use this
mode with caution only.

Automatic transaction log backup The database log backup settings.

Destination Supplied The log backup destination file.
The “...“ button on the left can be used to change the log
backup folder and enter the file name manually.

Schedule Supplied Schedule the automatic log backup task. See Figure 149 on
page 210.

Enable schedule Check The schedule is applied only if this box is checked.

Apply Click Accept the input.

Cancel Click Clear the dialog.

Exit Click Close the dialog without saving the input.

Figure 149 Backup Log Schedule Dialog
Edit Recurring Job Schedule x|

Job Mame:  [SDLCBackUpDELogJob

— Docurs Wweekly
|1 =
 Dally Evwery = week(z] on
& eekly [T Mon Miiug [ wed I Thur [ Fii
" Monthly I~ 5a T Sun

— Daily frequency

- - A

& Dcours once at |12.EIEI AW =

" Decours every I1 j IHUUT[S] 'I Starting at: |'|2ZUU A j
Ending at: |11:59 Fhd j‘

— Duration

Start date; I Thu 23410/2003 j " End date: Iwed 23M0/2003 j

' Mo end date

Ok I Cancel
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List
Job Name

Occurs

Daily/
Weekly/
Monthly

Daily
Frequency

Duration
OK

Cancel

4 Note

T4 Note

Operation

Supplied

Select

Select

Click

Click
Click
Click

Description

The original Job name for Backup Logs.

A daily backup.

A weekly backup.

A monthly backup.

Daily specifies the job execution days.

Weekly specifies how often (in weeks) and the day for job execution.

Monthly specifies how often each month or the exact day of each
month.

The single time or period of occurrence.

The start and end date. The end date can be left unspecified.
Accept the input and exit.

Clear the dialog and exit.

It is recommended to set the log backup rate higher as the database backup rate. For
example, if the database backup is scheduled onse a day, then schedule the database
transaction logs backup to one an hour or so.

Always schedule different jobs at different times so that they do not overlap and will not
conflict with each other.

Scalar DLC Reference Guide

211



Database Compact

This feature reduces the Scalar DLC database file size to save the disk space and increase the database
usability. The Compact Database operation can be executed only when the Scalar DLC software is stopped.
Any attempt to execute the operation when the Scalar DLC software is working shall cause an error
message.

Figure 150 Database Compact Dialog
']j:l'ScaIarDLE Database Service Tool _ |D|l|

Backupl Extended mode  Compact | Heslorel Save I

Database:  |SDLC

Command

DBCC SHRINKDATABASE ([SDLC])

Execute |
Schedule
¥ Schedule J
Aol | LCanze| |
Exit |
List Operation Description
Database Supplied The original database name.
Command Supplied The command associated with the compact.
Execute Click Immediate execution of the command.
Schedule Check Schedule the compact task. See Figure 151 on page 213.
Apply Click Accept the input.
Cancel Click Clear the dialog.
Exit Click Close the dialog without saving the input.
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Figure 151 Compact Schedule Dialog

List
Job Name

Occurs

Daily/
Weekly/
Monthly

Daily
Frequency

Duration
OK

Cancel

£ Note

Edit Recurring Job Schedule x|

Job Mame:  |SDLCCompactDEJob

— Oeocurs

 weekly

' FMonthly

D aily

Every |1—j day(s]

— Daily frequency

- - A
% Oocurs once at |D2.EIEI AW =
" Decours every I1 j IHUUT[S] 'I Starting at: IDE:UUJ’-\Mﬂ

Ending at: |11:59 Fhd j‘

— Duration

Start date; I Fri 17/10/2003 j " End date: Iwed 23M0/2003 j

' Mo end date

Ok I Cancel

Operation

Supplied

Select

Select

Click

Click
Click
Click

Description

The original Job name for Compact.

A daily compact.

A weekly compact.

A monthly compact.

Daily specifies the job execution days.

Weekly specifies how often (in weeks) and the day for job execution.

Monthly specifies how often each month or the exact day of each
month.

Establish either the single time or period of occurrence.

Set the start and end date. The end date can be left unspecified.
Accept the input and exit.

Clear the dialog and exit.

Always schedule different jobs at different times so that they do not overlap and will not
conflict with each other.
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Database Restore

This feature imports the Scalar DLC database contents either from the regular backup (databases, see
Figure 152) or external file (disk, see Figure 153 on page 215). The Restore Database command can be
executed only when the Scalar DLC software is stopped. Any attempt to execute the operation when the
Scalar DLC software is working shall cause an error message.

Restoring database from backup can also include restoring all transaction logs so not only the configuration
but the latest command list will be restored, too.

Figure 152 Database Restore Dialog (by backup)
']j:l'ScaIarDLE Database Service Tool _ |D|l|

Backupl Extended model Compact  Restore |Save I

D atabaze: ISDLC

" From device

Restare

Databaze backups

Id | Backup date | Size| Backup name |

2 13 Dec 2005 01:00:06:000 11362816 SDLCBackUpDBJab

1 12 Dec 2005 13:00:25:000 B131776  SDLC InstalledBackup
Tranzaction log backups [ Restore with logs

— Device Mame

IC:\F’rogram Filez\Mizrozaft SAL ServerstSSALBackuphSDLC_backup |
— Logizal file name tove ta physical file name

JsOLE |C:\Pragram Files\Miciosait SOL ServerMS50
|5DLE log |C:\Pragram Files\Miciosait SOL ServerMS50

Restare |

Exit

List Operation Description

Database Supplied The original database name.

Restore Select Database is for restoring database by previous backup. See Figure
152.
From Device is for restoring database from file. See Figure 153 on
page 215.

Database Select ID The backup ID.

backups ,
Backup date The date and time of the database backup.
Size Database size.
Backup name The backup set name.
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List

Restore with
logs

Transaction
log backups

Restore from
file

Restore

Exit

Operation

Check

Select

Select

Click
Click

Description

Restore the database with transaction logs if checked.

ID
Backup date

Size
Backup name

Device Name

Logical file name

Move to physical file

name

The backup ID.

The date and time of the transaction log
backup.

Transaction log size.
The transaction log set name.

The name of device (file) to restore the
database.

The device (file) to restore database from.

The path to the existing database files.

The file names to restore the database (DB

and transaction log) can be entered manually.

Accept the input and restore the database.

Close the dialog.

Figure 153 Database Restore Dialog (restore from device)

}i} ScalarDLC Database Service Tool

Backupl Extended model Compact Restore |Save I

Restore

Databasze:

" Database

Databaze backups

=101 %]

ISDLC

% From device

Id |Backup date |

Size | Backup hame |

? 12 Dec
1 12 Dec 2005 1.3:00: 25:000

05 071 00 0&; Qo0

Tranzaction log backups

E SDLCBackUpDBJob
BIATFFE  SDLC_InstalledB ackup

[ Restore with logs

— Device Mame

IC: “Program FileshMicrozoft SGL ServersMSS0LMB ackuphSDLC_backup

— Logical file name

tove to phyzical file name

|sDLC

IE:'\F'rogram Filas\Microzaft SAL ServersMS5E

|5DLC_lag

IE:'\F'rogram Files\Microzaft SGL ServerstS50E

Restare |
_ Bk |

Enit
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Database Save

This feature creates the archive with the Scalar DLC database backup contents and saves the archive to
the destination specified. The database backup however holds only sufficient information, without
temporary data (notifications, moves executed, etc.). See Table 26.

Table 26 Database Archive
Data description Saved
Physical libraries data, statistics, media rules, partitions, logical libraries Yes
Logical library statistics, pools, mailboxes, drives, cartridges Yes
Clients, client interface settings, reserve and define ranges, aliasing Yes
Move commands history, list of notifications sent No
Users and user settings, registration info; Notification rules, tickets, SNMP settings Yes

Figure 154 Database Save Dialog

List
Database
Destination
Save

Exit

216

}§j ScalarDLC Database Service Tool

Backupl Extended model Compact | Restore  Save

=101 ]

Database: ISDLC

Destination: I
Save |
Exit |
Operation Description
Supplied The original database name.
Enter The archive file destination.
Click Save database to archive.
Click Close the dialog.
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SCSI Target Port Tool

To launch the tool, right-click on Scalar DLC status icon and select Tools > SCSI Target Port Tool.

The Scalar DLC SCSI Target Port Tool is designed for operating the system SCSI Target ports. If the SCSI
port is currently in Target mode and the customer wants to change it to Initiator, the port must be disabled
as Target before enabling it as Initiator. This operation is executed via the SCSI Target Port Tool.

Immediately after the Scalar DLC software and the Target drivers are installed, the SCSI Target ports can
be disabled. To make them operational, enable the ports via the SCSI Target Port tool.

_ Enable only the ports that should operate in Target mode. An attempt to use
A1y CAUTION  the Initiator port as a Target may cause a system crash (for example, if the
hard disk is connected to the adapter, its port must work in Initiator mode.

@ Note Do not use two adapters of the same model in different operation modes (Initiator and
Target). Otherwise, it is possible to make a mistake and enable an Initiator as a Target.

After disabling the SCSI Target Port, launch the Device Manager and enable the SCSI port as an /nitiator.
Restart the system afterwards. Enabling a SCSI port as a Target can be done via the SCSI Target Port tool
(a reboot may be required).

Figure 155 SCSI Target Port Tool
£~ 5C51 Target Port Tool : |

Part list:

Fort | Tupe Befresh |
OLogic QLAZ2200 PCI Fibre Channel 4. Fibre

[OLogic OLA23xx PCl Fibre Channel Ad... Fibre Enatle |
Symbios Logic 875<5|D, 2280 PCI 5. Parall..
Dizahle |

1| | ] Exit |

List Operation Description
Port list Select Port is the port full name.
Type is a port type.

Status is a port status (enabled/disabled).

Refresh Click Refresh the port list.

Enable Click Enable the disabled SCSI Target port.

Disable Click Disable the enabled SCSI Target port.

Advanced Click Advanced port settings (only for Fibre Channel ports). See Figure 156.
Exit Click Close the SCSI Target Port Tool.
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Figure 156 Advanced Port Settings

Parameter

Failover
mode

Virtual WWN
OK

Cancel

218

Operation

Check

Enter
Click
Click

Advanced FC port paramekters

irkual Wi

o]

Cahicel |

Description

Must be checked if the Scalar DLC failover (cluster) solution has been

installed.

Virtual world-wide name that identifies the port from outside.

Update and exit.
Exit without update.
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Cluster Configurator Tool

This tool should be used only for the Scalar DLC installed as a failover (cluster) solution.

Immediately after the Scalar DLC software is installed on both cluster nodes launch the cluster configurator
tool. It can be found on the Scalar DLC Installation CD with the following path:
Scalar DLC\Cluster\SDLC ClusterConfig.exe.

Figure 157 Cluster Configuration Utility: no configuration

Bl spLc Cluster Configurator [ x|

Cluster Information:

luster Mame: SDLC-CLUSTER

windows Wersion: 5.0

windows build number: 2135

Wendor identifier for the Cluster Service: Microsoft{R] Cluster service
Wersion of Service Pack: Service Pack 3

Cluster Hode 1: STUDY STATE: The node iz Up

Cluster Hode 2 LIBRARY STATE: The node iz Up

SOLC Cluster Regources not configured

kake SDILLC Cluster Configuration

Click Make SDLC Cluster Configuration to configure Scalar DLC software for a failover mode. When the
configuration is completed, the pop-up “Configuration created successfully“ window opens. Click OK to
return to the SDLC Cluster Configurator.

Figure 158 Cluster Configuration Utility: configuration complete
EllspLc Cluster Configurator

ﬂ Cluster Information:

Cluster Mame: SDLC-CLUSTER

windows Wersion: 5.0

windows build number: 2135

Wendor identifier for the Cluster Service: Microsoft{R] Cluster service
Wersion of Service Pack: Service Pack 3

Cluster Hode 1: STUDY STATE: The node iz Up

Cluster Hode 2 LIBRARY STATE: The node iz Up

SOLC Cluster Regources configured
Active MODE: STUDY
STATE: The resource is operational and functioning narmally

‘ Remowe SOLC Cluzster Configuration I

The Remove SDLC Cluster Configuration button should be used only to re-configure Scalar DLC
software from failover (cluster) to basic (non-cluster) mode. If this is executed on a cluster, the Scalar DLC
failover solution will not function. However, the Scalar DLC itself will work in a basic mode (as if it has been
installed on standalone PC).
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Problem Report Tool

To start the Report Tool launch a shortcut: Start > Programs > ADIC Distributed Library Controller >
Scalar DLC Problem Report Tool.

Figure 159 Problem Report Tool
E“ Scalar DLC problem Report Tool x|

To report a problem, provide the follawing
Froblem description:

Expected

Steps to reproduce the

Est |

Describe the problem step-by-step. Clarify what has been expected and what should be done to reproduce
the problem. Then press Create Report to save the report file on disk; the report file will include the entered
description, the system register, and so forth.

After the report file is saved, it can be sent to the ADIC customer support via email.
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Log Viewer Utility

To launch the tool, right-click on the Scalar DLC status icon and select Tools > Log Viewer.

Figure 160 Log Viewer Main Window

& 20030218-1.log - Log¥iewer I ]
File Wiew Service Cptions Help
D= 2|
Date | Tirme: | Command ... | Command 1D | Client | Class | Ohiject | Description -
024'18,!'2003 11:35:54,332  Swstem M System ScalarlOkDa DewADICSc... et element skakus, physical skart address
®2I18,|'2EIE|3 11:35:54,392  Swstem MIA System MN3SnmpCo...  WN3SnmpCo...  SNMP agent is not reqgistered
024'18,!'2003 11:35:54,533  Swstem M System ScalarlOkDa DewADICSc...  Read element skatus, robok ID01, changer
62,1'134'2003 11:35:54.693  Swstem MIA System ScalariokDd DevADICSc...  Get element skatus, physical skark address
024'18,!'2003 11:35:54,903  Swstem M System ScalarlOkDa DewADICSc...  Read element skatus, robok ID01, changer
ﬂznaxzuua 11:35:55,374  Svstem Mif System ScalariokDd DewADICSc.,..  Read element skatus, robok 1001, changer
62,1'134'2003 11:35:55.734 Swstem MIA System ScalariokDd DevADICSc...  Read element skatus, robat ID0 1, changer
024'18,!'2003 11:35:56,045  Swstem M System ScalarlOkDa DewADICSc...  Read element skatus, robok ID01, changer
62,1'134'2003 11:35:56,295  Swstem MIA System ScalariokDd DevADICSc...  Get element skatus, physical skark address
024'18,!'2003 11:35:56,455  Swstem M System ScalarlOKDA  DevADICSc... Read element status, robot ID 1, changer ~
62,1'134'2003 11:35:56.806  Swstem MIA System ScalariokDd DevADICSc...  Read element skatus, robat ID0 1, changer
024'18,!'2003 11:35:57. 146 Swstem M System ScalarlOkDa DewADICSc...  @et drive information, robok 1001
62,1'134'2003 11:36:58.117  Swstem MIA System PhrysLib LibADICSca...  Update element skatus, robat ID 2, update
024'18,!'2003 11:36:58,127  Swstem M System ScalarlOkDa DewADICSc...  Get element address assignment, robot ID
62,1'134'2003 11:36:58.237  Swstem MIA System ScalariokDd DevADICSc...  Get element skatus, physical skark address
024'18,!'2003 11:36:58,338  Swstem M System ScalarlOkDd DewADICSc...  Read element skatus, robok ID02, changer
62,1'134'2003 11:36:58.548 Swstem MIA System ScalariokDd DevADICSc...  Get element skatus, physical skark address
024'18,!'2003 11:36:58,708  Swstem M System ScalarlOkDd DewADICSc...  Read element skatus, robob D02, changer =
4 »
Ready [Event 141 142 event(s) O
Icon Name Description
Normal Information messages. They usually contain the description of successfully
0 executed operation.
Warning Warning messages. Something is not working as it should; however, there is
@ no danger. The Scalar DLC functions are enabled and the operation has
finished successfully.
Error Error messages. They typically contain the description of the operation that has
@ been canceled because of error. The error code and description are also
contained if they are known.
Critical Critical error messages associated with an error condition that could cause a
. failure software or system failure. An immediate action may be required.

The Log Viewer tool is designed to view the logs of Scalar DLC software operations if an error situation has
appeared and the error content is needed.

When an error occurs, find it in the log (for example, filter to show only errors), look by the command ID in
what object the first error has appeared and see the error description and error content by the code. Find
where and when the error appears and check the states of appropriate logical and physical libraries, robots,
and so forth, in the appropriate period of time. Analyze command type, object, and client fields.

In some cases however the log itself does not contain sufficient information to reproduce the problem. The
client database may be required. Open Start > Programs > ADIC Distributed Library Controller > Scalar
DLC DB Tool, select Backup tab, save it to a specified location (see Figure 146 on page 207) and send the
file via email.
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The command tracking feature easies the search for an error. See Figure 161 for the illustration and Table
27 on page 223 for the feature description.

Figure 161 Log Viewer: Command Tracking
7 20051127-1.log - Scalar DLC log viewer - |D|ﬂ

File Wiew Service Cptions Help

O T T K| 7
Date | Tirme | Command bype | Command ID | Client | Class | Object | Description ﬂ

oE?.ll.ZDDS 1937:12,730  DRIVESTATU... 43782 woid DasClient woid Starked: client="id' drive="
02?.11.2005 19:37:13.386 DRIVESTATU... 43752 Woid DasRpc DASRpC Finished: code=0 message="

02?. 11,2005 19:37:31.120  VIEW (DAS) 43765 Turmnail DasClient Turmnail Started: volser="0A0307" media t
o2?. 11,2005 1903731917 VIEW (DAS) 43785 Turmaoil DasRpc DASHpo Finished: code=0 message="
02?. 11,2005 19:37:31.932 DRIVESTATU... 43736 Turmail DasClient Turmail Starked: client="Turmaoil' drive="
o2?. 11,2005 19:37:32.651 DRIVESTATU... 43786 Turmaoil DasRpc DASHpo Finished: code=0 message="

i ] Turnnail
ﬂfn 11 9Nnc A0S CE SN MTEWAY S n st +eranil
‘ ]

L3
Ready [Event 36743 [41338 eventis) | [MUM 4
Double-click on the log message to display the event context (see Figure 162).

Figure 162 View Event

¥iew event i ll

Date: 12022003 Time:  17:52:02.899

o Command type: b aunt [JEMWEL)
Command [0 33 Client:  admin

Clazz: AmlS Object: LiBADICScalar_1000111111111

Dezcription:

tMaove cartridge to element, cartridge index 43, destination element index 436, d
robat 1D 0, invert Hag 0

I

[rata:

The menu operations available in Log Viewer Utility are shown in Table 27 on page 223. Note that some
operations are also available via the tool bar buttons and/or keyboard shortcuts.
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Table 27 Log Viewer Operations

Menu Description Button Shortcut

File » Current - open the current (latest) Scalar DLC log file <Ctrl+C>
in its default location. D

» Open - browse for the log. <Ctrl+O>
']
[

» Exit - close the Log viewer tool.

View » Current event context - open the detalis for the <Enter>
selected event (see Figure 162 on page 222).

« Show/hide tool bar - show or hide the toolbar.

« Show/hide status bar - show or hide the status bar.

* Refresh - refresh the current log. <F5>
Service * Result description, as indicated by Figure 163 on
page 224 - lookup for the error code description.
» Search, as shown in Figure 164 on page 224 - search <Ctrl+F3>
engine.
» Search next - search for the same item again. <F3>
» Goto event, as shown in Figure 165 on page 224 - go <F4>

to certain event.

» Track active item / stop tracking - track the command
of the selected event. All events for the command will Ta
be shown in light-green color.

Selecting another event in the log results the tracking
of another command.
Click the button again to stop tracking.

« Track item / stop tracking - select the event to track. <Ctrl+A>
All events for the command will be shown in light- T
green color.

Selecting another event will NOT move the tracking.
Click the button again to stop tracking.

» Track secondary item / stop tracking - select the <Ctrl+D>
secondary event to track (when it is required to track T
more that one command). All events for the secondary
command will be shown in dark-yellow color, then in
blue, then in pink (see Figure 161 on page 222).
Tracing only up to three seconrary commands is
allowed (tracking the fourth command results
removing the tracking of the first one).

Selecting another event will NOT move the tracking.
Click the button again to stop tracking.

» Cancel tracking - stop all tracking.

Options * Logging, as shown in Figure 166 on page 224

* Filtering, as shown in Figure 167 on page 225.

* Viewing, as shown in Figure 168 on page 225.

Help * About - Log Viewer current version.
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Figure 163 Result Description

Query result ff x|

0 —
LCancel |

Enter the error number (for example, 0x00000005) and click Lookup to see the error content (in the

example code, Access is denied).

Figure 164 Search

Shring:

|

Direction: Iann "I [T Case senzitive LCancel |

Typical search engine. Enter the string to find, specify options and click Search.

Figure 165 Goto Event

Ewent number: IE ::I Go I
LCancel |

The Goto event pane allows user to jump on event with the specified number.

Figure 166 Logging Options

List
Log path

Age limit,
days

Size limit, KB

Extended
SCSl log

OK

Cancel

224

Operation

Supplied

Enter

Enter

Do not check

Click
Click

Logging options |

Log path: |I::'\F'mgram Filez'\ADICASDLC Y S Log
Age limit, days:

Siee limt, KB: [5120
Extended SCSI Lag [ Cancel |

Description

The log file path.

The age limit in days. Only natural numbers are allowed. All the log
files older than the age limit will be removed automatically at midnight.
“0” means “no age limit.”

The size limit in KB. Only natural numbers are allowed. If the log file
size exceeds the size limit, the new log file is created for current
session. “0” means “no size limit.”

When the box is checked, in no more than 180 sec all Scalar DLC
objects will log the extended SCSI data concerning executed operation
(CDB, command ID, etc.). The size ol log file greately increases, so
use this feature only when the SCSI communications work unstable
and there is needed to locate the weak phase.

Save the options and exit this pane.

Close the pane without saving the changed options.
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Figure 167 Filtering Options

Filtering options |
oK
¥ Show warning messages [
¥ Show emor messages
V¥ Show critical ermor messages
Description

List Operation

Show information messages = Check
Show warning messages Check
Show error messages Check
Show critical error messages  Check
OK Click
Cancel Click

Figure 168 Viewing Options

Yiewing options

Normal messages are shown.
Warning messages are shown.
Error messages are shown.
Critical error messages are shown.

Save the options and exit this pane.

Close the pane without saving the changed options.

LCancel

Check the box to auto-refresh the current log.
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Trace Manager Utility

To launch the tool, right-click on Scalar DLC status icon and select Tools > Trace Manager.

Trace Manager tool is designed for tracing the execution of Scalar DLC software objects.

_ Tracing the Scalar DLC slows its work as well as the work of client backup
A1\ CAUTION  gpplications that use the Scalar DLC as server software.
The higher is the configured trace level the slower is the work of the Scalar
DLC itself, so use the tracing feature only when needed.

Figure 169 Trace Manager Main Window

;. Trace manager = o ] A |
Scalar DLC started: | Yes  Tracing active: | Mo Start fime; | [
Description: |
r— Groups — Claszes — Objects
Client [ 1a1Client -
[ Conmnection [ amb
[1Device [ lamls
[Interface [ Cleantd anager

1M otification server
[ 1Phpzical library

CRequest M Database
[15ervice [ 1Devicetd anager
1 nknown [ 1DeviceSimulator
[ 1*firtual librany [ 1DriveControl LI
Lewvel .. I Level .. I Add.. |Eemnve| Level.. |
Start... I Stop I Update |thinns...|
Field/Button Operation Description
Scalar DLC started Supplied Shows Yes if the Scalar DLC is started, No if it is stopped.
Tracing Active Supplied Shows Yes if the Tracing process is started, No if it is not.
Start time Supplied Shows the start time and current time for the Tracing process.
Description Supplied Shows the description of current tracing process.
Groups Check The object groups list. If the selected group is checked, the
button Level becomes active.
Level Click Choose the sensitivity level for the tracing current group. See
Figure 170 on page 227.
Classes Check The object classes list. If the selected class is checked, the
Level button becomes active.
Level Click Choose the sensitivity level for the tracing current class. See
Figure 171 on page 227.
Objects Check The objects list. If the selected object is checked, the Level
button becomes active.
Add Click Adds the objects for tracing. See Figure 172 on page 228.
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Field/Button Operation Description

Remove Click Removes the objects from tracing list.

Level Click Chooses the sensitivity level for the tracing current object. See
Figure 174 on page 228.

Start Click Start the tracing. See Figure 175 on page 229.

Stop Click Stop the tracing.

Update Click Save the current trace manager options as default.

Options Click Show the trace manager options pane. See Figure 176 on
page 229.

Exit Click Close the pane without saving the changed options.

Figure 170 Group Level

Group level x|
Group: [Cliznt
Cancel
List Operation Description
Group Supplied Group name.
Level Select The sensitivity level where one is minimum and five is maximum.
OK Click Save the options and exit this pane.
Cancel Click Close the pane without saving the changed options.
Figure 171 Class Level
Class level el
Class: [Database
Cancel
List Operation Description
Class Supplied Class name.
Level Select The sensitivity level where one is minimum and five is maximum.
OK Click Saves the options and exit this pane.
Cancel Click Closes the pane without saving the changed options.
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Figure 172 Add Object

List Operation
Object Enter
Trace level Select
Add Click
Cancel Click
Existing Click

Figure 173 Add Existing Object

List Operation
Object list Select
OK Click
Cancel Click

Figure 174 Object Level

List Operation
Object Supplied
Level Select
Set Click
Cancel Click

228

Add object i x|

DObiject fi Add
Trace level: ILeveI'I VI
Enisting... |

Description

Object name.

The sensitivity level where one is minimum and five is maximum.

Add object and close the pane.

Close the pane without adding object.

Choose the existing object to trace. See Figure 173 on page 228.

Add existing object |
Add
Clignt1
Client2
DASRpe —lgame'
Database

DevaADICScalar 10001111111
DevaDICScalar_10KDATIFII:
DeviceManager

LibéDICS calar_10000171111111°
LibDICScalar 100011111111.%

Description

The objects to add.
Add the selected object.

Close the pane without adding the object.

Object trace level |

Object D atabaze
Trace level: |[RFEN] Cancel |

Description

Object name.

The sensitivity level where one is minimum and five is maximum.

Save the options and exit this pane.

Close the pane without saving the changed options.
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Figure 175 Start Tracing

Start tracing F x|

Desrciption: |

Start I LCancel |

List Operation Description
Description Enter The tracing description should be entered here.
Start Click Start the tracing process.

Cancel Click Close the pane without starting the tracing.

Figure 176 Tracing Options

Tracing options - x|

Common

Bath to folder for trace

b aximnurn zize for single trace file, KB: ID

[ Activate tracing at Scalar DLC start

0k I Cancel | Lpply |

List Operation
Path to folder for Enter
trace
Maximum size for Enter

single trace file, KB

Activate tracing at Check
Scalar DLC start

OK Click
Cancel Click
Apply Click
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Description

A trace path.
. .\ADIC\SDLC\WWW\Trace is the default path.

The size limit in KB is shown here. Natural numbers are
allowed only.

If the trace file size exceeds the size limit, the new trace file is
created for current session. ‘0’ means ‘no size limit’.

Check if the tracing should start automatically when Scalar
DLC supervisor starts.

Save options and close the pane.
Close the pane without saving options.

Set the current tracing options as default.
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Trace Viewer Utility

To launch the tool, right-click on Scalar DLC status icon and select Tools > Trace Viewer.

The Trace Viewer tool is designed for viewing the trace files generated by Trace Manager Utility on page
226 during execution of the Scalar DLC software.

Figure 177 Trace Viewer Main Window

1C2D780BABCDB40_1 - TraceYiewer =101 =]
File View Help
D= 2|
Date | Time | Level | Group | Class | Object Text |:|
n 18.02.2003 19:06:23.045 1 Service Database Database exiting CommitDETransaction()
n 13.02.2003 19:08:23.045 1 Service Database Database exiting PutConkesxk()
n 18.02.2003 19:06:23.045 1 Service Database Database in zetTemplateForObjectWithTexk()
n 13.02.2003 19:08:23.055 1 Service Database Database exiting GetTemplabeForObjectwith Texk)
n 18.02.2003 19:06:23.055 1 Service Database Database in zetTemplateForObjectWithTexk()
n 13.02,2003 1 Service Database Database exiting GetTemplabeForObjectwith Texk)
1 31 5 1 Database Database i
n 13.02.2003 19:08:23.035 1 Service Database Database exiking ListConkexkEx()
n 18.02.2003 19:06:23.085 1 Service Database Database in zetTemplateForObjectWithTexk()
n 13.02.2003 19:08:23.035 1 Service Database Database exiting GetTemplabeForObjectwith Texk)
n 18.02.2003 19:06:23.095 1 Service Database Database in et TemplateFarObject()
n 13.02.2003 19:08:23.095 1 Service Database Database exiting GetTemplabeForObieck()
n 18.02.2003 19:06:23.095 1 Service Database Database in TargetCartridgesList()
n 13.02.2003 19:08:23.105 1 Service Database Database exiting TargetCartridgesList()
n 18.02.2003 19:06:23.776 1 Service Database Database in ekSystemInformation)
n 13.02.2003 19:08:23.846 1 Service Database Database exiting GetSystemInformation]) =
“IQ o2 202 AG0a 73 fdl 1 Sarvica MNzakzkaca MNzakzkaca im rmakl ik seu™ j
MName | Data |
(2] et - in ListContextEx()
<raw data>
Ready [ i— -------- i— --------- i
Menu Description
File Typical trace-file operations: current, open, exit.
View Viewer options: show current record context using <Enter> (see Figure 178 on page
231), show tool bar, show status bar, refresh using <F5>.
Help Trace Viewer current version.

Double-click on the trace record to display the trace in a more detailed form (Figure 178 on page 231).
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Figure 178 View Trace Record

List Operation
Level Supplied
Date Supplied
Time Supplied
Group Supplied
Class Supplied
Object Supplied
Raw data Supplied

Named data  Supplied
Text Supplied
Close Click

Scalar DLC Reference Guide

Yiew trace record : |

Level [1 Date: 1B.02200% Time: | 505:23.06!

Group:  [Service

Clazs:  |Database

Object; |Database

Fiaw data I} Mamed data 1]

Text:

in ListContestE =[] =]

Description

The sensibility level needed to trace the event. The level is also shown

inside the color icon.
Record date.

Record time.

Group name.

Class name.

Object name.

The binary record data.
The text record data.
Record text.

Close the pane.
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Scalar DLC Software Licensing

The Scalar DLC software will run for a “grace period” of 30 days after installation without a license.
Thereafter, a license key is required to keep the software running. This key should be obtained by contacting
ATAC before the 30-days trial period expires.

To request a license, contact ADIC by either email or fax.
» Send the license request by email from the license application module.
» Print the license request text file, license.lic, and fax the file to ATAC at 1.303.792.0056.

The Licensing tool is used for both Scalar DLC Basic solution (Standard License on page 232 and Failover
solution (Cluster License on page 237).

Standard License

Refer to Obtaining License on page 232 to request a Scalar DLC license.

The license request can be sent either by email or fax. For a fax, the file is located at
<%SystemDrive%>\Program Files\ADIC\SDLC\docs\license.lic.

Once the license request is received and is validated by ADIC, a license string is sent back to the sender to
be entered into Scalar DLC software.

Refer to Installing License on page 236 for registering the Scalar DLC license.

Obtaining License

The Scalar DLC license request can be resolved in one of two ways. During the installation process, execute
the ADIC Licensing application and click Request.

The Licensing dialog is also available through Start > Programs > ADIC Distributed Library Controller
> ADIC Licensing.

Figure 179 Licensing Dialog

E’ﬂADIE Software LicenseWizard - Z' x|

License Operations

Reguest alicenze

Inztall a license Reqister... |

Cancel |  About. |
List Operation Description
Request Click Request a license string. See Figure 181 on page 233.
Register Click Install the license string. See Figure 185 on page 236.
Cancel Click Clear the dialog and exit.
About Click Provide a brief description of the license wizard. See Figure 180 on

page 233.
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Figure 180 About License

At the first step of License request process the customer must choose the license request file.

About ADIC Software LicenseWizard x|

ADIC Software License wizard

Wergion 1.2
Capyright [C] 1957-2002 ADIC, Ine.

Figure 181 License Request File

ADIC Software LicenseWizard - Step 2 of 4 ﬂ

Enter the name of the licenze reguest file that you want to send to ADIC customer support.

License Request Filz

C:Program Files'ADICASDLChdocsh Browsze... |

< Back | Mext » I

List Operation
License Enter
Request File
Browse Click
Back Click
Next Click
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Description

The license request file name and path. The default file is
<%SystemDrive%>\Program
Files\ADIC\SDLC\docs\license.lic

Browse for the license request file.
Return to the previous dialog

Open the next dialog pane.
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The next step is the Licensing Review.

Figure 182 Licensing Review
ADIC Software LicenseWizard - Step 3 of 4 x|

2413/2003  1:53 PM

r— Product Information

- Product
Scalar DLC Wersion  2.4.0002 Serial IDLE1 2345

r— Customer [nformation

Company: Iorganization Contact: Iuser
Address: Email:

Fhone: I
¥ Flease add me ta the ADIC mailing izt Fax: I

—windows MT Suppart Information

35;::"9 [windows 2000 -] sewicePack [ -]
Libraries:  |ADIC Scalar 10K 4
< Back Cear | [ SaveFieOny |  SendEmai> |
List Operation Description
Product Information Supplied Scalar DLC version is shown here.
Product Serial # Enter Scalar DLC serial number.
Customer Information  Supplied Customer information obtained from Scalar DLC Database.
Company Supplied Company name.
Address Supplied Company address.
Contact Supplied Contact person.
Email Supplied Contact email address.
Phone Supplied Contact phone number.
Fax Supplied Contact fax number.
ADIC mailing list Supplied Add user to the ADIC mailing list.
Support Information Supplied Windows NT/2000/2003 Support Information.
Operating System Supplied Operating system version.
Service Pack Supplied Service pack currently installed.
Libraries Supplied Licensed ADIC libraries.
Back Click Return to the previous dialog.
Clear Click Clear all editable fields.
Save File Only Click nge license request to file and exit. See Figure 184 on page
5.
Send Email Click Send license request to ADIC via email. See Figure 183.

234 Tools and Utilities



/1\, CAUTION

Changing the editable fields is possible, but not recommended.

Figure 183 Send License via Email

ADIC Software LicenseWizard x|
teszage header

To: Itechsup@adic.com

Fram: I

Subject: ICustnmer licensze reguest

SMTF Server I

List Operation Description

Message header Supplied Email parameters for sending email.
To Enter Email receiver. ADIC technical support is the default.
From Enter Sender email. Contact email is the default.
Subject Enter Email subject. Customer license request is the default.
SMTP server Enter SMTP server name.
Port Enter SMTP port.
Back Click Return to the previous dialog
Send Click Send email and finish. See Figure 184.

/1, CAUTION

Figure 184 Licensing Before Installation
ADIC Software LicenseWizard - Step 4 of 4 ﬂ

Changing the editable fields is possible, but not recommended.

That'z all Remember to submit the Lizense Change Request to ADIC

if you didn't do 2o in the previous step. [t will take approzimately 2 days for
ADIC customer support bo regpond to pour request, Once confirmed,

we'll zend you a new licenze file and you'll have to run this Wizard again to

reqister the changes to your system.

Thank-you for pour support,

Finish
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Installing License

After obtaining the License string from ADIC Technical support, perform the following:
Step 1 Before applying the license make sure the Scalar DLC service is stopped.

Step 2 Launch ADIC Licensing through Start > Programs > ADIC Distributed Library Controller >
ADIC Licensing. See Figure 179 on page 232.

Step 3 Press Register. The Register wizard starts with the Authorization string dialog. See Figure 185.
Step 4 Follow the steps as they are described.
Step 5 Restart the Scalar DLC supervisor for the changes to take effect.

Figure 185 Authorization String
ADIC Software LicenseWizard - Step 2 of 4 =l

— Inztallation Infarmation

Enter the Autharization String that you received from ADIC customer suppart:

Enter the Serial Mumber that iz on the product package:

IDLC1 2345

< Back | et = I

List Operation Description
Authorization string Enter The authorization string must be entered here.
Serial number Enter The Scalar DLC serial number must be entered here.
Back Click Return to the previous dialog.
Next Click Open the next dialog pane. See Figure 186.

Figure 186 Time-based License
ADIC Software LicenseWizard - Time-based lic x|

Please verify that the information below is commect,

IF it is not correct, pleaze contact ADIC Custamer Support,

Temparary Time-bazed License

Duration: IE Months

‘@ Note Although the typical ADIC license is permanent, it may be only time-based. This means
that after the specified period of time, the Scalar DLC software will not function unless a
new license is installed.
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List
Duration
Back
Next

Figure 187

4 Note

Operation Description

Supplied The Scalar DLC software duration period (months).
Click Return to the previous dialog.
Click Open the next dialog pane. See Figure 187.

Finishing License
ADIC Software LicenseWizard - Step 4 of 4 : =l

That'z all Click Finish to register the new licensze,

Changes will be effective immediately.

fbot | Finish |

When the license is installed, the tape device must be online. Otherwise, the license will
not be applied.

After the license string is installed, restart the Scalar DLC service for the

£¥\ CAUTION  changes to take effect.

Cluster

License

Although there is no special license wizard for Scalar DLC Failover solution, a special sequence must be
performed in order to install the license for the cluster.

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Start Scalar DLC software on Node1. Request the license. Refer to Obtaining License on page
232.

Send the license request file to ADIC customer support. The authorization string (stringl) will
be returned.

Change the active node to Node2. Request the license here as well. Refer to Obtaining License
on page 232.

Send the license request file to ADIC customer support. The authorization string (string2,
different from stringl) will be returned.

Register the license on Node1 with the stringl. Refer to Installing License on page 236. Take
the Scalar DLC supervisor offline, so the active node will be changed to Node2.

Register the license on Node2 with the string2. Refer to Installing License on page 236. Take
the Scalar DLC supervisor offline, so the active node will be changed back to Node1.
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Application Notes

This topic contains the following important information.

* Glossary on page 239 provides the glossary of significant terms.

» Element Addressing on page 244 describes the element addressing.

» Application Notes on page 245 shows the media and element types and enlists the error codes.

Glossary

Table below contains all specific terms used throughout the document and their brief explanation.

Table 28 Terms

Term Explanation

The hardware (card) for the SCSI or FC connection. Also required for the
connection between the Scalar DLC host and the tape device.

Adapter The adapter for the library connection operates in the /nitiator mode. The client
connection requires that the adapter(s) operating mode should be Target.
admin The default Scalar DLC user who has an Admin access level.
. The Scalar DLC user level with the greatest access rights.
Admin

Also refer to Administrator.

Local Administrator or Domain Administrator is the access right granted to the

Administrator Windows 2000/2003 user. Contact the network administrator for details.

aisle Same as Robot.
atac The default Scalar DLC user with CE access level. Cannot be removed.
ATAC ADIC Technical Support Center. The customers should contact ATAC in case

of any problems.

The label on cartridge where its name (volser) is written. Also usually contains

Barcode the cartridge media type (for example, 3590).

Barcode reader The built-in robotic device that scans the cartridge barcode.
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Table 28  Terms (Continued)

Term Explanation
Cartridge Typically means Data cartridge.
CE The Management GUI user level with the rights of ticket manipulation. Also
refer to Customer engineer.
A logical set of cleaning cartridges (single media type only). It should be
Clean pool assigned to the appropriate drive to perform the drive cleaning operation,

either manually or automatic.

Cleaning cartridge

The tool that has overall dimensions of a data cartridge that performs the drive
cleaning operations.

Cleaning medium

Same as Cleaning cartridge.

Client

Either a person or backup application that is connected to the Scalar DLC via
the client interface. Each client is assigned to a logical library, and from the
client side this library appears as the actual device.

Client interface

The method of the client-send and client-received commands interpretation.
Three client interfaces are available: SCS/, DAS, and ROBAR.

Command log

The list of commands executed by the Physical library.

Customer engineer

A person (usually from ATAC) that is responsible for the service maintenance.

The application provided by ADIC that represents the client part of the DAS

dasadmin interface, as well as the Scalar DLC software that represents the server part.
Distributed Automatic media library Server. A widely used client interface.
DAS Requires only valid TCP/IP connection between server (Scalar DLC host) and

client PC.

Data cartridge

The data carrier. Depending on the media type, it provides a different amount
of data (for example, LTO cartridge can hold up to 10 Gb).

The operation of moving a single cartridge from drive to a home position. Some

Dismount drive models require Unload to be executed before this operation.
Drive The slot designed to temporary store a data cartridge and execute read/write
operations from/to it.
Drive slot Same as Drive.
. The physical library with two robots. Contains at least one storage tower that
Dual-aisle
can be accessed by both robots.
EIF, E/NIF Export/Import Frame. Same as Mailbox.
Eiect The operation of move the cartridge(s) from storage or drive to Mailbox. Each
] cartridge will be either gjected or unloaded.
Element Same as Slot.
Error log The list of errors that the Physical library has encountered.
Event Any action performed by the Scalar DLC, for example, “move medium” or “start
the software service®. Every event is shown in the Scalar DLC log.
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Table 28

Terms (Continued)

Term

Explanation

Event notification

When the specific event has occurred, the Scalar DLC can sent an appropriate
message to the customer via email or Management GUI. The message format
depends on the appropriate Event rule.

A pre-defined pattern that selects the specific event from all actions that have

Event rule occurred. It can also send a notification to the specified destination. See also
Event and Event notification.

Export Same as Eject.

FC Same as Fibre Channel.

Fibre Channel

An optical connection operating with the SCSI protocol. Currently has the
largest carrying capacity among all other interfaces and virtually no distance
limitations. Also refer to SCSI.

Generic Mount

The operation of loading a single cartridge into the first free drive of the
appropriate type. Also refer to Mount.

The list of notification messages visible to all users who are currently logged on

GUllog the Management GUI. No archive available.
Also called HACC/MVS. Host (Automatic) Control Component / Multiple Virtual
HCC/MVS Storage. Some installations use this software solution on MVS platforms in

addition to the ROBAR client.

Home position

The slot (typically a storage slot) where the cartridge will be automatically
returned after Insert and Dismount commands are executed.

Input/Output unit. The device that contains a pack of insert/eject slots which

/0 unit can be accessed from outside the library only as a single unit. The physical
library usually contain several I/O units.

Import Same as Insert.

Insert The operation that moves the cartridge(s) from the insert/eject area to the

storage area. Each cartridge is placed into the home position.

Insert/eject area

All available insert/eject (mailbox) slots in the library.

Insert/eject slot

The slot that serves as a temporary storage for a cartridge that should be either
placed into the library (insert operation) or removed from it (eject operation).

Interface adapter

Same as Adapter.

Library

1 Referto Logical library.
2 Refer to Physical library.

Library log

Refer to Command log and Error log.

Linear shelve

Same as Linear storage.

Linear storage

A device that consists of storage slots. If the library is dual-aisle, each linear
storage device can be accessed by one robot only.
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Table 28  Terms (Continued)
Term Explanation
Logical library The logical representation of the Physical library (or its part) as it can be seen

by the customer via the Client interface.

LSCI coordinate

The element (slot) physical coordinate in LSCI format (device-section-row-
column-position).

Logical Unit Number. Each LUN can represent a device for the client. That

LUN means after the configuration is complete the SCSI client will see the assigned
logical library as the SCSI device connected to a certain LUN.
Mailbox The logical set of insert/eject slots. Should be created in the Logical library to

represent its I/O unit.

Mailbox area

Same as Insert/eject area.

Mailbox slot

Same as Insert/eject slot.

Media domain

This characteristic indicates the cartridges that can be stored into the same
storage slot even if their media type is different (for example, both NCTP and
3590 cartridges are of the ‘half-inch’ domain). And vice versa: the media
domain characteristic indicates slots that could be the possible container for
the cartridge.

Media type

The cartridge characteristic that indicates its dimensions, capacity, etc.

Medium, media

Same as Cartridge.

Mount

The operation of loading a single cartridge into a drive.

Move

The operation of getting the cartridge from a target slot and putting it to the
destination slot. This operation can change the cartridge home position.

Multi-port adapter

Some models of the SCSI adapters have more than one port that can be used
to accept commands. The Management GUI shows any two-port adapter as
two single-port adapters, although it is physically single hardware.

Notification

Same as Event notification.

Offline cartridge

The cartridge that has been removed from the library and remains currently
only in the archive list.

Partition

The continuous range of slots that are of the same type (for example, Generic
DLT). A set of partitions must be assigned to the Logical library.

Physical library

The automated robotic device that serves as a cartridge store. It contains a
large number of slots where the cartridges can be inserted, and where the
robotic accessory (manipulator) moves cartridges from one slot to another.

Represents the SCSI Adapter in the Management GUI because every adapter

Port has the port that is configured to accept commands. See also Multi-port
adapter.
ROBAR ROBotic ARchive. Requires valid TCP/IP connection between server (Scalar
DLC host) and client PC.
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Table 28  Terms (Continued)
Term Explanation
The automatic system that consists of a manipulator that is moving back and
Robot forth as well as up and down on the rails to access all library slots and move

the cartridges from/to them. Also contains a Barcode reader to identify the
accessed cartridges.

Robotic accessor

Same as Robot.

Rule

Same as Event rule.

Scalar DLC log

The list of notification messages that describe the Scalar DLC working process.
Can be viewed from outside even when the Scalar DLC software itself is
stopped.

Scanner

Same as Barcode reader.

Scratch cartridge

The data cartridge that is considered as empty and ready-to-write.

Scratch medium

Same as Scratch cartridge.

Scratch pool

A logical set of scratch cartridges (single media type only). Each data cartridge
assigned to the scratch pool will be considered as scratch.

SCsi

Small Computer System Interface. A widely used interface with the large
carrying capacity. Requires additional hardware (SCSI adapter(s), cables, etc.)
and software (SCSI Target Mode driver).

SCSI coordinate

Element (slot) physical coordinate in SCSI format (0 - 65535).

Single-aisle

The Physical library with a single robot.

Single-port adapter

The Adapter that contains a single port to send/receive commands.

Slot

The part of the physical library that receives a cartridge. There are three
groups: Storage slot, Insert/eject slot (mailbox), and Drive.

Storage area

All available storage slots in the library.

Storage slot

The slot is designed to keep a cartridge as long as it is required.

Storage tower

A device that consists of storage slots. Its capacity is larger than of the linear
storage (for example, DLT-tower contains up to 18 rows of slots, and DLT-
shelve only 6).

If the library is dual-aisle, there always is at least one storage tower that can be
accessed by both robots and therefore called shared. However the tower can
be non-shared, too.

A synonym for Cartridge. All tapes are cartridges, however some cartridges are

Tape not tapes.
Tape device Same as Physical library.

Depending on the adapter properties, each Target has a number of LUNs. That
Target means each Target can be connected to this number of the devices, or

represent such a number of connected devices to the client as well.
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Table 28  Terms (Continued)
Term Explanation
Ticket Mostly a report issue. It is usually created by a customer who encounters a
problem and calls for ATAC help.
The operation of ejecting the cartridge from drive to prepare it for a move. Most
Unload . ) :
Scalar drives execute this command automatically.
A person that can log on the Scalar DLC Management GUI and monitor the
User commands to execute or perform certain operations manually. Different users
may have different access levels and/or different rights. Also refer to Admin
and Customer engineer.
The cartridge name (from “volume serial number®) as shown to the customer.
Volser Can also indicate the cartridge type (data/cleaning).

volsers.

The optical disks acting as two-side cartridges are represented with two

Element Addressing

The slots in the tape libraries are mapped to the SCSI elements of physical library by the Scalar DLC
physical library object. In the single-aisle libraries, the mapping is identical to the original picture.

Table 29 Element Mapping (Single-aisle libraries)
Section Robot1. Start Robot2. Start Scalar DLC St.art Physical
Coordinate Coordinate Coordinate
I/E 16 None 16
Drive 256 None 256
Storage 4096 None 4096

Figure 188 Element Addressing (single-aisle library)

Drives Storages
Robotl
coordinate I I I I I
16 256 4096
16 256 4096
Scalar DLC U U
Physical coordinate I I I I I
Drives Storages

In the dual-aisle libraries the picture is much more complicated.
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Table 30  Element Mapping (Dual-aisle libraries)

Section Robot1 Start Robot2 Start Scalar DLC Start Physical
Coordinate Coordinate Coordinate
16 None 1024 (Robot1 I/E)
I/E
None 16 2048 (Robot2 I/E)
256 None 4096 (Robot1 drives)
Drive
None 256 8192 (Robot2 drives)
None 32768 (Robot1 storage)
4096
Storage 16384 (shared storage)
4096
None 49152 (Robot2 storage)

Figure 189 Element Addressing (dual-aisle library)
16 IE 255 Drives 4095 Storages

I Robot2
coordinate
\ \ \15334 \
1024 IE1 ADQE Drives1 . 32?68 Sealar DLC
: “ I Physical

" 2043 E2 8192 Drives2 . Shared” 49152 coordinate
/ﬁT/ \ Storages2

| Robott
255 4096 coordinate

Drives Storages

16

IE

The Management GUI also indicates the LSCI coordinates used by ROBAR and (sometimes) DAS
software.

The LSCI coordinates consists of 5 character pairs. The first four characters signify the ‘name’ or the number
of the device. The third pair of characters signifies the column in which the position is located. The fourth
pair of characters signifies the row of the position and the last two characters show the position in this row.

These coordinates are mapped from the coordinates of the physical library by the following way:

» Device type and number (four symbols): for example, LW01 means ‘storage shelve number 1,
D006 means ‘drive number 6, etc.

*  Column-row-position (six digits): for drives always 000000, for other types of slots something like
011006 or 120804.

Example: the LSCI coordinate “LW02060210“ means “a slot that can be fount at storage shelve 2, rack 6,
column 2, position 10

Application Notes

This section holds various supplemental information concerning different parts of the Scalar DLC software
and clients as well.

* Media Types on page 246.
+ Storage Types on page 247.
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+ Mailbox Types on page 248.

« Drive Types on page 249.
» Error Codes on page 251.

Media Types

The Scalar DLC software and the client applications recognizes used media in different ways. Refer to Table
31.

@ Note The asterisk (*) means the medium is supported by the Scalar 1000 library. The plus (+)
means the medium is supported by the Scalar 10K and Scalar 10K DA libraries (this is
actually one tape library but two models: single- and dual-aisle).

Table 31 Media Types

Media Type
Media Manufacturer | Description Medl_a U_sed n
Domain Scalar Library
DAS AMU
DLC
3480 3M 0.5” tape Half- 3480 3480 Co *
inch
3490 3M 0.5” tape Half- 3480 3480 Co *
inch
3490E 3M 0.5” tape Half- 3490E 3480 Co *
inch
NCTP Philips 0.5” tape Half- NCTP 3480 Co *
(Philip new inch
compatible
product)
DLT Digital Digital Linear | DLT DLT I DECDLT C1 *
Compac Tape
Tape Il
DLT Quantum Digital Linear | DLT DLT IV DECDLT C1 ¥+
Compac Tape
Tape IV
DLT Maxell Digital Linear | DLT DLT INXT DECDLT C1 *
Compac Tape
Tape llI
XT
Super Quantum Digital Linear | DLT SDLT DECDLT C1 ¥+
DLT Tape
3590 3M 0.5” tape Half- 3590 3590 Cc2 *
(NTP - New inch
tape product)
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Table 31 Media Types (Continued)
Media Type
Media Manufacturer | Description Med'? U§ed in
Domain Scalar Library
DAS AMU
DLC

3590E 3M 0.5” tape Half- 3590E 3590 Cc2 *+

(Condor inch

3590, double

capacity)
LTO1 Ultrium LTO L1 LTO LTO LTO C3 *+
LTO 2 Ultrium LTO L2 LTO LTO 2 LTO C3 ¥+
LTO 3 Ultrium LTO L3 LTO LTO 3 LTO C3 +
Super Quantum Digital Linear | DLT SDLT I DECDLT C5 *
DLT Il Tape
3592 RW | IBM 0.5” tape Half- 3592 R/W 3592 R/W C7 +

read/write inch
3592 RW | IBM 0.5” tape Half- 3592 short | 3592 R/W C7 +
short read/write, inch R/W

short
3592 IBM 0.5” tape Half- 3592 3592 Cc8 +
WORM write once / inch WORM WORM

read many
3592 IBM 0.5” tape Half- 3592 short | 3592 C8 +
WORM write once / inch WORM WORM
short read many,

short
SONY Sony 8mm tape 8mm AIT 8MM V1 ¥+
AIT
SONY Sony 8mm tape 8mm AIT 8MM V1 *+
AIT2
SONY Sony 8mm tape 8mm AIT 8MM V1 *+
AIT3

Storage Types

The different storage elements holds different media. Refer to Table 32 on page 248.

T4 Note

The asterisk (*) means the storage slot is supported by the Scalar 1000 library. The plus
(+) means the storage slot is supported by the Scalar 10K and Scalar 10K DA libraries
(this is actually one tape library but two models: single- and dual-aisle).
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Table 32

Storage Types

Storage Name

Manufacturer

Loaded Media (Scalar DLC type)

Used In Library

Generic DLT

ADIC

DLT 1l
DLT IV
DLT NIXT
SDLT
SDLT Il

* ot

Generic 8mm

Sony

AIT

LTO

IBM

LTO
LTO 2
LTO 3

Generic half-inch

ADIC

3480

3490E

3590

3590E

NCTP

3592 RW

3592 WORM
3592 short R/W
3592 short WORM

Mailbox Types

The different insert/eject elements holds different media Refer to Table 33.

@ Note The asterisk (*) means the mailbox slot is supported by the Scalar 1000 library. The plus
(+) means the mailbox slot is supported by the Scalar 10K and Scalar 10K DA libraries
(this is actually one tape library but two models: single- and dual-aisle).
Table 33  Mailbox Types
Mailbox Name Manufacturer Loaded Media Used In Library
Generic DLT I/E ADIC « DLTHI *+
* DLTIV
o DLT IIXT
 SDLT
+ SDLTII
Generic 8mm I/E Sony o AIT ¥+
LTO I/E IBM + LTO *+
+ LTO2
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Table 33  Mailbox Types

Mailbox Name Manufacturer Loaded Media Used In Library

Generic half-inch I/E | ADIC + 3480 *+
+ 3490E

+ 3590

+ 3590E

* NCTP

+ 3592 RW

+ 3592 WORM

+ 3592 short R/'W

+ 3592 short WORM

Drive Types

The different drives are recognized by the client applications in different ways. The different drives also
accepts different media. Refer to Table 34.

@ Note The asterisk (*) means the drive is supported by the Scalar 1000 library. The plus (+)
means the drive is supported by the Scalar 10K and Scalar 10K DA libraries (this is
actually one tape library but two models: single- and dual-aisle).

Table 34 Drive Types
Drive Type
Drive Name Manufacturer Lh:::;d Eis:r:\m
Scalar DLC DAS AMU i

HP LTO HP HP LTO LTO Drive D1 LTO a

IBM LTO1 IBM IBMLTO LTO Drive D1 LTO *+

IBM LTO1 Fibre IBM IBMLTO FC | LTO Drive D1 LTO +

Channel

IBM LTO2 SCSI IBM IBM LTO-2 LTO Drive D1 LTO *+

SCSI LTO 2

IBM LTO2 Fibre IBM IBM LTO-2 LTO Drive D1 LTO +

Channel FC LTO 2

IBM LTO3 SCSI IBM IBM LTO-3 LTO Drive D1 LTO +

SCsl LTO 2
LTO 3
IBM LTO3 Fibre IBM IBM LTO-3 LTO Drive D1 LTO +
Channel FC LTO 2
LTO 3
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Table 34  Drive Types (Continued)

Drive Type
Drive Name Manufacturer Lh:::;d Lli?beriln
Scalar DLC DAS AMU i
IBM 3592 IBM IBM 3592 IBM 3592 D6 |+« 3592 RW +
+ 3592
WORM
+ 3592 short
R/W
» 3592 short
WORM
Quantum DLT Quantum Quantum DLT (Low DG |+ DLTIV *
4000 with DCI DLT 4000 Profile) « DLT I
« DLT IXT
Quantum DLT Quantum Quantum DLT (Low DG |+ DLTIV *
7000 with DCI DLT 7000 Profile) « DLT I
« DLT IXT
Quantum DLT Quantum Quantum DLT (Low DG |+ DLTIV *
8000 with DCI DLT 7000 Profile) « DLT I
« DLT IXT
SONY AIT Drive Sony Sony SDX AIT drive DM |« AIT *+
(SDX 310) 310/500
SONY AIT2 Drive | Sony Sony SDX AIT2 drive DM |« AIT ¥+
(SDX 500) 310/500
SONY AIT3 Drive | Sony Sony SDX AIT3 Drive DM |« AIT *+
(SDX 700-C) 700-C
3590 Magstar IBM IBM 3590 IBM 3590 DN |+« 3590 *+
(Magstar) - 3590E
NCTP Drive Philips NCTP PhilipsLMS | DQ |+« NCTP *
(3490)
3480 Drive ADIC Philips 3610/ | PhilipsLMS | DQ |« 3480 *
ADIC 8490 (3490) « 3490E
8490 Drive ADIC Philips 3610/ | PhilipsLMS | DQ | » 3480 *
ADIC 8490 (3490) . 3490E
SDLT 220 Quantum Quantum DLT (Low DR |+ DLTIV *+
SDLT 220 Profile) - SDLT
SDLT 320 Quantum Quantum DLT (Low DR |+« DLTIV *+
SDLT 320 Profile) e SDLT
SDLT 600 Quantum Quantum Quantum DY |+ DLTIV *
SDLT 600 DLT . SDLT
« SDLTII

a. Currently used only in Scalar 100 Dell series.
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Error Codes

The Error Codes described in the Table 35 are used with the Rules Tab on page 179 and ATAC Calls Tab
on page 189.

Table 35 Error Codes

Error Code Description
0 No error
200 NULL
201 NULL
202 RPC problem
203 NULL
204 Unable to Recover
205 The robot is not ready (or switched off logically)
206 Request link failure
207 Invalid robot number
208 Invalid arguments
209 Invalid client name
210 Invalid request id
211 The request was canceled
212 General software failure
213 Invalid pool name in scr_info (use with scr_info only!)
214 The cartridge is in use
215 The accessor couldn't put a cartridge - inventory dst cell
216 The accessor couldn't get a cartridge - inventory src cell
217 General hardware problem
218 Physical problem with cartridge
219 Physical problem with drive
220 Unrecoverable hardware problem
221 The accessor couldn't put a cartridge and rejected it to IE station - inventory dst cell,
update IE station cells
222 The source cell is empty - update src cell, retry?
223 The destination cell if full - update dst cell, retry?
224 The door was opened and closed - do a complete inventory, retry
225 The insert/eject station was opened and closed - update |E station cells, retry
226 Unexpected hardware failure - retry
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Table 35  Error Codes (Continued)

Error Code Description

227 Invalid volser
228 Invalid drive name
229 The drive is in use
230 Prowler is not active
231 Invalid area name
232 The dynamic area became full, insertion stopped
233 The drive is allocated for another client
234 The cartridge is not mounted
235 The cartridge belongs to another pool
236 The drive is in cleaning
237 Invalid pool name
238 The area is full (occurs during ejecting)
239 The drive is allocated exclusively for another client
240 One or more coordinates are wrong
241 The area is empty?
242 Barcode read error
243 The client is not authorized to make this request
244 No drive available to do generic mount
245 No available cleaning cartridge to clean the drive
246 Media type doesn't match the volser
247 Library needs teaching - need to specify actions!
248 Library is becoming ready
249 Nothing to eject
250 Open configuration failed
251 Close configuration failed
252 Create configuration key failed
253 Delete configuration failed
254 Query configuration value failed
255 Update configuration value failed
256 Out of memory
257 Invalid user name or password
258 Invalid user
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Table 35  Error Codes (Continued)

Error Code Description
259 Invalid client type
260 User can't rename himself
261 Supervisor can't create object
262 Supervisor can't update object
263 Supervisor can't remove object
264 Supervisor can't start object
265 Supervisor can't stop object
266 Search for client in database failed
267 List clients in database failed
268 Create client failed in database
269 Get client failed in database
270 Update client failed in database
271 Remove client failed in database
272 Listing of mailboxes has failed in database
273 Creating of mailbox failed in database
274 Assigning volser to mailbox failed
275 List cartridges failed in database
276 Get cartridge failed in database
277 Get property of cartridge failed in database
278 Create destination failed in NS
279 List destinations failed in NS
280 Remove destination failed in NS
281 Requested virtual library not found
282 List elements failed in database
283 Get element failed in database
284 Get element properties failed in database
285 Assign cartridge to element failed in database
286 Internal error
287 Object is not ready
288 Initialization of request failed
289 Can't query object interface.
290 Getting of mailbox failed in database
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Table 35  Error Codes (Continued)

Error Code Description

291 List physical libraries failed in database
292 Get physical library property failed in database
293 List partitions failed in database
294 Get partitions failed in database
295 Create partition failed in database
296 Mapping of virtual elements to physical failed in database
297 List media pools failed in database
298 Get media pool failed in database
299 Create media pool failed in database
300 Remove cartridge from media pool failed in database
301 Add cartridge to media pool failed in database
302 List service actions failed in database
303 List of virtual libraries failed in database
304 Create virtual library failed in database
305 Create library failed in database
306 Get property of virtual library failed in database
307 Search of notification failed in NS
308 Load history failed in NS
309 Unknown type of notification
310 Acknowledging of notification failed in NS
311 Invalid action type
312 Get template failed in NS
313 Create template failed in NS
314 List templates failed in NS
315 Remove template failed in NS
316 Get list of rules failed in NS
317 Get rule's properties failed in NS
318 Create new rule failed in database
319 Remove rule failed in database
320 List tickets failed in SCM
321 List ticket states failed in SCM
322 List ticket states entries failed in SCM
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Table 35  Error Codes (Continued)

Error Code Description
323 Get ticket context value failed in SCM
324 Add ticket state failed in SCM
325 Add ticket state value failed in SCM
326 Mark the ticket state as deleted failed in SCM
327 Context value not found in SCM
328 Find all libraries failed in configuration module
329 The volser requested is not in the client assigned volserrange
330 Deletion of mailbox has failed
331 Deletion of virtual library has failed
332 Deletion of physical library has failed
333 Deletion of partition has failed
334 Deletion of media pool in library has failed
335 Impossible to remove or change user level of last admin
336 This item already exists
337 Impossible to create ticket
338 The volser is allocated for another client
339 The library contains mailboxes
340 The library contains pools
341 The library contains partitions
342 Updating of mailbox has failed
343 Getting pool's properties has failed
344 Updating pool has failed
345 Updating partition has failed
346 Operation has failed
347 One or more clients use this library
348 Impossible to get dump
349 Impossible to get data
350 Insertion of cartridge has failed
351 Exporting to alias has failed
352 Initialization of element status has failed
353 Mount has failed
354 Dismount of cartridge has failed
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Table 35  Error Codes (Continued)

Error Code Description

355 Dismount of drive has failed
356 Control of library has failed
357 Query of library status has failed
358 Invalid destination for move operation.
359 Element is not inventoried
360 Robot could not move
361 General bus problem
362 Resource pended
363 Invalid field in CDB
364 Coordinate not found
365 No clean cartridges are available for drive
366 Move cartridge to problem box
367 Volser is ejected
368 Insert/Eject station door is open
369 Volser is unchanged
370 Volser is duplicated
371 Volser contains invalid characters
372 Move cartridge to problem box
373 Volser is allocated to another coordinate
374 The cartridge already in place
375 The cartridge is not accessible
376 Command was aborted
377 Invalid home position
378 Mismatch to use the clean media within scratch pool
379 Element is unavailable
380 The drive did not unload the cartridge
381 Cannot lock I/E station
382 Command not supported
383 The volser is already allocated
384 The drive is already allocated
385 The drive requested is not available for this client
386 A mechanical positioning error occurred
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Table 35  Error Codes (Continued)

Error Code Description
387 The accessor dropped a cartridge
388 Could not erase EEPROM
389 Could not program EEPROM
390 Cartridge in gripper at power-on
391 Component failure
392 Gripper error
393 The accessor could not move on the vertical (Y) axis
394 Could not home the vertical (Y) axis
395 The accessor could not move on the horizontal (X) axis
396 Could not home the horizontal (X) axis
397 The accessor lost power
398 Internal target failure
399 A drive did not load or unload a tape
400 Cannot lock the I/E station
401 Cannot unlock the I/E station
402 Label too short, too long or duplicate
403 Cannot read a barcode label due to scanner problem
404 Firmware error
405 Parameter list length error (lllegal Request).
406 lllegal operation code in CDB (lllegal Request).
407 Invalid element address in CDB (lllegal Request).
408 Attempt to write a read only buffer (lllegal Request).
409 lllegal LUN (lllegal Request).
410 Invalid field in Parameter List (lllegal Request).
411 Invalid parameter in Parameter List (lllegal Request).
412 Parameter data checksum failure (lllegal Request).
413 Incompatible media installed (lllegal Request).
414 Source of MOVE MEDIUM command cannot be accessor (lllegal Request).
415 Cartridge stuck in tape drive (lllegal Request).
416 Source cartridge loaded into tape drive and not accessible (lllegal Request).
417 Media type does not match destination media type (lllegal Request).
418 Invalid bit in "Identify" message (lllegal Request).
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Table 35  Error Codes (Continued)

Error Code Description
419 Incorrect LUN configuration (lllegal Request).
420 Firmware detected an internal logic failure (lllegal Request).
421 Cartridge rejected in the Insert/Eject station because it was not properly loaded (lllegal
Request).
422 Cell status and barcode questionable (lllegal Request).
423 Medium removal prevented because storage element is unavailable (lllegal Request).
424 Cartridge magazine is not installed (lllegal Request).
425 Data transport device is not installed (lllegal Request).
426 Data transfer element is varied offline (lllegal Request).
427 Message received at inappropriate time (Abort error).
428 Host rejected "Identify" message sent for reselection (Abort error).
429 Message system was disabled during parity error detection on SCSI bus (Abort error).
430 Received an "Initiator Detected Error" or initiator rejected "Restore Data Pointer" (Abort
error).

431 Disconnect during command processing (Abort error).
432 The command was cancelled due to a state change (Abort error).
433 Destination element full for MOVE MEDIUM command (lllegal Request).
434 Source element empty for MOVE MEDIUM command (lllegal Request).
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DAS Guide

This topic provides an overview of the DAS Client software that is a part of Scalar DLC software product.

The sections are:

» System Description on page 259.

+ Commands Overview on page 260.

+ DAS Commands on page 263.

System Description

DAS Client software runs as an application under Windows 2000/2003, Windows NT, Unix, Windows 9x,
and so forth. This is a client software product designed to provide shared access to a member of the ADIC
library family by up to 50 separate clients who run from entirely separate platforms while using various
media in the library system. The DAS software makes it possible for backup, document management or
HSM applications to have direct access to the media in the library systems.

The library system is controlled by the Scalar DLC software. The data from the applications is sent directly
to the drives. The DAS software supports a wide variety of UNIX systems, Windows NT, and Windows 2000/
2003. Connection to other operating systems such as MVS, VM or Tandem has been made across another
interface of the Scalar DLC.

The client software consists of a library of functions and an administration program (dasadmin).The software
is available for various platforms. A new client requires the standard TCP/IP functions with ONC Remote
Procedure Calls (RPC) support and an ANSI C compiler. The applications access the open interface (ACI).

Each client can be assigned specific access privileges to the library:
+ Basic, extended, or all functions
* Drives
*  Volume Serial Number (Volsers)
* Ranges of the I/O units
»  Scratch pools

The installation instructions for the DAS Client software can be found in the Scalar DLC Installation Guide,
Installing DAS Client section.
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Starting DAS Client Software

From WinNT / Win2000 / Win2003, launch Start > Programs > ADIC Distributed Library Controller >
Scalar DLC DAS-Client. The dasadmin starts immediately.

However, the dasadmin.exe program can be launched manually as well.

— If the DAS Administration Utility has been installed under the firewall connection, the
L Note ) o : :
main executable file is dasadmin_fw.exe, not dasadmin.exe.

Commands Overview

DAS administrator commands can be divided into four areas: Media management, DAS management,
Client management, and Scratch pool management

Media Management

*  Mount and dismount

+ Change sides on the optical disk in the drive
* Insert and eject

*  Move medium

* Inventory

+ View the available media

* View the media status

* View the logical ranges for insert/eject
« Catalog or remove foreign media

+ Clean the drive

* Insert and eject the cleaning cartridge
* View the element status

Refer to Table 37 on page 263 for the details.

DAS Management

* Delete command

* View outstanding commands

» Send message

» Activate and deactivate barcode reading for mount, move and eject from DAS
»  Shutdown Scalar DLC supervisor

*  Shutdown Scalar DLC and operating system

Refer to Table 38 on page 264 for the details.
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Client Management

* Reserve/release a drive for a client
* Reserve/release a volser for a client
* Modify access privileges for a client
*  Modify execution parameters

Refer to Table 39 on page 265 for the details.

Scratch Pool Management

* Add volser(s) to the scratch pool

* Remove volser from the scratch pool
»  Get volser from the scratch pool

* View scratch pool information

Refer to Table 40 on page 265 for the details.

Define and Reserve

Although the DAS Client may typically access all resources of the library which is configured to it, there are
situations when the access rights need to be temporarily modified.

Define means the client may access only the defined drives and/or cartridges. The defined resource could
be used by several clients. No definition means the client can use all available resources (whole logical
library).

Reserve (allocate) means only the specified client may use the reserved drives and/or cartridges. The
reserved resource cannot be used by other client until the reservation is removed. No allocation means the
client uses common resources that can be also accessed by other clients.

Table 36 lists all DAS/ACI commands that use either define or reserve features (or both).

Table 36  Usage of Define and Reserve

Command Used Define Used Reserve
allocd drives drive
allocv - volser
carry drive, volser drive, volser
cellinfo volser -
clean drive, volser drive, volser
dismount drive, volser drive, volser
eject volser volser
eject2 volser volser
eject3 volser volser
ejectcl volser volser
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Table 36  Usage of Define and Reserve (Continued)

Command Used Define Used Reserve

ejectcom volser volser
flip drive, volser drive, volser
getvolsertodrive drive -
getvoltoside volser -
insert volser volser
insert2 volser volser
listd drive -
listd2 drive -
listd3 drive -
listd4 drive -
listd5 drive -
listv - volser
listv2 - volser
mount drive, volser drive, volser
pausedrive drive drive
qgvolsrange volser volser
scap drive, volser -
scr_get volser volser
scr_info volser volser
scr_insert volser volser
scr_mount drive, volser drive, volser
scr_set volser volser
scr_unset volser volser
show drive, volser -
show?2 drive, volser -
typelist drive -
typelist2 drive -
unload drive -
view volser -
view2 volser -
viewc drive -

262 DAS Guide




DAS Commands

DAS commands are divided into:

* Media management
+ DAS management

*  Client management

*  Scratch management

All these commands are called from dasadmin.

T4 Note

The dasadmin application provides a brief help by entering the -h option.

Table 37 Media Management
Command Explanation
carry moves volser from one slot to another.
catf catalogs foreign media.
cellinfo displays information about devices and cartridges in the system.
clean cleans drive.
dismount removes a medium from a drive and returns it to its home position.
eif_conf returns an information of logical ranges configured in the insert/eject area.
eif_info returns an information of logical ranges configured in the insert/eject area.
eject ejects a limited number of media from the library.
eject2 ejects media from the library.
eject3 ejects media from the library.
ejectcl ejects used cleaning media from the library.
ejectcom ejects media from the library completely.
flip flips the optical disk in the drive.
getvolsertodrive displays the configured assignment of volsers to drives.
getvoltoside displays information on the association of volsers to an optical disk.
insert inserts a few cartridges in the library.
insert2 inserts many cartridges, including cleaning cartridges, in the library.
inventory checks and corrects the whole library system database.
mount loads medium into a drive.
partinventory checks and corrects part of the library system database.
pool_list provides information about clean/scratch pools in the system.
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Table 37  Media Management (Continued)
Command Explanation
pool_data provides information about volsers assigned to the given pool.
gvolsrange displays the volser from the Scalar DLC database for a specified range.
rmf removes foreign media from the catalog.
unload operates the buttons on the drive (for example, unload button) by the robotics.
view displays information from the database relating to a volser.
view2 displays information from the database relating to a volserrange.
viewc displays information from the Scalar DLC database relating to a coordinate

volserinventory

checks and corrects part of the library system database.

Table 38 DAS Management
Command Explanation
barcode activates/deactivates the library barcode reader for the mount, carry, and eject
commands.
cancel deletes a command from the command queue.
email sends the message via email.
hosttype provides information about the type of the connected host
killamu terminates Scalar DLC software and OS.
list displays the DAS command queue.
list2 displays the advanced DAS command queue.
list3 provides enhanced information on executing requests
pausedas turns dasadmin to a passive state.
pausedrive logically turns a tape drive disable/enable.
gversion displays the DAS and ACI version.
robhome makes the library system inactive.
robstat makes the library system active or queries status.
rpctest perform quick portmapper test
shutdown shuts down Scalar DLC
snmp sends the message via SNMP.
switch switches between active and passive cluster nodes.
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Table 39  Client Management

Command Explanation
allocd drive reservation for a client.
allocv volser reservation for a client.
listd displays drive assignment for up to 16 drives.
listd2 displays drive assignment for up to 250 drives.
listd3 displays drive assignment for up to 250 drives.
listd4 displays drive assignment for up to 380 drives.
listd5 displays drive assignment
listf displays foreign volsers.
listv displays volser reservations.
listv2 displays volser reservations
scap temporarily modifies access privileges.
scop temporarily modifies the working parameters.
scop2 temporarily modifies the working parameters.
show displays current access privileges and operating parameters.
show?2 displays current access privileges and operating parameters.
typelist shows all drives or specific drives with matching media type
typelist2 shows all drives or specific drives with matching media type

Table 40  Scratch Management

Command Explanation
scr_get displays the next available scratch volser from the scratch pool.
scr_info displays information relating to the scratch pool.
scr_insert inserts a cartridge and adds it to the scratch pool.
scr_mount places the next available scratch cartridge in the drive.
scr_set adds cartridge in the library system to the scratch pool.
scr_set_range adds cartridges in the library system to the scratch pool.
scr_unset changes cartridge status from scratch to unscratch.

T4 Note

The configuration of scratch pools, clean pools, and insert/eject areas should be
executed via the Scalar DLC Management GUI. The configuration of Define Range and
Reserve Range can be done from both Management GUI and client side as well.
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SCSI Guide

This section provides a brief overview for the Scalar 1000 and Scalar 10K Medium Changer Small Computer
System Interface (SCSI) protocol, including supported commands and messages.

The topics are:

Installation and Configuration on page 267 describes the installation and configuration order for

SCSI Client.

General Characteristics on page 268 outlines SCSI general information. It also includes:

+ SCSI Bus on page 269.

+ SCSI Communications on page 270.

+ SCSI| Message System on page 271.

+ SCSI Commands on page 272.

» SCSI Operations on page 274.

Installation and Configuration

Step 1

Step 2

Step 3

Step 4

Step 5

Install the Scalar DLC software with the SCSI support on the server PC. Install the required
drivers for the target mode. Refer to Scalar DLC Installation Guide, Installing Scalar DLC
Software and Installing SCSI Target Drivers sections. The server PC requires a restart.

Enable appropriate SCSI target ports via the SCSI Target Port tool. Refer to SCSI Target Port
Tool on page 217. The server PC may ask for a restart.

Start the Management GUI. Refer to Scalar DLC Management GUI on page 9. Create at least
one Target object and at least one LUN. Refer to SCSI Target Tab on page 162, Create Target
on page 169 and Create LUN on page 170. The created target is not active.

Create the library configuration that the client requires. Refer to Configuration on page 16.
Create additional mailboxes and clean/scratch pools if necessary. Refer to Create Mailbox on
page 110 and Create Pool on page 109.

Create a SCSI client based on the created Target and LUN, and assign it to the created logical
library. Refer to Create SCSI Client on page 155. The LUN becomes active.
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@ Note Either use LUN 0 or ensure that there already is a SCSI client configured for LUN 0 of

the specified target. Otherwise, even when everything is properly configured and
installed, the SCSI Client cannot be activated.

It is strongly not recommended either assign the non-SCSI client to the same

/¥ CAUTION  |ogijcal library, or use the library partitions as shared resources in other logical

Step 6

Step 7

libraries with the non-SCSI client assigned. Should that be done, some SCSI
features will not be available for the client, mostly because of home position
restrictions used in the Scalar DLC software for non-SCSI clients.

Install the client application on the client PC and configure it to work with the appropriate Port-
Target-LUN.

Now, the Scalar DLC software is ready to accept commands from a SCSI client.

General Characteristics

The Scalar 1000 components include:

Control Module (CM) - a single cabinet containing an Insert/Eject station, storage cells, and tape
drives. The CM uses one or two SCSI ports to connect to a SCSI host.

Expansion Module (EM) - a single cabinet that is added to a CM to provide additional storage cells
and tape drives. The Scalar 1000 can have up to three EM’s.

Operator panel - displays status and provides command entry.

Accessor - a device that moves cartridges to and from the Insert/Eject station, storage cells, and
tape drives.

Barcode scanner - reads cartridge barcode labels to identify library volumes.

The Scalar 10K components include:
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Control Module (CM) - a cabinet that attaches to the AM. It contains storage cells, tape drives, and
the library Operator LCD Panel that displays library status and provides a command entry point. The
CM uses one or two SCSI ports to attach SCSI hosts.

Accessor Module (AM) - a cabinet that contains four rack locations (Control Module, Insert/Eject
stations, Tower Module, or Storage Cells), and the Accessor. Each AM can have an Expansion
Module added.

Expansion Module (EM) - a cabinet that is added to an AM or to another EM to provide additional
storage cell configurations and attachment capabilities for DMs and TMs. The Scalar 10K can have
up to three EM’s.

Accessor - located in the AM, it is a device that moves cartridges to and from Insert/Eject stations,
storage cells, or tape drives.

Barcode scanner - located in the AM, it is a device that teaches the system configuration, and reads
cartridge barcode labels to identify library volumes.

Drive Module (DM) - a cabinet that attaches to an AM or an EM. It contains a maximum of 48 drives.

Tower Module (TM) - a cabinet that attaches to an AM or an EM. It contains rotating storage
locations.
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@ Note The Scalar 10K DA (dual-aisle) library is the same as Scalar 10K, however it contais
two CM, two AM, two barcode readers, etc.

There are four Scalar 1000 and Scalar 10K modes of operation:

+ ADIC native mode,

«  EXABYTE compatibility mode,
*  STK compatibility mode,

+  EMASS compatibility mode.

@ Note The mode of operation determines how the library responds to the SCSI INQUIRY
command.

The Scalar 1000 and Scalar 10K supports half inch, DLT/SDLT, LTO, and AIT tape cartridges. For the
Scalar 1000 library, a storage cell cartridge capacity ranges from 118 cells in the CM and up to 1182 cells
with additional EMs. For the Scalar 10K library, a storage cell cartridge capacity ranges from 700 cells in
the CM to 15938 cells with additional EMs, DM, and TMs. Total capacities are dependent on the media type
configurations.

Associated Documents

For the details of the SCSI operations refer to:
»  SCSI Reference Manual for the Scalar 10K library.
» SCSI Reference Manual for the Scalar 1000 library.

The SCSI client should use the document that describes the data format used by his software target
application. Refer to Target on page 166 and Logical Unit Number (LUN) on page 168 for the details.

SCSI Bus

A SCSI Bus is a shared resource that provides a pathway for exchanges between one or more hosts and
their peripheral devices. A SCSI bus can be Single Ended, Differential, or Low Voltage Differential and must
be terminated at both ends.

SCSI bus components are:
*  SCSlinitiator (host)
» SCSI target (peripheral)
»  Cable connecting host and peripheral
*  Bus terminators

Consider the computer system as the host and the Scalar 1000 and Scalar 10K as the peripheral.

Initiator Operation

The SCSI bus adapter card in a host computer is the initiator of SCSI operations. The host initiates
commands and messages or sends data to the target. The initiator also receives messages, data, and
status from the target.
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Target Operation

The Scalar 1000 and Scalar 10K library target respond to control information or data from the host. The
library does not:

» Generate unsolicited interrupts to the host
* Initiate its own SCSI commands

* Assert bus resets

Element Addressing

The host references source and target designations with element addresses within the library. Each
element within the library has a unique address. The element addresses are established according to the
firmware version of the library.

The Scalar 1000 has two firmware versions:

+  Firmware earlier than Version 3.0
* Firmware Version 3.0
The addressing scheme of the Scalar 1000 depends on the firmware version that is used.

The Scalar 10K SCSI addressing scheme is:

* One Cartridge Accessor exists. Its assigned address is always 1h.
« The I/E station locations are addressed continuously from top to bottom, station by station.
« Tape drive locations are addressed from lower left to upper right, rack by rack.

+ Storage element locations are addressed from the top left to lower right, column by column, rack by
rack.

SCSI Communications

Scalar 1000 and Scalar 10K communications are implemented across the SCSI bus. The following
paragraphs discuss the bus phases.

Bus Phases

The Scalar 1000 and Scalar 10K conforms to the bus state transition table of the SCSI-2 standard, Phase
Sequences. Bus phases determine the type of information and direction on the interface as shown in table
below.

Phase Description
Bus Free The Bus Free phase indicates that the bus is idle.
Arbitration The Arbitration phase allows devices to compete for bus access.
Selection The Selection phase allows the host initiator to select the target destination for

communication.

Reselection The Reselection phase allows the target to reconnect to the host initiator after a
disconnect has occurred.
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Phase Description

Transfer The library supports asynchronous data transfer phases with differential and single
ended communications. Odd parity is generated during all information transfer phases
from the library. Parity is checked during all information transfer phases to the library.
Parity checking can be disabled.

Information Transfer phases include:

* The Message In/Message Out phases manage the physical path between the host
initiator and target destination. Message In is a message to the host initiator, Message
Out is a message to the target destination.

« Command Out phase is a command from the host initiator to the target destination.

» Data In/Data Out phase is either data sent from the target to the host initiator (Data
In) or data sent from the host initiator to the target destination (Data Out).

» Status In is a target status byte response to a host-initiated command.

SCSI Message System

The SCSI message system (Message In/Message Out) allows communication between an initiator and a
target for the purpose of physical path management.

Message Code Description Direction
COMMAND 00h The COMMAND COMPLETE message is In
COMPLETE sent from a target to an initiator to indicate that

the execution of a command is complete and
valid status has been sent to the initiator.

SAVE DATA 02h The SAVE DATA POINTERS message is In
POINTERS issued before every disconnect message

following a Data In or Data Out phase. The

message is not sent when disconnecting after

a Command Descriptor Block (CDB) that did

not transfer data.

RESTORE 03h The RESTORE POINTERS message is sent In
POINTERS from a target to direct the initiator to continue
sending data.

DISCONNECT 04h The DISCONNECT message is sent by a In
target to inform an initiator that the present
data transfer will be suspended. The target
will reselect the initiator at a later time to
continue the current operation.

INITIATOR 05h The INITIATOR DETECTED ERROR Out
DETECTED ERROR message is sent from an initiator to inform a

target that an error has occurred. This allows

the target to retry the operation.

ABORT 06h The ABORT message is sent from the initiator Out
to the target to clear the current or pending
operation. The target goes directly to the BUS
FREE phase after successful receipt of this
message.
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Message Code Description Direction

MESSAGE REJECT 07h The MESSAGE REJECT message is sent Both
from the initiator or target to indicate that the
last message received was inappropriate or
not implemented.

NO-OP 08h The NO-OP message is sent from the initiator Out
to inform the target that no message is valid in
response to the target request for a message.

MESSAGE PARITY 09h The MESSAGE PARITY ERROR message is Out
ERROR sent from the initiator to the target to indicate

that one or more bytes in the last message

received contained a parity error.

BUS DEVICE 0Ch The BUS DEVICE RESET message is sent Out
RESET from an initiator to clear all commands, data,

and status at the target. When the target

recognizes this message, it aborts the

command currently being executed, proceeds

to the BUS FREE state, and executes a hard

reset.

IDENTIFY 80h or COh  The IDENTIFY messages are sent either by Both
the initiator or by the target to establish (or re-
establish) the logical connection path between
an initiator and target for a particular logical
unit. The Scalar 1000 and Scalar 10K libraries
only support a logical unit of 0.

SCSI| Commands

The topic provides information on Device Commands, SCSI Commands Format, and SCSI Command
Status Byte.

Device Commands

Table below shows the SCSI medium changer commands that are supported by the Scalar 1000 and Scalar
10K libraries.

Operation code Command
07h INITIALIZE ELEMENT STATUS
E7h INITIALIZE ELEMENT STATUS WITH RANGE
12h INQUIRY
4Ch LOG SELECT
4Dh LOG SENSE
15h MODE SELECT
1Ah MODE SENSE
A5h MOVE MEDIUM
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Operation code Command

2Bh POSITION TO ELEMENT

1Eh PREVENT/ALLOW MEDIUM REMOVAL
3Ch READ BUFFER

B8h READ ELEMENT STATUS

1Ch RECEIVE DIAGNOSTIC RESULTS

17h RELEASE

03h REQUEST SENSE

B5h REQUEST VOLUME ELEMENT ADDRESS
16h RESERVE

01h RE-ZERO

1Dh SEND DIAGNOSTIC

B6h SEND VOLUME TAG

00h TEST UNIT READY

3Bh WRITE BUFFER

SCSI Command Format

The SCSI command format follows the SCSI-2 and SCSI-3 standard. Table below describes the CDB fields
that are common to all commands.

Command Description

Logical Unit The library has a single Logical Unit Number (LUN). The library always appears as LUN

Number 0. If the LUN is specified in the IDENTIFY message, the LUN field in the CDB is ignored
by the library.
Reserved The word Reserved or Rsvd refers to a field defined by the SCSI standard as 0. The

library checks the field for 0. If the field is not 0, the library returns Check Condition
status with a sense key of lllegal Request.

Control Byte  The vendor unique portion of the Control Byte is defined in the specific command.

Not This description indicates that the field is a SCSI standard but is not supported by the
Implemented library.

SCSI Command Status Byte

Both the Scalar 1000 and Scalar 10K enter the status phase once per command, unless aretry is requested
by the initiator. Table below describes the library return status bytes.
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Status Value Description

Good 00h The library successfully completed the command.

Check 02h An error condition occurred during command processing. The
Condition REQUEST SENSE command responds with detailed error information.
Busy 08h The target is busy. This status is returned when the device is unable to

accept a command from an otherwise acceptable initiator. The initiator
should reissue the command at a later time.

Reservation 18h This status is returned by the library when a SCSI initiator attempts to
Conflict access the library after it is reserved by another initiator with a
RESERVE command.

SCSI Operations

The following detail Scalar 1000 and Scalar 10K SCSI communication behavior.

Parity Checking

To enable parity checking on information received by the library, set the parity bit on the Parity Page of the
MODE SELECT command.

Disconnection

The library disconnects from the SCSI bus whenever a command requires a lengthy time to complete. The
library receives permission to disconnect from the initiator. The initiator grants permission by:

»  Selecting the library with the Attention signal.
» Sending an Identify message with the DiscPriv bit set to 1.

Once the command processing completes, the library reselects the initiator and sends the Identify message.

Resetting the Library
The library is reset by a Power-On Reset (POR) or a SCSI Device Reset.

Power-On Behavior

* The library goes to the Bus Free phase.

*  The checksum of the flash EEPROM is validated.

» All library parameters are loaded with either saved or default values.
* A Power On SelfTest is performed.

* The library responds to the SCSI bus within 10 seconds of power on.

SCSI Device Reset Behavior

* The library goes to the Bus Free phase.

» Alllibrary parameters are returned to their saved or default values.
* A Self Test is performed.

* The library responds to the SCSI bus within 250 milliseconds.
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Unit Attention Condition

Unit Attentions are reported under the following circumstances:

Reset occurred.

A firmware (microcode) update completes.

A library door closes.

The Insert/Eject station closes.

Another initiator changes the Mode Parameters.

Another initiator changes the Log Parameters.
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ROBAR Guide

The ROBAR (ROBotic ARchive) software works with the Scalar DLC via the specific ROBAR interface. The
ROBAR Client software is a flexible tool that works under various operating systems (Unix-based, Win9x,
WInNT, Win2000, and so forth). The ROBAR interface was one of the first methods to operate the
Automated Media Libraries and still remains very useful.

The ROBAR Client works with the Scalar DLC server software. Before the connection between the ROBAR
Client and Scalar DLC can be established, the ROBAR Client object must be created and configured.

The sections are:
« Installation and Configuration on page 277.
+ ROBAR Commands on page 278.
+ ROBAR Command Format on page 280.

+ Command Header on page 280.

+ Command Structure on page 281.

+ ROBAR Coordinates on page 283.

Installation and Configuration

Step 1 Install the Scalar DLC software with the ROBAR Client support on the server PC. Refer to
Scalar DLC Installation Guide, Installing Scalar DLC Software section (either a Complete
installation or a Custom installation with the ROBAR support selected). The server PC requires
a restart.

Step 2 Start the Management GUI. Create the library configuration that the client requires. Refer to
Configuration on page 16. Create additional mailboxes and clean pools if necessary. Refer to
Create Pool on page 109 and Create Mailbox on page 110.

Step 3 Configure ROBAR interface to work with an appropriate port. Refer to ROBAR on page 156.

Step 4 Create a ROBAR client and assign it to the created library. Refer to Create ROBAR Client on
page 160.

Step 5 Install the client application on the client PC and configure it to work with the appropriate server
and port.
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Example1 (for DOS or Windows-based system):

C:>\ Set PORT
C:>\ Set HOST

1010
computer

Example2 (for Unix-like systems):

#PORT =
#HOST

1010 export PORT
computer export HOST

Step 6 If the customer uses HCC/MVS, this also must be configured in the ROBAR client settings.
Refer to ROBAR Client on page 158.

Now, the Scalar DLC software is ready to accept commands from ROBAR Client.

ROBAR Commands

Table 41 ROBAR Commands

Command Description
ACOM Checks the communication to the Scalar DLC software and get information
about the library status.
AOFF Programs end of the Scalar DLC software.
AUTO Switches from manual or test mode to the automatic mode.
BOF Switches the barcode reading for the sending host off.
BON Switches the barcode reading for the sending host on.
CLM Clean manager status and configuration command.
CLU Closes the flap on a drive.
DL Changes a archive catalog entry.
EJ Ejects data cartridges - temporary.
EJT Ejects data cartridges - complete.
EJTC Ejects complete - used cleaning cartridges.
FLIP Toggles the side of a Optical Disk in an Optical Disk drive.
IN Inserts data cartridges by a logical range.
INC Verifies the archive with the database by a given coordinate.
INSC Inserts clean cartridges by a logical range.
INV Inventory of a given volser.
IVK Inventory of a given coordinate range.
\AYS Inventory of a given volser.
KE Moves a cartridge from drive to the home position.
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Table 41 ROBAR Commands (Continued)
Command Description
KEC Moves a cartridge from drive to a given position.
LJB Moves a cartridge to the I/O area of a integrated Jukebox.
MAN Switches from automatic mode to the manual or test mode.
MO Moves a cartridge to a drive from archive or the Insert/Eject unit.
MOCL Initiates a drive cleaning.
MV Moves a cartridge from archive or Insert/Eject unit to a coordinate in the
archive or insert/eject unit.
ROPO Moves the robot to the given coordinate.
ROSA Displays and change the library status to online.
ROSO Moves the robot to a park position and set the status to not ready.
SCH Sends the information of the first occupied compartment to the requester.
SIN Stops the running insert command.
SIVK Stops the running inventory command.
SWIT Toggles the library status passive-active.
uJB Unloads the I/O unit of a integrated Jukebox.
ULC Displays a archive catalog entry by a given coordinate.
ULK Displays a archive catalog entry by a given coordinate.
ULU Performs the robot to press button(s) on the drive.
uLv Displays a archive catalog entry by a given volser.
UPC Changes the archive catalog entry by a given coordinate.
UPK Changes the archive catalog entry by a given coordinate.
upPv Changes the archive catalog entry by a given volser.
VI Inserts the first available Cartridge in the Insert area to the archive.
VICC Inserts the cartridge from a given coordinate to a given target coordinate.

T4 Note

The configuration of clean pools and insert/eject areas should be executed via the Scalar
DLC Management GUI. Refer to Create Pool on page 109 and Create Mailbox on page
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ROBAR Command Format

The command is a string that contains:

» Start symbol (<)

¢ Command header

e Command

« Command parameters

*  End symbol (>)

The standard command is a single command with a single answer. There are also block commands that
contain one command, some data messages, and one answer.

Also, in some special situations, Scalar DLC will distribute a notification in this command format to all
partners using the ROBAR command format.

Command Header

The command header contains the following fields:

« Receiver

 Sender

* Telegram type

*  Request ID

The command header format is shown in Table 42.

Table 42 Command Header format
Field Length Value/Description Example
Receiver 2 Name of the Receiver of the telegram. H1
Hx Requester from type "Host".
M1 "Major HCC" only after a "Sign of Life" from
Host type "HCC/MVS".
Sender 2 A1, External name of the Scalar DLC host. A1
A2
Vx Virtual host name (for VTLS)
This command will only be routed to the
VAMU (CentricStor).
Telegram 2 A00 Standard command. AQ0
type
P Vxx Message for the VAMU.
Request ID Comma+4 |O0- Sequence identifier from the command ,M085
Z7Z7Z | originator.
z Notification starts with the Prefix A.
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Command Structure

The command itself contains the following fields:

¢ Command header
e Command
* Acknowledge

* Returned code

+ System
* Robot
+ Device
+  Volser
+ Status

* 1st param

*  2nd param

* Time stamp

* Orig. Host ID

* Orig. Request ID

The details in command format are shown in Table 43.

Table 43 Command format
Field Length Value/Description Example
Command 9 Command header with information about sender and A1H5A00,
header requester (refer to Command Header on page 280). M875
Command 4 Name of the command or NTFY for an asynchronous | AO1
notification.
Acknowledge 1 Message specific response: P
P Positive (command successful)
N Negative (command unsuccessful)
D Data (message in a block command)
E End (end of block command)
M Asynchronous message ROBS
Return code 4 Error or Status message in the answer/number of the | NO05
notification.
System 1(2) Library (if larger than 9, replaces the comma with the 2
second digit of the system).
Robot 1 Robot number for a twin robot system (1 or 2). 1

Scalar DLC Reference Guide

281




Table 43  Command format (Continued)

Field Length Value/Description Example
Device 3 Dxx Drive name. DOR
Oxx
Ixx Logical range of the Insert/Eject unit.
Exx
Pxx Pool name.

Volser 6 Volume serial number. GRO0815
Status 2 Coordinate/cartridge type (1st byte): MB

C Cleaning cartridge.

M Data cartridge.

0] Optical Disk.

0 Empty (Null).

Coordinate/cartridge status (2nd byte):

Occupied.

Ejected.

Mounted.

Optical disk mounted other side.

Optical disk in Jukebox.

r|l <l OO Z| m

Empty.

1/0 Barcode reading on/off.

1st param 8 First parameter (mainly the source coordinate) 01010101

2nd param 8 Second parameter (mainly, the target coordinate) 00000201

Time stamp 9 Actual Day, hour, minute and seconds used for 26/211501
synchronization (ROSA)

Orig. Host ID 2 Original Host ID in a HCC/MVS Major-Minor Complex | H7

Orig. 4 Original Host request ID in a HCC/MVS Major-Minor 0815
Request ID Complex

The following example represents the typical ROBAR command.

<A1lH5A00,0010,MO0 , , ,1,2,DOR,GR0O012, 1,02321810, , 26/
211032,H1,0815>

Most ROBAR commands return an answer string that has the same structure as the command string. The
answer string is returned whether the command is executed successfully or not.
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ROBAR Coordinates

For all physical positions in the system, the Scalar DLC software provides a signification coordinate. With
the help of this coordinate, the Scalar DLC can compute the physical position. These are LSCI coordinates
(the Scalar DLC database contains a coordinate decoder and uses the LSCI coordinate system as well as

SCSI coordinates, and others). Refer to Element Addressing on page 244.

Additionally, for the Insert/Eject unit, Drives, Jukebox, and Problem box, the ROBAR interface uses special

coordinates.

Table 44 ROBAR Coordinates

Area

Description

Example

Storage area

typical LSCI coordinate - device, column, row, position

01010101 (device 1, column
1, row 1, position 1)

the problem box

Insert area coordinate starts with 0001 followed by row and 00010510 (row 5, slot 10)
position

Eject area coordinate starts with 0002 followed by row and 00020608 (row 6, slot 08)
position

Foreign coordinate starts with 0003 followed by row and 00030701 (row 7, slot 01)

Mount area position

Drive/ coordinate starts with 0000 followed by the drive 00000FO01 (drive addr. OF)

Jukebox address/name and 01 0000ZQ01 (drive name ZQ)

Problem box | coordinate starts with 000000 followed by number of 000000001 (problem box 1)
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